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Korkma, sönmez bu afaklarda yüzen al sancak;  
Sönmeden yurdumun üstünde tüten en son ocak.  
O benim milletimin y ld z d r, parlayacak;  
O benimdir, o benim milletimindir ancak.  
 

Çatma, kurban olay m, çehreni ey nazl  hilâl! 
Kahraman rk ma bir gül! Ne bu iddet, bu celâl? 
Sana olmaz dökülen kanlar m z sonra helâl. 
Hakk d r Hakk’a tapan milletimin istiklâl. 
 

Ben ezelden beridir hür ya ad m, hür ya ar m. 
Hangi ç lg n bana zincir vuracakm ? a ar m! 
Kükremi  sel gibiyim, bendimi çi ner, a ar m. 
Y rtar m da lar , enginlere s mam, ta ar m. 
 

Garb n âfâk n  sarm sa çelik z rhl  duvar,  
Benim iman dolu gö süm gibi serhaddim var. 
Ulusun, korkma! Nas l böyle bir iman  bo ar, 
Medeniyyet dedi in tek di i kalm  canavar? 
 

Arkada , yurduma alçaklar  u ratma sak n; 
Siper et gövdeni, dursun bu hayâs zca ak n. 
Do acakt r sana va’detti i günler Hakk’ n; 
Kim bilir, belki yar n, belki yar ndan da yak n  

 

 

Bast n yerleri toprak diyerek geçme, tan :  
Dü ün alt ndaki binlerce kefensiz yatan . 
Sen ehit o lusun, incitme, yaz kt r, atan : 
Verme, dünyalar  alsan da bu cennet vatan . 
 

Kim bu cennet vatan n u runa olmaz ki feda? 
üheda f k racak topra  s ksan, üheda! 

Cân , cânân , bütün var m  als n da Huda, 
Etmesin tek vatan mdan beni dünyada cüda. 
 

Ruhumun senden lâhî, udur ancak emeli: 
De mesin mabedimin gö süne nâmahrem eli. 
Bu ezanlar -ki ehadetleri dinin temeli-  
Ebedî yurdumun üstünde benim inlemeli. 
 

O zaman vecd ile bin secde eder -varsa- ta m, 
Her cerîhamdan lâhî, bo an p kanl  ya m, 
F k r r ruh-  mücerret gibi yerden na’ m; 
O zaman yükselerek ar a de er belki ba m. 
 

Dalgalan sen de afaklar gibi ey anl  hilâl! 
Olsun art k dökülen kanlar m n hepsi helâl. 
Ebediyyen sana yok, rk ma yok izmihlâl; 
Hakk d r hür ya am  bayra m n hürriyyet;  
Hakk d r Hakk’a tapan milletimin istiklâl! 

 
         Mehmet Âkif Ersoy 
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GENÇL E H TABE 

 

Ey Türk gençli i! Birinci vazifen, Türk istiklâlini, Türk Cumhuriyetini, 

ilelebet muhafaza ve müdafaa etmektir. 

Mevcudiyetinin ve istikbalinin yegâne temeli budur. Bu temel, senin en 

k ymetli hazinendir. stikbalde dahi, seni bu hazineden mahrum etmek 

isteyecek dâhilî ve hâricî bedhahlar n olacakt r. Bir gün, istiklâl ve cumhuriyeti 

müdafaa mecburiyetine dü ersen, vazifeye at lmak için, içinde bulunaca n 

vaziyetin imkân ve eraitini dü ünmeyeceksin! Bu imkân ve erait, çok 

namüsait bir mahiyette tezahür edebilir. stiklâl ve cumhuriyetine kastedecek 

dü manlar, bütün dünyada emsali görülmemi  bir galibiyetin mümessili 

olabilirler. Cebren ve hile ile aziz vatan n bütün kaleleri zapt edilmi , bütün 

tersanelerine girilmi , bütün ordular  da t lm  ve memleketin her kö esi bilfiil 

i gal edilmi  olabilir. Bütün bu eraitten daha elîm ve daha vahim olmak üzere, 

memleketin dâhilinde iktidara sahip olanlar gaflet ve dalâlet ve hattâ h yanet 

içinde bulunabilirler. Hattâ bu iktidar sahipleri ahsî menfaatlerini, 

müstevlîlerin siyasî emelleriyle tevhit edebilirler. Millet, fakr u zaruret içinde 

harap ve bîtap dü mü  olabilir. 

Ey Türk istikbalinin evlâd ! te, bu ahval ve erait içinde dahi vazifen, 

Türk istiklâl ve cumhuriyetini kurtarmakt r. Muhtaç oldu un kudret, 

damarlar ndaki asil kanda mevcuttur. 

                       Mustafa Kemal Atatürk 
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DERS MATERYALİNİN  TANITIMI

Ölçme ve değerlendirme 
sayfasını gösterir.

Öğrenme biriminin temel 
kavramlarını gösterir.

Öğrenme biriminin  
adını gösterir. 

Hazırlık çalışmalarını 
gösterir.

Karekod okuyucu ile taratılarak resim, video, 
animasyon, soru ve çözümleri gibi ilave 

kaynaklara ulaşılabileceğini gösterir.
Detaylı bilgi için http://kitap.eba.gov.tr/karekod

Öğrenme biriminde neler 
öğrenileceğini gösterir. 

Bilgi kutusunu
gösterir.

Öğrenme biriminin
numarasını gösterir.

Öğrenme biriminin
konularını gösterir.



DERS MATERYALİNİN  TANITIMI

Etkinlik sayfasını 
gösterir.

Uygulama 
sayfasını 
gösterir.

Cevap anahtarı 
sayfasını gösterir.

Derecelendirme 
ölçeklerini gösterir.

Öğrenme biriminin 
adını gösterir.

Not: Bu ders materyalindeki kısaltmalar uluslararası ölçü birimleri dikkate alınarak kullanılmıştır.             



1. 
ÖĞRENME

BİRİMİ

BİLGİSAYARDA 
FOTOĞRAF DÜZENLEME



KONULAR TEMEL KAVRAMLAR

NELER ÖĞRENECEKSİNİZ?

HAZIRLIK ÇALIŞMALARI

•	 Fotoğraf dosya boyutu ayarlama
•	 Fotoğrafta temel renk ayarları yapma
•	 Fotoğrafta temel ışık ayarları yapma
•	 Kullanım alanına uygun rötuş yapma
•	 Kullanıma alanına uygun dekupe yapma
•	 Fotoğrafları yeni hâlleri ile kaydetme

1.	 Bir fotoğrafın düzenlenmesi denildiğinde aklınıza gelen işlemler nelerdir?
2.	 Görüntü üzerinde değişiklik yapan programlardan hangilerini kullanmayı 
	 tercih ediyorsunuz? Tercihinizi nedenleri ile açıklayınız.
3.	 Fotoğraflar üzerinde yapılan düzenlemeler, izleyici üzerinde ne gibi 
	 etkiler oluşturabilir? Düşüncelerinizi arkadaşlarınızla paylaşınız.

1.1. BOYUTLANDIRMA 
	 VE ÇÖZÜNÜRLÜK
1.2. RENK AYARI
1.3. IŞIK AYARI
1.4. RÖTUŞLAMA
1.5. DEKUPE ETME
1.6. KAYDETME

•	 Rötuş
•	 Dekupe
•	 Renk
•	 Layer
•	 Araçlar
•	 JPEG
•	 RAW
•	 Fırça
•	 Cetvel
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Fotoğraf, geçmişte ve günümüzde birçok işlemden geçirilerek kullanıma hazır hâle gelmiş-
tir. Karanlık odada fırçalar yardımıyla yapılan düzeltmeler, günümüzde bilgisayar ortamın-
da görüntü düzenleme programlarıyla yapılmaktadır. Birçok firma görüntülerin düzenlen-
mesi için çeşitli program ve uygulamalar geliştirmiştir. Gelişen teknolojiyle akıllı telefonlar 
bile çekilen görüntünün düzenlenebilmesine olanak sunmaktadır.

Görüntü düzenleme programları, profesyonel ve amatör kullanımlar için deneme sürümü 
indirilerek test edilmektedir. Programların deneme sürümleri kullanıcıya belirli süre kulla-
nım olanağı sağlar. Deneme sürümünün kullanımı için üyelik şartı bulunmaktadır. Bunun 
için kişiden e-posta adresi ve telefon numarasını, program sayfasında bulunan talep 
formuna yazması istenir. Yazılan e-posta adresine link gönderilir ve süre sonunda satın 
alma işlemi yapılabilir. Firmaların bazıları sadece tek bir indirme ücreti talep ederken 
bazıları kullanım için üyelik oluşturmakta, aylık veya yıllık ücretler karşılığında programı 
indirterek kullanıma sunmaktadır. Ticari veya kişisel kullanım için program lisansının alı-
narak programın temin edilmesi ve bilgisayara kurulumunun yapılması gerekmektedir. 
Program için başlatılan üyelik şartları sağlandığında firma kişiye programı indirebilmesi 
için bir link gönderir. Program kurulum adımları takip edilerek program bilgisayara yük-
lenir. Kurulum dosyasının indirildiği yere gidilerek dosyaya tıklanması ve kurulum prog-
ramının başlatılması gerekir. Başlatılan kurulum programında sırayla e-posta ve kişisel 
bilgiler talep edilecektir. 

Kurulum sırasında bilgisayar interneti açık olmalıdır. Kurulum tamamlandıktan sonra bil-
gisayarda program kısayolu oluşacaktır. Bu kısayola tıklandığında program kullanıma 
açılır. Program bilgisayara yüklendikten sonra         simgesine tıklanarak açılır. Sol tarafta 
araçların olduğu palet bulunur. Üst kısımda ise seçeneklerin olduğu paletler yer almak-
tadır (Görsel 1.1).

Görsel 1.1: Çalışma ekranı ve alanı

Araç çubuğu

Seçenekler çubuğu

Çalışma alanı Paneller
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Görüntüde birim olarak 
piksel / inç veya piksel /
cm kullanılır. Piksel, px 
olarak da ifade edilir.

 10 cm uzunluğunda ve 
20 cm enindeki bir gö-

rüntü, 100 ppc çözünür-
lüğe sahip ise boyunda 
10 cmx100 ppc=1000 

piksel, eninde ise 
20 cmx100 ppc=2000 
piksel vardır. Görüntü-

deki toplam piksel sayısı 
(enxboy)=2000x1000= 

2000000 
pikseldir. 

BİLGİ 
KUTUSU

1.1. BOYUTLANDIRMA VE ÇÖZÜNÜRLÜK 
Görüntü düzenleme programları piksel tabanlı program-
lardır. Piksel, görüntüleri oluşturan küçük karelere verilen 
isimdir. Görüntüler, görüntü düzenleme programlarına çe-
kim aşamasındaki ayarlarına göre hazır çözünürlükle gelir. 
Çözünürlük piksel sayısını oluşturur. Çözünürlük kalitesi, 
içerdiği piksel sayısı ile orantılıdır. Görüntüdeki piksel sa-
yısı ne kadar fazla olursa görüntünün ve baskının kalitesi 
de o denli artar. Piksel tabanlı programda çalışmak, kareli 
bir defter üzerinde çalışmaya benzetilebilir. Bir kare içe-
risine denk gelen piksel üç renkten [kırmızı, yeşil, mavi 
(RGB)] oluşur. Pikselin rengi, RGB oranlarına göre belli 
olur. Vektör tabanlı programların aksine sonsuz büyütme-
ye izin vermez. 

Piksel tabanlı bütün programların kullanım yöntemleri veya 
arayüzleri birbirinden farklıdır ancak bütün programlar aynı 
mantıkla çalışmaktadır. Görüntüler üzerindeki piksellerde 
değişiklik yapılarak görüntünün istenilen görünüme ulaş-
ması sağlanır. Tüm kesme, yapıştırma ve yer değiştirme 
işlemlerinin tamamı piksellere uygulanır. Program, hazır 
seçeneklerle sunulurken aynı zamanda eklentilerle dışa-
rıdan eklenebilen komut, filtre, efekt, yazı karakterleri gibi 
yazılımlarla kullanıcıya yeni çözümler de sunar.

1.1.1. Görüntü Düzenleme Programı Çalışma  
        Alanı
Program ilk açıldığında görünen bölüme çalışma ekranı 
adı verilir. Çalışma ekranı, yapılan seçime göre boş bir 
sayfa, çağrılan bir dosya ya da fotoğraf şeklinde görül-
mektedir. Çalışma ekranında görüntüyü düzenlemek için 
araçlar ve paneller gibi sekmeler bulunur. Çalışma alanı 
ise açılan çalışma ekranındaki boyutlar ile sınırlıdır. 

Her program gibi görüntü düzenleme yazılımları da kişisel-
leştirilebilir. Kullanım sıklığına göre araçlar çubuğunda sık 
kullanılanlar öne çıkarılabilir. Program standart ayarlar ile 
çalıştırıldığında sağ tarafta Color (Kalır), History (Histori), 
Actions (Ekşıns), Layer (Leyır) gibi paneller görünür. Bu 
paneller isteğe göre görünümden kaldırılabilir veya başka 
paneller görünüme eklenebilir. Bu paneller birbirine kenet-
lenebileceği gibi ayrılmaları da mümkündür. Daha geniş 
alanda çalışılmak isteniyorsa kenetlenerek ve sekme şek-
linde gösterilebilir. 
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1.1.2. Paneller 
Görüntü düzenleme programında çalışma alanı seçimine 
göre sağ tarafta bulunan panellerden birkaçı açık şekilde 
görünür. Panellerin görünürlüğü isteğe göre değiştirile-
bilir (Görsel 1.2). Bunun için menüde yer alan Window > 
Workspace (Vindov > Vörksipeys) komutuna tıklanarak 
hazır çalışma alanları seçilebilir. Kişisel panel görünürlüğü 
için Window menüsünden paneller işaretlenebilir veya işa-
retli olanlar seçilerek iptal edilebilir. Paneller mouse (maus) 
ile üst üste sürüklenerek birbirine kenetlenebilir veya sek-
melerin yanına sürüklenerek yeni bir sekme gibi görünme-
si sağlanabilir. En çok kullanılan paneller arasında History, 
Actions, Layer, Color, Brush (Bıraş), Histogram (Histogram) 
sayılabilir (Görsel 1.3).

Layer, görüntü düzenleme programlarının çalışma alanında 
kullanılan bütün katmanların gösterildiği paneldir.

Color, renk modlarının gösterildiği ve değiştirildiği paneldir. 

Brush, görüntü düzenlemede kullanılacak fırçaların şekil ve 
boyutlarını ayarlar.

Histogram, fotoğraftaki ışık yoğunluğunun görüntülenmesi 
için kullanılır.

Actions, fotoğraf üzerine yapılan işlemleri kaydederek daha 
sonra başka bir fotoğrafta bu işlemleri uygulamak için eklen-
ti oluşturmayı sağlar. Çoklu fotoğraf düzenlemelerinde hızlı 
çözüm sunduğu için tercih edilir.

History, yapılan işlemlerin geçmişini görebilmek ve istendi-
ğinde bu işlemleri geri alabilmek için kullanılır. Ancak bu geri 
alma işlemi sınırsız değildir.

Görsel 1.2: Program arayüzü  Görsel 1.3: Paneller menüsü
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Araç Çubuğu 
Fotoğraf üzerinde seçme, taşıma, kırpma, düzeltme gibi işlemlerin yapılmasına yarayan 
araçların bulunduğu alana araç çubuğu denir. Araç çubuğu, programda kullanılan araç-
lara daha kolay ulaşabilmeyi sağlar. Birçok programda üst veya yan alanlarda görünür. 
Görüntü düzenleme programında sol yana yaslı tek sütunda görünen araç çubuğunun 
üstünde bulunan çift oka tıklanıldığında çift sütunda da görülebilir (Görsel 1.4).  

En üstte taşıma ve seçim araçları bulunur. Bunların hemen altında kırpma ve dilimleme 
araçları vardır. Bu araçların altında ise ölçüm araçları, altta rötuşlama ve boyama araç-
ları bulunur. Bunların altında çizim ve yazım araçları vardır. Son olarak da altta gezin-
me araçları bulunur. Araç çubuğundaki her aracın bir simgesi bulunmaktadır. Program 
içerisinde yer alan tüm araçlar, araç çubuğunda gösterilmez. Görünen araçların altında 
küçük bir ok görünüyorsa arkada daha fazla araç var demektir. Bu oka tıklanarak diğer 
araçlar seçilebilir.

Görsel 1.4: Araç çubuğu

 Move Tool 
(Taşıma Aracı)

Marquee Tool 
(İşaretleme Aracı)

 Lasso Tool 
(Kement Aracı)

Magic Wand Tool 
(Sihirli Değnek Aracı)

 Crop Tool 
(Kırpma Aracı)

Eye Droper Tool
(Damlalık Aracı)

 Spot Healing Brush 
(Düzeltme Fırçası)

Healing Brush Tool 
(İyileştirme Fırçası Aracı)

Patch Tool 
(Yama Aracı)

Content Avare Move Tool 
(İçeriye Duyarlı Taşıma Aracı)

Brush Tool 
(Fırça Aracı)

Clone Stampt Tool 
(Klonlama Aracı)

History Brush Tool 
(Geçmişe Dönüş Fırça Aracı)

Eraser Tool 
(Silgi Aracı)

 Gradient Tool 
(Degrade Aracı)

Blur Tool 
(Bulanıklaştırma Aracı)

Sharpen Tool 
(Keskinleştirme Aracı)

Dodge Tool 
(Aydınlatma Aracı)

 Type Tool
(Yazı Aracı)

Pen Tool 
(Kalem Aracı)

 Path Selection 
(Yol Seçme Aracı)

Hand Tool 
(El Aracı)

 Zoom Tool 
(Yakınlaştırma Aracı)

3D Material Eye Dropper Tool 
(3D Damlalık Aracı)

Background Color 
(Arka Plan Rengi)

 Foreground Color 
(Ön Plan Rengi)

Change Screen Mode 
(Ekran Modu Değiştirme)

 Quick Mask Mode
(Hızlı Maskeleme)
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1.1.3. Dosya Boyutunu Ayarlama
Program içerisinde oluşturulan veya dışarıdan yüklenen 
herhangi bir dokümanın çözünürlüğünün ve boyutunun 
ayarlanması Image menüsünden Image Size (Imıc Sayz) 
komutu ile yapılır (Görsel 1.5). Bir dokümanın çözünürlük 
ve boyut bilgilerine de buradan ulaşılabilir. Menü içerisinde 
görüntünün piksel, inch (inç), milimetre, santimetre gibi ölçü 
birimlerindeki karşılıkları görünür.

Image Size 
Görüntünün boyutu, Image Size komutunda genişlik Width 
(Wid) ve yükseklik Height (Hayd) ölçüleri ile ayarlanır. Bu öl-
çüler, yanında görünen zincir işaretiyle birbirine bağlıdır. Bu-
nun anlamı, bu değişkenlerden herhangi biri değiştirildiğinde 
diğerinin de aynı oranda değiştirileceğidir. Gerekli durumlar-
da bu zincir üzerine tıklanarak bağlantı kaldırılabilir. Bağlantı 
kaldırıldığında değişkenler birbirinden bağımsız şekilde bo-
yutlandırılabilir.

Image Size komutundaki Resolution (Rezuluşın) seçeneği, 
çalışılan dosyanın çözünürlük değerini gösterir. Çözünürlük 
değeri piksel/inç veya piksel/santimetre ölçü birimleri ile 
kullanılabilir. Özellikle baskı yapılacak dokümanlarda çö-
zünürlüğe dikkat edilmelidir.Resolution değeri artırıldığında 
program dokümana yeni piksel sayıları ekler. Resolution de-
ğeri azaltıldığında ise piksel sayısı azaltılır. Bu artırılan ve 
azaltılan piksellerin nasıl ekleneceği Resample (Risembıl) 
sekmesi işaretlendiğinde açılan seçeneklerden belirlenir. 
Bu seçenekler şunlardır:

Piksel tabanlı programın arayüzünü (araç çubuğu, paneller ve menüler) 
inceleyerek denemeler yapınız.

•	 Piksel tabanlı programı, simgesine tıklayarak açınız. 
•	 Programın araç çubuğu inceleyiniz. 
•	 Window menüsünden panellerin görünürlüğünü açıp kapatarak piksel ta-

banlı programın arayüzünü kendi tercihlerinize göre oluşturunuz. 
•	 Panelleri birbirine bağlayınız.
•	 Programın menülerini inceleyiniz.
•	 Geçmişte kullandığınız programlar ile piksel tabanlı programın benzer ve 

farklı yönlerini söyleyiniz.

1.ETKİNLİK
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Görsel 1.5: Image Size penceresi

Genişlik

Sığdır

Yükseklik
Çözünürlük Değeri

Yeniden Örnekleme Seçenekleri

Automatic (Automatik): Otomatik
Preserve Details (Pirizörv Ditayls): Ayrıntıları koru
Bicubic Smoother (Baykubik Simudır): Daha yumuşak
Bicubic Sharper (Baykubik Şarpır): Daha keskin
Bicubic (Baykubik): Çevre piksellerin renk ortalaması
Nearest Neighbour (Niırıst Neybur): En yakın komşu 
Bilinear (Bayliniır): Çift doğrusal                                      

Baskı Boyutları 
Dots per inch (dats per inç), DPI olarak kısaltılmaktadır. DPI özellikleri, görüntüler basılı ola-
rak kullanılmak istendiğinde önem kazanmaktadır. DPI, inç başına düşen nokta sayısıdır. 
Basılacak görüntünün her bir inçte bulunan küçük noktaların sayısını belirtir. DPI ne kadar 
büyükse nokta sayısı o kadar fazla olur. Bu durum baskının daha net olmasını sağlar. Baskı 
üretiminde piksel yerine nokta kullanılmaktadır. Baskı üretiminde DPI çözünürlüğü ne kadar 
yüksek olursa o kadar fazla nokta vuruşu yapılır. 300 DPI çözünürlük 1 inç ölçü içine 300 
nokta vuruşu yapılacağı anlamına gelir. Fotoğrafların yüksek çözünürlükle çekilmeleri ve 
yüksek çözünürlükleri korunarak kaydedilmeleri gerekir. 
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Inç, İngiliz uzunluk 
ölçü birimidir. Bir inç 

2.54 cm’ye eşittir.

Görsel 1.6: Image menüsü

Bilgisayar ortamında PPI [Pixel Per Inch (Piksıl Pör İnç)] inç 
başına düşen piksel sayısıdır. Dijital görüntüleri oluşturan 
pikseller görüntünün ekranda görünmesini sağlayan renk 
kutucuklarıdır. Bu renk kutucukları ne kadar fazla sayıda 
olursa görüntüde o kadar fazla detay yer alır. Fotoğraflar 
ekranlarda görüntülenirken 72 PPI genellikle yeterli bir gö-
rünüm sağlar ancak baskı için kullanılacaklarsa bu değerin 
en az 300 PPI olması beklenir. Yüksek çözünürlükle çekilen 
görüntülerin PPI’sı düşürülebilir. Düşük çözünürlükle çe-
kilmiş görüntülerin ise PPI’sı yükseltilse bile görüntü belirli 
boyutların üzerine çıkarıldığında baskı kaliteli olmayacak-
tır. Çekilmiş görüntünün PPI kontrolü, Image menüsünden 
Image Size komutu ile yapılır (Görsel 1.6, 1.7). 

Fotoğraf, profesyonel bir fotoğraf makinesiyle yüksek çözü-
nürlükte çekilmişse en az 300 piksel olarak gelecektir. Re-
solution seçeneği fotoğrafın çözünürlüğünü göstermekte-
dir. Bu çözünürlük 300 PPI’dan 72 PPI’ya düşürüldüğünde 
görüntü boyutları da (Dimensions) değişecektir. 

Fotoğraf baskısı, görüntünün fotoğraf kâğıdına veya farklı 
baskı seçenekleriyle bir yüzeye yüksek çözünürlükle basıl-
masıdır. Farklı kullanım alanları için farklı boyutlarda isteni-
len türde baskı yapılabilmektedir. Çoğunlukla fotoğraf baskı-
sı Tablo 1.1’deki boyutlarda yapılmaktadır.

4x6 cm

5x7 cm

8x10 cm

10x13 cm

10x20 cm

11x14 cm

16x20 cm

20x24 cm

20x30 cm

Tablo 1.1: Baskı Boyutları
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Baskı Kâğıdı Seçme
Fotoğraf kâğıdı, fotoğrafın özelliğine göre seçilmelidir. Fotoğraf kâğıdının doğru seçilmesi 
baskı kalitesini de doğrudan etkiler. 

Mat kâğıt, ışık yansımasının istenmediği yüzeylerde tercih edilir. Mat kâğıt ile yapılan bas-
kılarda renkler daha az kontrastlıdır. Cam veya plastikle üzeri kaplanmadan direkt sergi-
lenir. 

Yarı mat kâğıtlar, saten veya yarı parlak kâğıt olarak da adlandırılır. Diğer kâğıtlara göre 
daha ağırdır. Yüzeyi dokuludur ve bu dokulu yüzey; parlamalar, parmak izi veya küçük 
çiziklerin görünümünü en aza indirir. Fotoğrafın her açıdan rahat izlenmesini sağlar. Fotoğ-
rafçılar genellikle bu baskı kâğıdını tercih etmektedir.

Parlak kâğıt, renklerin daha parlak görünmesini sağlar. Doğru aydınlatılma yapılmadan 
izleyiciye sunulduğunda fotoğrafın görülmesini zorlaştırır. Yansımalar, kâğıt üzerinde olu-
şan parmak izi ve çizik gibi kusurları gösterir. Bu nedenle baskı aşamasından çerçeveye 
yerleştirilme aşamasına kadar dikkatli olunmalıdır. Doğru ışıkla aydınlatıldığında yüksek 
kaliteli görünüm sağlar. 

Metalik kâğıt, zengin renk seçeneği sunar. Yarı parlak yüzeylidir. Fotoğraf baskılarında kes-
kinlik ve derinlik sağlar. Fotoğraflar metal bir levha üzerine basılmış gibi görünür. Diğer baskı 
türlerine göre maliyeti daha yüksektir. Koruyucu şeffaf bir malzeme ile üzeri kaplanırsa baskı-
lar uzun süre sorunsuz olarak saklanabilir. 

Görsel 1.7:  300 PPI/72 PPI



BİLGİSAYARDA FOTOĞRAF DÜZENLEME

24 Bilgisayarda Fotoğraf

Canvas Size
Açılan bir dokümanın çalışma alanı boyutunun değiştirilmesi Image menüsünden Canvas 
Size (Kenvıs Sayz) komutu ile yapılır (Görsel 1.8). New Size başlığı altında Width ve 
Hight seçenekleri değiştirilerek yeni boyut seçilebilir. 

Altta yer alan Relative seçeneği seçildiğinde Width ve Hight değerleri sıfır görünecektir 
(Görsel 1.9). Canvas Size komutunda yer alan Anchor (Enkır) seçeneği, oluşacak yeni 
dokümanın ne taraftan büyütüleceğinin belirlendiği alandır. Özellikle çoklu görüntü kulla-
nılan manipülasyonlarda eklemenin yapılacağı alanın genişletilmesi için seçenek kişisel-
leştirilebilir. Oklar, dokümanın hangi yönde genişletileceğini gösterir. 

Görsel 1.8: Canvas Size komutu

Görsel 1.9: Canvas Size açılır penceresi
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1. UYGULAMA

UYGULAMA ADI	:	Fotoğraf Baskı Boyutu Ayarlama 
AMAÇ	 :	Fotoğrafı baskıya uygun hâle getirmek.

Aşağıdaki işlem basamaklarını dikkate alarak seçeceğiniz bir fotoğrafı 
baskıya uygun hâle getiriniz. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapabileceğiniz 

bir fotoğraf belirleyiniz.
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğraf baskısı için uygun çözünürlüğü kontrol ediniz.
5.	 Fotoğrafın dosya boyutuna dokunmadan baskı boyutunu ve çözünürlüğünü 

değiştiriniz. 
6.	 Gerekli düzenlemeleri yaparak fotoğrafı kırpınız.  
7.	 Fotoğrafı baskı boyutuna uygun hâle getirene kadar çalışmanızı 
	 tekrarlayınız.
8.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
9.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşınabilir 

belleğinize kaydediniz.
10.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
11.	Görüntü düzenleme programınızı kapatınız. 
12.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygula-
ma çalışmanız, Ek 1’de verilen “1. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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1.1.4. Yeni Belge Açma
Görüntü düzenleme programında herhangi bir düzenleme 
yapabilmek için öncelikle yeni bir belge açılmalıdır. Yeni bel-
ge açmak için File menüsünden New (Fayl > Niv) komutu 
verilmelidir. Kısayolu Ctrl+N / Command+N tuşlarıdır. Belge 
ölçüleri, renk modu seçenekleri, arka plan seçenekleri bu 
ekranda belirlenir (Görsel 1.10). 

Görsel 1.10: File menüsü New komutu

1.1.5. Görüntü Kırpma
Görüntüde istenmeyen nesnelerin yer alması nedeniyle veya 
daha küçük bir alanın ihtiyacı karşılayabileceği düşüncesiyle 
orijinal boyut üzerinde kırpma yapılabilir. Bu kırpma işlemi sa-
dece hata giderme olarak değil aynı zamanda yeniden yaratı-
cı kadrajlama olarak düşünülmelidir. Crop Tool (Kırop Tuul) 
seçim aracıyla görüntü üzerinde istenilen boyutta kırpma ya-
pılır. Boyutlandırma serbest yapılabileceği gibi üst tarafta yer 
alan seçeneklerle hazır ölçüler kullanılarak da yapılabilir. Ha-
zır ölçülerin kullanılması görüntünün orijinal boyutunda gibi 
görülmesini sağlayacaktır. İstenilen ölçüleri kullanım alanına 
göre belirlemek de doğru bir tercihtir (Görsel 1.11).
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Görsel 1.11: Crop Tool
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1.1.6. Ufuk Çizgisi Düzeltme 
Fotoğraflarda ufuk çizgisi düz çekilmek istendiğinde her zaman istenilen sonuca ulaşıla-
mamaktadır. Fotoğrafta istenilmeyen bu eğrilik görüntü düzenleme programında düzelti-
lebilir. Bu tür fotoğraflarda görüntünün ne kadar düzeltilmesi gerektiğini ölçmek için View 
(Viuv) menüsünden Ruller (Rulır) komutu seçilerek görüntünün üzerine yerleştirilir. Crop 
Tool aracında Perspective Crop Tool (Pörspektiv Krap Tuul) ile fotoğraf üzerinde kareler 
yardımıyla perspektif gözlemlenebilir. Perspektif Tool komutu seçildikten sonra mouse 
ile fotoğraf seçilir. Mouse ile görüntünün yanındaki çizgilere yaklaşıldığında döndürme 
işareti çıkacaktır. Bu seçimle görüntü döndürülebilir hâle gelir. İstenilen döndürme nok-
tasına gelindiğinde mouse ile seçim bırakılarak görüntü üzerine tıklanır. İstenirse Ruller 
kullanılmadan da görüntü üzerindeki kareler yardımıyla döndürme ayarlanabilir. Ufuk 
çizgisi gereği kadar düzeltildikten sonra fotoğraf kenarında oluşan boşluklar Crop Tool 
ile kesilmelidir (Görsel 1.12).

Görsel 1.12: Ufuk çizgisi düzeltme işlemi
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UYGULAMA ADI	:	Fotoğrafta Ufuk Çizgisi Düzeltme  
AMAÇ	 :	Fotoğraflarda ufuk çizgisi düzeltmek.

Aşağıdaki işlem basamaklarını dikkate alarak ufuk çizgisi eğri çekilmiş bir 
fotoğrafın ufuk çizgisini düzeltiniz. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı 
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Ufuk çizgisi eğri olan bir fotoğraf belirleyiniz. 
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğrafın ufuk çizgisini düzeltiniz. 
5.	 Yeni oluşturduğunuz fotoğrafı kırpınız. 
6.	 Gerekli düzenlemeleri yaparak fotoğrafı taşınabilir belleğinize kaydediniz.
7.	 Fotoğrafın ufuk çizgisi düzelene kadar çalışmanızı tekrarlayınız. 
8.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.
9.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşınabilir 

belleğinize kaydediniz.
10.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
11.	Görüntü düzenleme programınızı kapatınız. 
12.	Bilgisayarınızı Başlat menüsünden kapatınız. 
 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 1’de verilen “2. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

2. UYGULAMA
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1.2. RENK AYARI
Fotoğrafçı, fotoğrafı çekmeden önce fotoğraf makinesinde 
renk ayarları yapabilir. Ancak fotoğrafı son kullanıma sunma-
dan önce yeniden kullanım amacına uygun yeni bir düzen-
leme yapması gerekebilir. Fotoğraf makinesinde istenilen 
sonuca yakın bir sonuç elde edilse de görüntü düzenleme 
programında son bir kontrol yapılarak fotoğraf kullanıma ha-
zır hâle getirilmelidir. 

Görüntülerde renk düzeltmeleri Image menüsünde açılan 
alt menü Adjustments (İmıc > Edcastmınts) menüsünün 
altındaki komutlarla yapılabilir (Görsel 1.13). Birçok renk 
düzeltme seçeneğinin olduğu bu açılır alt menüdeki bazı 
komutlardan aynı sonuca ulaşılabilirken bazılarından farklı 
sonuçlara ulaşmak mümkündür. Buradaki kullanım kişilere 
ve program bilgisine göre farklılık gösterecektir. Fotoğrafı 
düzenleyen kişinin görselde ulaşmak istediği sonuç doğrul-
tusunda da bu renk düzenlemeleri değişiklik göstermektedir. 
Adjustments açılır alt menüsünde Brightness / Contrast (Bı-
raytnıs / Kontrast), Hue / Saturation (Hu / Saçureyşın) gibi 
birçok komut bulunmaktadır.

Görsel 1.13: Image > Adjustments açılır alt menüsü
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1.2.1. Brightness / Contrast 
Görüntü üzerindeki renklerin parlaklık ve kontrastını artırıp 
azaltmak için Brigthness / Contrast seçeneği kullanılır. Görsel 
1.14’te görüldüğü gibi Image > Adjustments > Brigthness / 
Contrast komutu seçildiğinde üzerinde Contrast ve Brigthness 
komutlarının bulunduğu işlem penceresi açılır (Görsel 1.15). 
Brigthness parlaklığı, Contrast ise kontrastı ayarlar. Bu işlem, 
sürgünün ileri geri hareket ettirilmesiyle ya da sayısal değerle-
rin girilmesiyle yapılır. Görüntü üzerinde istenilen parlaklık ve 
kontrast, bu değerler değiştirilerek elde edilir. Bu iki seçeneğin 
düzenlenmesiyle fotoğraftaki renkler daha canlı ve parlak gö-
rünebilir. 

Görsel 1.14: Brigthness / Contrast komutu

 Görsel 1.15: Brigthness / Contrast işlem penceresi
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1.2.2. Hue / Saturation 
Image > Adjustments > Hue / Saturation komutuyla görüntü üzerin-
de üç farklı değişiklik yapılabilir (Görsel 1.16). Hue seçeneği, renklerin 
başka bir renge dönüştürülmesi için kullanılır. 

Görsel 1.17: Hue / Saturation açılır penceresi

Saturation seçeneği, renklerin yoğunluk ve doygunluk derecesini be-
lirlemek için kullanılır. Lightness (Laytnıs) seçeneği ise renk tonunu 
açmak veya soldurmak için kullanılır (Görsel 1.17). 

Görsel 1.16: Hue / Saturation çalışma alanı
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Preset (Pirizıt) sekmesinden hazır renk seçenekleri tercih edilebilir (Görsel 
1.18). Preset sekmesinin altında yer alan ve ilk açıldığında Master (Mastır) 
olarak görünen seçenekle görüntüye göre renkler seçilerek seçilen renkler 
üzerinde değişiklik yapılabilir ( Görsel 1.19). 

Görsel 1.18: Hue / Saturation açılır penceresi

Görsel 1.19: Hue / Saturation açılır penceresi
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1.2.3. Photo Filter 
Image > Adjustments > Photo Filter (Foto Filtır) komutu seçildiğinde görüntü üzerine 
renk filtresi uygulanılarak baskın renk artırılabilir ya da azaltılabilir. Bu uygulama çekim 
sırasında kullanılan renkli filtreler gibi düşünülebilir. Uygulanan renk filtresine göre bazı 
renklerin geçişi kolay olacak bazı renklerin geçişi ise baskılanacaktır (Görsel 1.20).

Görsel 1.21: Image > Adjustments > Photo Filter renk paleti

Siyah ve beyaz filtre kullanıldığında ise görüntünün tüm renkleri açılıp koyulaşacaktır. 
Renk filtresi seçildikten sonra renk oranı da ayarlanmalıdır. Görsel 1.21’de görüldüğü 
gibi kırmızı filtre kullanılarak manzara daha sıcak renklere çevrilmiştir.

Görsel 1.20: Image > Adjustments > Photo Filter komutu
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1.2.4. Replace Color 
Görüntü üzerinde tek bir renkte değişiklik yapılmak istendiğinde Image > Adjust-
ments > Replace Color (Repleys Kalır) komutuyla renk seçilerek değişiklik yapı-
labilir (Görsel 1.22). 

Görsel 1.22: Image > Adjustment > Replace Color komutu
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Damlalıkla seçilmiş rengin değiştirilmek istenen alanı 
Fuzziness (Fazinıs) skalası kullanılarak seçilmelidir. Bu 
seçenek ne kadar artırılırsa uygulanan alan da artacak ne 
kadar azaltılırsa uygulanan alan da azaltılmış olacaktır. 
Damlalık (+) ile birden fazla renk alanı seçilebilir veya (–) 
seçeneği ile seçilmiş  renkler bırakılabilir (Görsel 1.23). 

Görsel 1.23: Image > Adjustment > Replace Color açılır penceresi
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1.2.5. Match Color 
Herhangi bir görüntünün renk tonlarını farklı bir görüntüye uygulamak veya aynı tonlarda 
görüntüler oluşturabilmek için Image > Adjustment > Match Color (Meç Kalır) açılır 
penceresiyle çalışılmalıdır (Görsel 1.24). 

Bunun için öncelikle iki görüntü de çalışma alanı içerisinde açılmalıdır. Window menü-
sünden Arrange 2 Up Vertical (Erınç Tu Ap Vörtıgıl) komutu seçilir. Daha fazla görselle 
çalışılacaksa bu komut değiştirilebilir. Rengi değiştirilecek görüntü tıklanarak seçilir. Ar-
dından Image menüsünden Adjustment > Matc Color komutu seçilir. Alt kısımda bu-
lunan Source (Sors) seçeneğiyle açılan işlem penceresinden kullanılacak görüntünün 
renkleri seçilir. Image Options (İmiç Opşıns) seçeneğinden yoğunluk, parlaklık ve sol-
gunluk dereceleri ayarlanır. Buradaki seçenekler kişinin görüntüyü nasıl kullanacağına 
göre değişiklik gösterebilir. Görsel 1.25’te sadece Fade (Feyd), Luminance (Luminıns) 
ve Color Intensity (Kalır İntensiti) seçenekleri değiştirilerek çiçeklerdeki renk çok az de-
ğiştirilmiştir. Fon ise diğer görüntünün rengine fazla yakınlaştırılmıştır. Özellikle birkaç 
fotoğrafın birleştirilmesiyle oluşturulan manipülasyon işlemleri öncesi bu işlem yapılarak 
görüntüler arasındaki renk dengelenebilir.  

Görsel 1.25: Match Coloraçılır penceresi

Görsel 1.24: Match Color 
komutu
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1.2.6. Channel Mixer 
Görüntünün rengini, renk kanallarını karıştırarak değiştir-
mek için Image > Adjustments > Channel Mixer (Çenıl 
Miksır) komutu kullanılır (Görsel 1.26). 

Yeni açılan işlem penceresinde kırmızı, yeşil, mavi renk 
seçenekleri görülür. Bu seçenekler değiştirildiğinde görün-
tü üzerinde bulunan aynı isimli renklere müdahale edilmiş 
olur. Aynı zamanda altta bulunan Contrast seçeneğiyle 
görüntüdeki rengin baskınlığına müdahale edilebilir. Altta 
bulunan Monokrom (Monokırom) seçeneği seçilirse gö-
rüntü monokrom renklere çevrilecektir. Görüntü siyah be-
yaza çevrilmek istendiğinde, bu sekmeden üst tarafta açılır 
menü içerisinde bulunan siyah beyaz seçeneklerden gö-
rüntüye uygun olanı seçilmelidir (Görsel 1.27). 

Görsel 1.26: Image > Adjustments > Channel Mixer açılır penceresi

Görsel 1.27: Image > 
Adjustments > Channel Mixer 

komutu
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1.2.7. Black & White 
Görüntü siyah beyaza çevrilmek isteniyorsa kullanılacak 
en etkili yöntem renk tonlarının ayarlanabildiği Image > 
Adjustments > Black & White (Bilek end Vayt) komutu-
dur (Görsel 1.28). Görüntü tek bir tondan oluşmaz. Renkli 
görüntülerde olduğu gibi siyah beyaz görüntülerde de renk 
tonları görünür olmalıdır. Siyah beyaz görüntüde de tüm 
renk tonlarının ayarlanabildiği seçenekle çalışılmalıdır. 
Her görüntünün farklı rengi ve renk tonu bulunmaktadır. Bu 
nedenle her ton görüntüye göre şekillendirilmelidir. Black 
& White bölümüyle çalışılmasının en büyük avantajı kont-
rastla ana konunun ön plana çıkarılmasıdır. Bu menü ile 
fotoğraf içerisindeki renklerin ışık ve gölge değerleri ara-
sındaki ilişkiden yararlanılır. Anlatılmak istenen duygu ve 
düşünceler doğrultusunda görüntü şekillenir (Görsel 1.29).

Görsel 1.29: Image > Adjustments > Black & White açılır penceresi

Görsel 1.28: Image > 
Adjustments > Black & White 

komutu
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1.2.8. Desaturate 
Image > Adjustments > Desaturate (Disaçüreyt) komu-
tu seçildiğinde herhangi bir işlem penceresi açılmadan 
görüntü sepya tonlarına çevrilir (Görsel 1.30). Hue / Sa-
turation komutuyla da Saturation seçeneğinin -100’e ge-
tirilmesiyle aynı sonuca tek işlemle ulaşılır (Görsel 1.31).

Görsel 1.31: Image > Adjustments > Desaturate 
komutunun uygulanması

BİLGİ 
KUTUSU

Sepya tonu, gri tonlama 
yerine koyu tonda basıl-
mış fotoğrafı ifade eder. 
Ortaya çıkan görüntü, 

sıcak kahverengi ve al-
tın tonlarındadır. Birçok 
eski fotoğraf, mürekkep 
balıklarından elde edilen 

sepya mürekkebiyle 
basılmıştır. Bu nedenle 
günümüzde bu tarzda 

basılan fotoğraflar daha 
eski bir dönemi çağrış-
tırmaktadır. Dijital fotoğ-
raf düzenleme program-
larında sepya seçeneği, 

fotoğrafın daha eski 
görünmesini ve hissedil-
mesini sağlamak veya 

fotoğrafa stil katmak için 
kullanılır.

Görsel 1.30: Image > Adjustments 
> Desaturate komutu
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1.2.9. Threshold 
Image > Adjustments > Threshold (Tireşhold) komutu, 
görüntü üzerindeki tüm renklerin siyah ve beyaza çevril-
mesidir (Görsel 1.32). Threshold komutunda orta tonlar 
yoktur. Threshold komutu seçildiğinde görüntünün His-
togram sekmesi gelir. Histogram, açık ve koyu alanları 
gösterir. Bu histogram üzerinde ibre sağa ve sola hareket 
ettirildikçe görüntünün siyah ve beyaz alanlarında deği-
şim meydana gelir (Görsel 1.33). Görüntünün özelliği ve 
verilmek istenen etkiye göre bu seçenek değiştirilerek Ok 
tuşu tıklanır.

Görsel 1.33: Image > Adjustments > Threshold komutunun uygulanması

Görsel 1.32: Image > Adjustments 
> Threshold komutu
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1.2.10. Invert 
Image > Adjustments > Invert (İnvört) komutu herhangi 
bir işlem penceresi açılmadan fotoğrafların renklerini ne-
gatife çevirme işlemini gerçekleştirir (Görsel 1.34). Fotoğ-
rafın tamamı negatife çevrilebileceği gibi sadece belirli bir 
alan da negatife çevrilebilir (Görsel 1.35).

Görsel 1.35: Image > Adjustments > Invert komutunun uygulanması

Görsel 1.34: Image > 
Adjustments > Invert komutu
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1.2.11. Posterize 
Image > Adjustments > Posterize (Postırayz) komutu, 
görüntü üzerinde benzer renklerin birleştirilerek tek ren-
ge dönüştürülmesi işlemidir (Görsel 1.36). Görüntüde yer 
alan renk, kontrast ve ışık değerlerinin bu filtreyle yeniden 
değerlendirilerek fotoğrafın görsel açıdan grafikselleştiril-
mesi ve resimsel bir hâle getirilmesi işlemidir. Bu işlemle 
fotoğraf içindeki renkler birbirinden grafiksel çizgilerle ve 
renklerindeki tonaj farklarıyla ayrışmakta ve fotografik gör-
sel açıdan yeni bir ifade biçimi olarak ortaya çıkmaktadır. 
Açılır işlem penceresinde Level (Levıl) seçeneğiyle görün-
tü üzerine posterize etkisinin ne kadar uygulanacağı belir-
lenir (Görsel 1.37). Preview (Piriviyuv) seçeneği seçilirse 
oluşacak etkinin ön izlemesi yapılabilir.

Görsel 1.36: Image > 
Adjustments > Posterize komutu 

Görsel 1.37: Image > Adjustments > Posterize komutunun uygulanması
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1.2.12. Selective Color 
Image > Adjustments > Selective Color (Selektiv Kalır) 
komutu, görüntüdeki renklerin azaltılıp çoğaltılması için 
kullanılan seçenektir (Görsel 1.38). Bu komutla görüntü 
üzerinde tek bir renkte değişiklik yapılabileceği gibi birçok 
farklı renk seçilerek de değişiklik yapılabilir. Değişiklik ya-
pılmak istenen renk üzerinde açılır işlem penceresinden 
o renk seçilerek altta yer alan renklerle ibreler oynatılır. 
Bu durumda azaltıp çoğaltma işlemi gerçekleştirilmiş olur 
(Görsel 1.39). İstenilen sonuca ulaşıldığında Ok tuşuna 
basılarak asıl çalışma sayfasına dönüş yapılabilir. 

Görsel 1.39: Image > Adjustments > Selective Color komutunun uygulanması

Görsel 1.38: Image >
 Adjustments > Selective Color 

komutu
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1.2.13. Color Balance 
Image > Adjustment > Color Balance (Kalır Balıns) ko-
mutu, görüntüdeki renk tonlarını belirli bir renge çekmek 
için kullanılır (Görsel 1.40). Açılır işlem penceresinde kar-
şılıklı renk isimlerinin yer aldığı bir imleç bulunmaktadır. 
Bu imleç hangi rengin tarafına doğru çekilirse görüntü üze-
rinde o renk artırılır. Bir renk azaltılmak isteniyorsa içinde 
bulunan diğer renklere de müdahale etmek daha doğru 
sonuç verecektir. Color Balance seçeneğinde gölgeler 
Shadow (Şadov), orta tonlar Midtones (Midtons), aydınlık 
tonlar için Highlights (Haylayts) seçenekleri bulunur (Gör-
sel 1.41). Görüntü üzerinde sadece aydınlık alanlarda de-
ğişiklik yapılacaksa Highlights, genel bir değişiklik yapıla-
caksa Midtones seçeneği seçilmelidir.

Görsel 1.40: Image > 
Adjustment > Color Balance 

komutu

Görsel 1.41: Image > Adjustment > Color Balance 
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1.2.14. Gradient Map 
Gradient Map (Girediyınt Mep) özelliği, “görüntü üzerinde birçok renk kombinasyonun 
birleşimi” olarak adlandırılabilir. (Görsel 1.42). Gradient Map renkleri seçilip görsele uy-
gulanabileceği gibi kullanıcı kendi renklerini de tasarlayabilir. Image > Adjustments > 
Gradient Map açılan işlem penceresinde renklerin görüldüğü yere tıklanılarak altta açı-
lacak alandan farklı renk seçeneklerinden biri seçilir. Görüntü üzerinde seçilen rengin 
uygulanmış hâli görülecektir. Renk geçişinin görüldüğü boya kutucukları renk duraklarını 
gösterir. Bu kutucuklara tıklanılarak açılan Color Picker (Kalır Pikır) seçeneğinden kulla-
nılmak istenen renk seçilebilir. Siyah yerlerin beyaz, beyaz yerlerin siyah olması başka 
bir deyişle uygulanan renklerin tersi uygulanmak isteniyorsa Gradient Map komutundaki 
Reverse (Rivörs) seçeneği işaretlenmelidir. Bu işlem uygulanan renklerin tersinin uygulan-
masına olanak sağlar. Gradient Map komutu, birçok renk seçeneği sunduğu gibi görüntü 
siyah beyaza çevrilmek istendiğinde de kullanılabilir. Kullanılan yöntemlerden farklı olarak 
altta yer alan boya kutularının da yerleri oynatılarak renk tonları kolaylıkla değiştirilebilir.  

Görsel 1.42: Image > Adjustments > Gradient Map açılır penceresi
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1.2.15. Filter > Camera Raw Filter 
Fotoğrafçı, görüntü düzenleme programlarında fotoğrafları 
işleyecekse çekim sırasında RAW formatını tercih etmelidir. 
RAW, fotoğrafın ham hâline yakın ve daha fazla değişikliğe 
izin veren görüntü kayıt formatıdır. RAW formatta tüm veriler 
korunarak görüntü oluşturulurken ekstra renk, keskinlik ve 
kontrast gibi filtreler, fotoğraf makinesi tarafından eklenmediği 
için görüntü sıkıştırılamaz. JPEG çekimlerde ise görüntü sıkış-
tırıldığı için değişiklik oranı düşmektedir. Birçok görsel tasarım 
programı RAW fotoğraflar için haricî kullanım alanları sağlar. 
Çekilen RAW, görüntü düzenleme programıyla ilk açıldığında 
normal düzenleme alanından farklı olarak açılır. JPEG formatı-
na çevrilmeden önce düzeltmeler yapılır. İstenilen sonuca ula-
şıldığında görüntü düzenleme programının normal sayfasında 
ve JPEG formatında açılır. RAW formatının getirdiği bu kolay-
lık görüntü düzenleme firmalarının son dönemde programa 
kazandırdıkları bir yeniliktir. RAW formatına uygulanabilen bu 
değişikliklerin JPEG üzerinde de yapılabilmesi ve belirli ayar-
ların açılabilmesi için haricî bir filtre eklenmiştir (Görsel 1.43).  
Eklenen bu filtre, JPEG formatındaki fotoğrafa uygulandığı için 
RAW formatta çekilen bir fotoğraf gibi çok detaylı işlem yap-
maya imkân tanımamaktadır. Yapılan işlemlerde JPEG fotoğ-
raf bozulmalara uğramaktadır. 

Görsel 1.43: Filter > Camera Raw Filter komutu
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Filter menüsünden Camera Raw Filter (Kamera Raw Filtır) 
komutu seçildiğinde fotoğraf RAW formatında çekilmiş gibi 
programda ilk RAW açılma sayfası gelir. Bu filtre RAW ol-
mayan görüntünün üzerinde birçok değişikliğe imkân verir. 
Renk düzeltmeleri tek bir sekme üzerinden yapılabilmektedir 
(Görsel 1.44). 

Görsel 1.44: Filter > Camera Raw Filter komutunun uygulnması
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UYGULAMA ADI	:	Fotoğrafta Renk Düzeltme 
AMAÇ	 :	Fotoğrafın renklerini ayarlamak.

Aşağıdaki işlem basamaklarını dikkate alarak seçeceğiniz bir fotoğrafın 
renklerini değiştirerek fotoğraf üzerinde düzenleme yapınız.
 
Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapacağınız 

bir fotoğraf belirleyiniz. 
3.	 Düzenleme için seçtiğiniz fotoğrafı bilgisayara aktarınız.
4.	 Renklerle ilgili tekniklerden birini kullanarak fotoğrafı değiştiriniz. 

Değiştirdiğiniz renklerin fotoğrafı estetik göstermesine dikkat ediniz. 
5.	 Seçtiğiniz fotoğrafın işlem uygulanmış ve uygulanmamış hâllerini yan 

yana getirerek fotoğrafları karşılaştırınız. İşlem uyguladığınız fotoğraf 
renk ve estetik açıdan uygun değilse uygun hâle getirene kadar çalışma-
nızı tekrarlayınız.

6.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
7.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşına-

bilir belleğinize kaydediniz.
8.	 Taşınabilir belleğinizi bilgisayardan çıkarınız. 
9.	 Görüntü düzenleme programınızı kapatınız. 
10.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Uygulama çalışmanız, Ek 1’de verilen “3. Derecelendirme Ölçeği”ndeki 
ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate 
alınız.

3. UYGULAMA
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1.3. IŞIK AYARI
Fotoğraf çekimlerinde en önemli kriter ışık kullanımıdır. Çekim sırasında genellikle is-
tenilen sonuç elde edilir. Ancak bazı durumlarda istenilene yakın sonuçlar elde etmek 
de mümkündür. Çekim sırasında fotoğraf üzerindeki ışık iyi sonuçlanmamışsa görüntü 
düzenleme programlarında bu durumun düzeltilmesi zor olabilir. Bunun tam tersi bir du-
rumda ise küçük müdahalelerle fotoğraf tam istenilen sonuca uygun düzenlenebilir.
 
1.3.1. Equalize 
Image > Adjustments > Equalize (İkualayz) fotoğraf üzerindeki en açık ve en karanlık 
bölgeleri tespit ederek, en açık tonları koyulaştırıp, en karanlık tonları da açarak fotoğ-
raftaki rengi orta seviyeye getirir. Equalize komutu sonrası fotoğrafta bir miktar kontrast 
oluşur. Equalize, belirli bir alan seçilerek de uygulanabilir. Equalize belirli bir alana uygu-
lanacaksa açılan işlem penceresinden Equalize Selected Area Only (İkulayz Selektid Ar 
Onli) seçilmelidir (Görsel 1.45). 

Görsel 1.45: Image > Adjustment > Equalize komutunun uygulanması
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1.3.2. Camera Raw Filter 
Camera Raw Filter (Kamera Rav Filtır), renk düzeltme işlem-
lerinin yanı sıra fotoğrafın ışık düzeltmeleri için de kullanılır. 
Bu özelliği kullanmak için Filter > Camera Raw Filter açı-
lır penceresi tıklanır. Açılan işlem penceresinde sağ tarafta 
Basic (Beyzik) seçeneği altında fotoğrafta hangi alanların 
ışığının değiştirilebileceğini gösteren seçenekler bulunur. 
Bu seçenekler üzerindeki ibrenin yeri değiştirilerek görün-
tü üzerindeki ışık değiştirilir (Görsel 1.46). Curve (Körv) se-
çeneğiyle de çapraz çizgi oynatılarak fotoğrafın histogramı 
üzerinde değişiklik yapılabilir.

Görsel 1.46: Filter > Camera Raw Filter komutunun uygulanması
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1.3.3. Brightness / Contrast 
Görüntüde parlaklığı ayarlamak ve kontrastta basit düzenlemeler yapmak için Image > 
Adjustments > Brightness / Contrast açılır penceresi seçilir. Brightness parlaklığın 
ayarlanması, Contrast ise kontrastta değişiklik yapmak için kullanılır. Görüntü üzerinde 
bir bölge seçilmemişse görüntünün tamamına işlem uygulanır. Sürgü sağa doğru hare-
ket ettirildiğinde parlaklık artacak, sola hareket ettirildiğinde ise parlaklık azaltılacaktır. 
Contrast için de aynı yön geçerlidir (Görsel 1.47).  

Görsel 1.47: Image > Adjustments > Brightness / Contrast komutunun uygulanması
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1.3.4. Shadows / Highlights 
Çekilen fotoğraflarda ışık koşulları bazen yetersiz kalabilmekte bazen de ters ışığa ya-
kın görüntüler öndeki nesnelerin görünürlüğünü azaltabilmektedir. Bu sorunu giderebil-
mek için en kısa yöntem gölge ve vurgulara müdahale etmektir. Bu işlem için Image > 
Adjustments > Shadows / Highlights (Şadov / Haylayts) komutu seçildiğinde sürgü, 
açılan sekme üzerinden müdahale edilmek istenen tarafa doğru sağa ya da sola hareket 
ettirilir (Görsel 1.48).

Görsel 1.48: Image > Adjustments > Shadows / Highlights komutunun uygulanması
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4. UYGULAMA

UYGULAMA ADI	:	Fotoğrafta Işık Düzenleme 
AMAÇ	 : 	Fotoğrafın ışık düzenlemelerini yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak daha önce çekilmiş bir 
fotoğrafın ışık düzenlemelerini yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapacağınız bir 

fotoğraf belirleyiniz. 
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğrafa uygun ışık ayarları yapınız.
5.	 Belirlediğiniz fotoğrafın ışık düzenlemelerini kontrol ediniz. İstediğiniz 

sonuca ulaşana kadar düzenlemeyi tekrarlayınız. 
6.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
7.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşınabi-

lir belleğinize kaydediniz.
8.	 Taşınabilir belleğinizi bilgisayardan çıkarınız. 
9.	 Görüntü düzenleme programınızı kapatınız. 
10.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Uygulama çalışmanız, Ek 1’de verilen “4. Derecelendirme Ölçeği”ndeki ölçüt-
lere göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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1.3.5. Yeni Dolgu veya Ayar Katmanı Oluşturmak
Fotoğraftaki ışığın müdahale edilmek istenen bölgeleri için öncelikle programın sağ alt 
penceresinde bulunan Layers işlem penceresine tıklanır. Layers penceresi altında bu-
lunan + ikonuna basılarak Creative a new layer (Kreativ a niv leyır) seçeneği tıklanır. 
Seçenek üzerinde Layers penceresinin altında bulunan Creative new fill or adjusment 
layer (Kreativ niv fil or edjustmınt leyır) komutu seçilir (Görsel 1.49).

Görsel 1.49: Yeni dolgu veya ayar katmanı

Açılan menüden Levels komutu seçilerek, Histogram sekmesinde ibre sağa sola doğru 
çekilerek görüntü olduğundan daha koyu ya da daha açık hâle getirilebilir (Görsel 1.50). 
Fotoğrafta en koyu olması istenen bölge, bu koyuluğa ulaşana kadar işlem devam ettirilir. 

Görsel 1.50: Yeni dolgu veya ayar katmanı
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Fotoğrafı aydınlatmak için sol tarafta Araçlar menüsü üze-
rinden fırça seçilir. Fotoğrafın açılmak istenen yeri ve açılma 
miktarına göre fırçanın boyutu ayarlanır (Görsel 1.51). 

Görsel 1.51: Fırça boyutunun ayarlanması

Sağ tarafta açılmış olan Layers sekmesinden işlemin yapılacağı Levels’ın beyaz kutu-
suna tıklanmalıdır. Daha sonra açılmak istenen bölge fırçayla boyanır. Görüntüde her-
hangi bir değişiklik olmuyorsa sol tarafta bulunan renk kutularından beyazın seçili olup 
olmadığı kontrol edilmelidir. Aydınlatılmak istenen bölge yanlışlıkla fazla açılmışsa renk 
kutularından siyah seçilerek fazla açılmış bölge, siyaha boyanabilir. Bu işlem, fotoğrafın 
o bölgesinin rengini koyu hâle getirecektir (Görsel 1.52). Kademeli bir aydınlatma isteni-
yorsa fırçanın Opacity (Opesiti) ayarı düşürülerek etki azaltılabilir. 

Fotoğrafta var olan ışık hüzmesi artırılmak ya da fotoğrafa yapay ışık eklenmek istenilirse 
öncelikle Layers işlem penceresinden + komutu tıklanarak yapay ışığın işleneceği yeni 

Görsel 1.52: Yeni dolgu veya 
ayar katmanı
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bir Layer açılır. Bu katmanla ışığın direkt fotoğraf üzerine eklenmemiş haricî bir Layer 
sayesinde kaldırılması veya düzenlenmesi daha kolay olacaktır. Daha sonra Window > 
Brushes (Bıraşıs) açılır alt menüsünden ışık hüzmesine veya spot ışığa uygun bir fırça 
seçilir (Görsel 1.53). 

Görsel 1.53: Yeni dolgu ışığı
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Spot ışığa uygun fırça yoksa güvenilir sitelerden fırça eklentisi de indirilebilir. İndirilen 
fırça, program içerisine sürüklenip bırakıldığında yüklemesi yapılacaktır. Yüklenen veya 
var olan fırçalardan ışığa uygun olan seçilir. Ardından renk kutusuna gidilerek ışık için 
uygun renk seçimi yapılmalıdır. Güneş ışığının tonları veya yapay ışık kaynaklarının ton-
ları seçilir. İstenen ışık yoğunluğuna göre fırçanın boyutu ayarlanmalıdır. Aynı zamanda 
ışığın yönü de boyutun ayarlandığı yerden yuvarlak yön düğmesi değiştirilerek ayarlanır 
(Görsel 1.54).

Görsel 1.54: Yeni dolgu ışığı
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Haricî ışık ekleme özelliklerinden bir diğeri ise Filter menüsünün açılır alt menüsünden 
Render (Rendır) tıklanarak Lighting Effects (Layting Efekts) komutunun seçilmesidir 
(Görsel 1.55). Işık efekti verilebilecek bu sekme açıldığında üst tarafta görünen Presest 
(Piresist) ön ayarlar ile ışığın özelliği seçilir. Preview (Pireviyuv) ön özleme seçeneği 
tıklanarak ışığın fotoğraf üzerindeki etkisi anlık olarak görülebilir. 

Görsel 1.55: Fotoğrafta yapay ışıklandırma
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Üçlü ışık kaynağı, soft ışık, RGB gibi seçeneklerden biri 
seçildiğinde fotoğraf üzerinde ışık görünür. Spot ışık görü-
nümündeki bu özelliğe mouse ile scala noktalarından mü-
dahale edilerek genişlik, yön, boyut gibi özellikler de değiş-
tirilebilir. Sağ tarafta yer alan Properties (Pırapırtiıs); ışığın 
noktasal, spot, sonsuz, renk, parlaklık gibi özelliklerini kişisel 
olarak değiştirebilmeye olanak sağlar (Görsel 1.56). Işığın 
fotoğraf üzerinde olması istenen hâline göre değişiklik ya-
pılmalıdır. Haricî ışık uygulaması tamamlandıktan sonra üst 
kısımda yer alan Ok seçeneğine basılarak programın asıl 
çalışma alanına dönülmelidir. Haricî ışık, özellikle ışık hüz-
melerinde etkiyi artırmak için kullanılabilir. 

Görsel 1.56: Fotoğrafta yapay ışıklandırma
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5. UYGULAMA

UYGULAMA ADI	:	Fotoğrafa Haricî Işık Ekleme 
AMAÇ	 :	Fotoğrafın ışığını düzenlemek ve fotoğrafa haricî ışık ...
			   eklemek.

Aşağıdaki işlem basamaklarını dikkate alarak daha önce çekilmiş bir 
fotoğrafın ışık ayarlarını yapınız ve fotoğrafa haricî ışık ekleyiniz. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapacağınız bir 

fotoğraf belirleyiniz.
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğrafa uygun ışık ayarları yapınız.
5.	 Düzenlemiş olduğunuz fotoğrafa ışığın geliş yönüne uygun haricî ışık 

eklemesi yapınız. 
6.	 Belirlediğiniz fotoğrafın ışığını ve eklediğiniz ışığın etkilerini kontrol ediniz. 

İstediğiniz sonuca ulaşana kadar düzenlemeyi tekrarlayınız. 
7.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
8.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşınabilir 

belleğinize kaydediniz.
9.	 Taşınabilir belleğinizi bilgisayardan çıkarınız. 
10.	Görüntü düzenleme programınızı kapatınız. 
11.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Uygulama çalışmanız, Ek 1’de verilen “5. Derecelendirme Ölçeği”ndeki ölçütlere 
göre değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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1.4. RÖTUŞLAMA 
Fransızcadan dilimize yerleşen rötuş sözcüğü düzeltmek anlamında kullanılmaktadır. 
Rötuş, fotoğraflar kullanıma sunulmadan önce hataları varsa gidermek ve düzeltmek 
amacıyla yapılan her türlü değişikliğe verilen genel isimdir. Bilgisayar ortamında fotoğ-
raflar daha canlı, çekici ve mükemmel hâle getirilebilir.  

1.4.1. Fotoğraf Üzerindeki Lekeleri Temizleme
Dışarıda ve stüdyoda çekilen fotoğrafların üzerinde, objektiften veya çevreden kaynaklı 
görüntü lekeleri oluşabilir. Bu lekeler, fotoğraflar son kullanıma sunulmadan önce görün-
tü üzerinden temizlenmelidir. Fotoğrafların orijinal hâli, bilgisayara veya taşınabilir bel-
leğe yedeklenmeli ve bir kopyası alınarak değişiklikler, bu kopya üzerinde yapılmalıdır. 
Patch Tool (Petç Tuul) veya Clone Stamp Tool (Kılon Sitemp Tuul) ile aynı renklerde 
düzgün görünen yerlerden kopyalama yaparak temizleme yapılabilir (Görsel 1.57). 

Görsel 1.57: Fotoğraf üzerindeki lekeleri temizleme uygulaması
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Çalışılacak alan, Zoom Tool (Zum Tuul) ile yakınlaştırılarak, büyütülüp küçültülebilir. 
Patch Tool ile düzeltilmek istenilen alan seçilerek aynı renkte düzgün görünen alan üze-
rine kopyalanır. 

Clone Stamp Tool ile yapılan temizleme işleminde öncelikle Clone Stamp Tool seçilmeli 
ve klavyeden alt tuşuna basılarak temiz alandan kopya alınmalıdır. Kopyalanan alan, 
düzeltilmek istenen alana mouse ile tıklanarak kopyalanır. 

Clone Stamp Tool, aynı zamanda nesneleri çoğaltmak veya başka fotoğraflardan nesne-
leri kopyalamak için de kullanılır. Bunun için ekranın üst kısmında (seçenekler çubuğun-
da) yer alan seçeneklerden fırça boyutu değiştirilerek kopyalanacak alan genişletilebilir 
veya daraltılabilir (Görsel 1.58).

Görsel 1.58: Fotoğraf üzerindeki lekeleri temizleme uygulaması
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Görüntüler üzerindeki leke ve hataları gidermek için kulla-
nılan bir diğer yöntem ise Spot Healing Brush Tool (Sıpot 
Hiıling Bıraş Tuul) aracını kullanmaktır. Bu araç ile yapılan 
düzeltmeler, özellikle küçük hataların giderilmesi için tercih 
edilir. Spot Healing Brush Tool aracı farklı renk alanları olan 
yerlerde yakınındaki renk tonlarını alarak görüntünün deva-
mını sağlar (Görsel 1.59).

Görsel 1.59: Fotoğraf temizleme uygulaması
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6. UYGULAMA

UYGULAMA ADI	:	Fotoğrafta Rötuş Yapma 
AMAÇ	 :	Fotoğrafın üzerinde rötuş yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak daha önce çekilmiş bir 
fotoğrafın leke ve renk hatalarını rötuş yaparak düzeltiniz. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapacağınız bir 

fotoğraf belirleyiniz. 
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğraf üzerindeki renk hatalarını ve lekeleri rötuş araçlarını kullanarak 

düzeltiniz. 
5.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
6.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşınabilir 

belleğinize kaydediniz.
7.	 Taşınabilir belleğinizi bilgisayardan çıkarınız. 
8.	 Görüntü düzenleme programınızı kapatınız. 
9.	 Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 1’de verilen “6. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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1.5. DEKUPE ETME
Dekupe, ürün fonlarının transparan yapılarak yeniden farklı bir fona yerleştirilmesi veya 
internet sitelerinde kullanıma uygun hâle getirilebilmesi için çekim sonrası fonun temiz-
lenmesidir. Dekupe fotoğraf, özellikle son dönemlerde yaygınlaşan internet üzerinden 
yapılan satışlarda kullanılacak fotoğraflar veya tanıtım için kullanılacak tasarımlarda ürü-
nün gösterilmesi için çekilir. Arka planın üründen kolaylıkla ayrılabilmesi için zıt renklerle 
yapılan fotoğraf çekimleridir. Dekupe fotoğraf çekimleri genellikle beyaz fon önünde yapı-
lır. Ürünler, çekim masasında veya fon önünde çekilebilir. Dekupeye uygun olmayan çe-
kimlerde de ürün fondan ayrılabilir. Bu işlem oldukça uzun sürebilir hatta bazen istenilen 
sonuca da ulaşılamayabilir.

1.5.1. Dekupe Yöntemleri
Dekupeye uygun çekilmiş bir fotoğraf seçilmelidir. Dekupe işlemi, Tools Bar’dan bazıları 
kullanılarak yapılabilir. Pen Tool (Pen Tuul), Lasso Tool (Laso Tuul), Magnetic Lasso 
Tool (Megnedik Laso Tuul), Magic Wand Tool (Mecik Vand Tuul), Quick Selection Tool 
(Kuik Selekşın Tuul) dekupe işleminde kullanılabilecek araçlardır.  Bu araçlar, yapılacak 
işleme göre özellikleri değiştirilerek kullanılabilir.

Pen Tool dekupe yapılacak fotoğrafı manuel seçimlerle çizerek seçim 
yapmak için kullanılır. Diğer yöntemlere göre daha yavaş seçim yapıla-
bilse de en sağlıklı seçim Pen Tool ile yapılabilmektedir. 

Polygon Lasso Tool düz çizgilerle seçim yapmak için kullanılır. Daha 
düz hatları olan ürünlerin dekupesinde de kullanılabilir. Yuvarlak veya 
daha girintili fotoğraflarda istenilen sonucu vermeyecektir. 

Magnatic Lasso Tool başlangıç noktasındaki yakın renklerin seçilme-
sine olanak sağlar. Birbirine yakın renklerdeki bir fotoğrafa dekupe ya-
pılacaksa daha hızlı seçim yapabilmek için kullanılabilir. Yakın renkleri 
seçebilmek için seçimi yapılacak alan boyunca fare hareket ettirilmeli 
ve ilk seçim noktası ile son seçim noktası birleştirilerek seçim tamam-
lanmalıdır. 

Magic Wand Tool en çok kullanılan seçim araçlarından biridir. Seçimin 
yapıldığı alandaki birbirine yakın pikselleri tek tıklamayla seçilebilmeye 
olanak sağlar. Keskin zıt renkleri olan fotoğraflarda doğru sonuç ve-
rebilir. İstenilmeyen alanlar seçildiğinde geri alınarak seçime devam 
edilebilir. 

Quick Selection Tool mouse hareketiyle seçimin yapıldığı seçim ara-
cıdır. Magic Wand Tool aracına benzer yapıda olmasının yanında bu 
seçim aracıyla daha doğru ve hızlı seçim yapılabilir. Daha ince seçim 
yapılmak isteniyorsa fotoğrafa yakınlaşarak küçük seçimlerle ilerlene-
bilir.
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Dekupe için düz fon önünde çekilmiş fotoğraflar prog-
ramda açılır. Seçim mouse ile işaretlenerek yapılır. Se-
çim aracının boyutu seçenekler çubuğundan ayarlan-
malıdır (Görsel 1.60). Seçim araçlarından uygun olanla 
dekupenin yapılacağı alan seçilir (Görsel 1.61). Renk 
geçişlerinin anlaşılmadığı alanlara yaklaşılarak ve se-
çim aracının boyutu küçültülerek seçim yapılır .

Görsel 1.61: Dekupe etme

Görsel 1.60: Quick Selection Tool
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Diğer yöntem ise seçim alanı tamamlandıktan sonra fonun silinmesidir. Bu işlem için 
seçim alanı tamamlandıktan sonra üst araç panelindeki Select (Silekt) menüsünden 
Inverse (İnvörs) seçeneği seçilmelidir. Bu işlemle seçim alanının dışı seçilebilir. Bu sa-
yede seçim alanının dışında kalan diğer taraflar silinebilir. Background Eraser Tool (Bek-
gıraund İreyzır Tuul) aracıyla silme işlemi yapılmalıdır. Arka planın transparan yapılma 
işlemi tamamlandıktan sonra kullanım alanına uygun kaydedilmelidir. Transparan olarak 
kaydedilmek isteniyorsa PNG formatı, daha sonra başka fona yerleştirilecekse PSD for-
matıyla kaydedilebilir (Görsel 1.63).  

Görsel 1.63: Transparan arka plana dekupeyi yerleştirme

Arka planın transparan yapılabilmesi için iki yöntem kullanılabilir. İlk yöntem yeni çalışma alanı 
açılırken Background Contents (Bekgıraund Kontınts) komutundan transparan seçilmesidir 
(Görsel 1.62). 
  

Görsel 1.62: Transparan arka plan açma
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7. UYGULAMA

UYGULAMA ADI	 :	Dekupe Etme 
AMAÇ	 :	Fotoğrafın dekupesini yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak bir fotoğrafı arka plandan 
ayırıp otoğrafın dekupesini yapınız.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapacağınız bir 

fotoğraf belirleyiniz. 
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğraf üzerindeki dekupe yapılacak alanı, seçim araçlarından birini kullanarak 

seçiniz. Fotoğrafı dekupeye uygun transparan zemine yerleştiriniz. 
5.	 Uygulama yaptığınız fotoğrafı kontrol ediniz. Dekupenin eksiksiz ve tam 

yapıldığından emin olana kadar işleminizi tekrarlayınız. 
6.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
7.	 Bilgisayarda düzenleme işlemlerinizi bitirdikten sonra çalışmanızı taşınabi-

lir belleğinize kaydediniz.
8.	 Taşınabilir belleğinizi bilgisayardan çıkarınız. 
9.	 Görüntü düzenleme programınızı kapatınız. 
10.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 1’de verilen “7. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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1.6. KAYDETME 
Görüntülerin her biri, yapılan işlemler sonrasında 
görüntü düzenleme programlarında kaydedilme-
lidir. Görüntü kaydedilmeden önce kullanım alanı 
belirlenmeli ve kullanım alanına uygun kayıt formatı 
seçilmelidir. Birçok dosya biçimi, görüntülerin bo-
yutunu küçültmek için sıkıştırma yöntemini kullanır. 
Sıkıştırma yapmak,  renk ve görüntü ayrıntılarında 
kayıplara neden olur. Sıkıştırarak kaydeden kayıt 
formatlarına kayıplı formatlar, sıkıştırmadan dos-
yayı ham hâliyle kaydeden formatlara ise kayıpsız 
formatlar denir. Kayıpsız formatlar, renk bilgileri ve 
görüntü ayrıntılarını daha geniş renk bilgisiyle kay-
deder. Bu nedenle görüntülerin ham hâllerinin de 
saklanması daha sonra kullanım için farklı kayıt for-
matlarının seçimi için doğru tercih olacaktır. 

1.6.1. Görüntü Kayıt Formatları
Görüntü düzenleme programlarında çalışmalar 
farklı kayıt formatlarında kaydedilir. 

JPEG
JPEG [Joint Photographic Expert Group (Coint Fo-
tografik Ekspır Gurup)] formatı; dijital fotoğrafları 
paylaşmak ve görüntülemek için en çok tercih edilen 
kayıt türüdür. Fotoğraf makineleri ve telefonlar fotoğ-
rafları çekerken JPEG formatında kaydeder. Sadece 
bazı DSLR fotoğraf makineleri JPEG veya RAW for-
matında görüntü kaydeder. JPEG formatı 24 bit rengi 
destekler. JPEG görüntüleri sıkıştırdığı için kayıplı bir 
kayıt formatıdır. JPEG formatında küçültme ne ka-
dar çok yapılırsa ve yan sıkıştırma tekniği ne kadar 
çok uygulanırsa görüntülerde de o kadar bozulma 
görülür. Bir fotoğraf JPEG formatında kaydedilecek-
se görüntü düzenleme programlarında tüm işlemler 
uygulandıktan sonra kaydedilmelidir. Genellikle web 
sayfaları ve sosyal medya platformları JPEG forma-
tı kullanır. Kullanım alanı küçük çözünürlüklü JPEG 
dosyası kabul ediyorsa yedek bir dosyayla önce bü-
yük dosya kaydedilmeli, daha sonra küçültme işlemi 
uygulanmalı ve farklı bir isimle kaydedilerek gerekli 
yere iletilmelidir. Küçük JPEG kaydedildikten son-
ra programda açılarak büyütülmeye çalışıldığında 
görüntüde ciddi kayıplar yaşanacaktır. Arşivlemek 
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ve yeniden çalışmaya devam etmek için uygun bir 
format değildir. Her kayıtta kalitede bozulmalar gö-
rülebilir. Yapılan işlemler geri alınamaz. Bu nedenle 
orijinal görüntü kayıpsız dosya formatlarıyla kaydedi-
lerek saklanmalıdır. 

PSD
PSD (Piesdi), bir görüntü düzenleme programının 
formatıdır. Henüz bitirilmemiş bir çalışmayı tüm 
katmanlarıyla kaydetme ve sonrasında çalışmaya 
devam etme olanağı sağlar. Görüntü düzenleme 
programında hangi dosya formatıyla çalışmaya baş-
lanırsa başlansın program öncelikle o çalışma dos-
yasını PSD formatına çevirir. Bu sayede program 
kendi formatı üzerinde tüm araçlar ve özellikleriyle 
çalışılmasına izin verir. Çalışma tamamlandığında 
veya çalışmaya daha sonra devam edilmesi gerek-
tiğinde PSD formatıyla kaydedilerek çalışmalarda 
geriye dönmek kolay hâle gelir. Görüntü hazır hâle 
getirilmiş olsa bile daha sonra değişiklik yapılmak 
istenebileceği için PSD formatıyla yedeğinin kayde-
dilmesi oluşabilecek aksiliklerin önüne geçecektir. 
PSD kayıpsız bir kayıt yöntemidir. Görüntü üzerin-
de ne kadar fazla işlem yapılırsa dosya boyutu da 
o oranda büyüyecektir. Bunun için haricî bir belleğe 
kaydetmek, bilgisayarın çalışma hızını yavaşlatma-
dan dosyaya ulaşımı kolaylaştıracaktır. 

RAW
İngilizce bir sözcük olan RAW (Rav) işlenmemiş, 
ham anlamına gelmektedir. Fotoğrafçılık alanında 
kullanılan bu sözcük, makine tarafından fotoğrafa 
hiçbir müdahalede bulunulmadığını anlatır. Fotoğraf 
daha sonra işlenecekse RAW formatında çekilmeli 
ve bu formata uygun programlarda işlenmelidir. 

GIF
GIF (Gif), grafik değişim formatıdır. Web grafikleri 
için GIF dosyalarının JPEG formatından daha dü-
şük renk aralığı vardır. Web tasarımlarında sayfa-
ların birçok ayrıntısı GIF olarak hazırlanır. Küçük 
dosya boyutu internet sayfalarının hızını düşürmez 
ve web tarayıcıları GIF dosyalarını destekler. GIF 
formatı sayfalara hızlı yüklenir. 
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PNG
PNG (Pienci), taşınabilir ağ grafikleri kayıpsız dosya biçi-
midir. 48 bit rengi destekler. Transparan arka fonlu görün-
tüler için en iyi dosya biçimidir. PNG dosyaları multimedya 
programlarının yanı sıra sunu hazırlama yazılımlarında 
da kullanılır. PNG, CMYK renklerini desteklemez. PNG 
formatı kullanım alanlarına göre JPEG formatı kadar des-
teklenmediği için paylaşımı ve görüntülenmesi kısıtlıdır. 
Tasarımcılar, web tasarımları yaparken PNG formatını 
transparan ve boyutunun küçük olması sebebiyle tercih 
ederler.
 
TIFF
TIFF (Tif), etiketli dosya biçimidir. Görüntü düzenleme 
programlarının tüm özelliklerini destekleyen birkaç dosya 
türünden biridir. Kayıpsız sıkıştırma yöntemini kullanır. Ti-
cari baskılar için kullanılan evrensel olarak kabul edilmiş 
standart dosya türüdür. Görüntülerin arşivlenmesi için kul-
lanılabilir. Dosya boyutu oldukça büyüktür. Arşivleme TIFF 
formatında yapılacaksa haricî depolama alanları kullanıl-
malıdır. Çok sayfalı düzenleme programlarının neredeyse 
tümüyle uyumlu bir dosya türüdür. 
 
EPS
EPS (Epese); kapsüllenmiş komut dosyası, bir başka de-
yişle endüstriyel baskı biçimidir. EPS dosyaları görüntü 
dosyaları değildir. Aslında bir yazıcının görüntüyü nasıl 
oluşturması gerektiğine dair talimatları içerir. Kapsüllenmiş 
kısım, görüntü düzenleme programında açılmadığı sürece 
dosyaların değiştirilemeyeceği anlamına gelir. Sayfa dü-
zeni programlarında çalışılırken kapsüllenmiş kısımların 
görünmesi isteniyorsa ön izleme düğmesi eklenebilir. Aksi 
takdirde sayfa düzeni yazdırılana kadar görülmez. EPS 
hem vektör hem de bitmap grafikleri içerebilir. Vektörel ve 
masaüstü yayıncılık programlarının hemen hemen hepsi 
tarafından desteklenen bir dosya türüdür. 

PDF
PDF (Pidief); birçok alanda kullanılan taşınabilir belge for-
matıdır. Elektronik belgeleri paylaşmak, görüntülemek ve 
yazdırmak için kullanılır. Kalite ayarıyla  tamamlanmış 
JPEG ve ZIP sıkıştırma seçeneklerini sunar. Birçok bilgi-
sayarda yer alan PDF görüntüleyiciler sayesinde herkes 
tarafından görülebilir. Görüntü arşivleme için kullanılmaz. 
Genellikle taşıma ve paylaşım için kullanılır. 
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8. UYGULAMA

UYGULAMA ADI	:	Fotoğrafı Farklı Formatlarda Kaydetme
AMAÇ	 :	Fotoğrafı görüntü kayıt formatlarına uygun 
		  kaydetmek. 
                                         
Aşağıdaki işlem basamaklarını dikkate alarak daha önce çekilmiş bir fo-
toğrafın ufuk çizgisi, renk, ışık, rötuş ayarlamalarını yaparak fotoğrafı 
kullanım alanına uygun kaydediniz.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek 
4.	 Fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital ortamdan ya da taşınabilir belleğinizden düzenleme yapacağınız bir 

fotoğraf belirleyiniz.
3.	 Düzenleme için fotoğrafı bilgisayara aktarınız.
4.	 Fotoğraf üzerinde ufuk çizgisi, ışık, renk, rötuş işlemlerini yaparak fotoğrafı 

kırpınız. 
5.	 Fotoğrafta gerekli düzenlemeleri yapınız.
6.	 Fotoğrafları PSD, JPEG, PNG ve PDF formatlarında ayrı ayrı kaydediniz.
7.	 Farklı formatlarda kaydettiğiniz dosyalarınızın büyüklükleri arasındaki farkları 

not ediniz.
8.	 Farklı formatta kaydettiğiniz fotoğrafları taşınabilir belleğinize de aktarınız.
9.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
10.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
11.	Görüntü düzenleme programınızı kapatınız. 
12.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 1’de verilen “8. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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ÖLÇME VE DEĞERLENDİRME

A) Aşağıdaki cümlelerde parantez ile (...) boş bırakılan alanlara verilen       
     bilgiler doğru ise “D” yanlış ise “Y” yazınız. 

1.	 (...) Pen, detaylı seçim için kullanılan araçtır.
2.	 (...) Polygonal Lasso Tool fotoğraflarda keskin köşeli seçim aracıdır.
3.	 (...) Görüntü düzenleme programları, vektörel çizim yapmak için kullanılır. 
4.	 (...) Hue / Saturation seçeneği ile fotoğraflarda renk değişikliği yapılır. 
5.	 (...) Move Tool bir nesneyi kopyalamak için kullanılan araçtır.

 
B) Aşağıdaki cümlelerde yer alan boşlukları uygun ifadelerle 
	 doldurunuz.

6.	Görüntü düzenleme programının ................... panelinde geçmişte yapılan 
işlemler  görülür.

7.	Önceden kaydedilmiş tüm ayarların fotoğrafa uygulanması ................... 
seçeneğiyle olur.

8.	Görüntü düzenleme programında üst üste çalışılan alanlara ................... 
denir.

9.	Fotoğrafta istenmeyen alanları kırpmak için .................. seçeneği 
kullanılır.

C) Aşağıdaki soruları okuyarak doğru seçeneği işaretleyiniz.
 

10. Aşağıdakilerden hangisi web tasarımında tercih edilen görüntü         
      kayıt formatıdır? 

A) EPS               B)  PNG            C) PSD             D) RAW               E) TIFF

11. Aşağıdakilerden hangisi görüntü düzenleme programının kullanım    
      alanlarından biri değildir?

A) Afiş tasarlama 
B) 3D tasarım yapma 
C) Fotoğraf düzenleme 
D) Baskı için görüntü hazırlama 
E) Web sitesi arayüzü tasarlama
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ÖLÇME VE DEĞERLENDİRME

12. Aşağıdakilerden hangisi Lasso Tool’un görevidir?

A) Bir yeri silme  
B) Serbest seçim yapma  
C) Kırmızı gözü yok etme 
D) Bir parçayı taşıma             
E) Benzer renkleri seçme 

13. Aşağıdakilerden hangisi görüntü düzenleme programında aynı   .
	 renk ve renk tonlarını daha hızlı seçebilmeyi sağlayan seçim .
	 aracıdır?

A) Magic Wand Tool 
B) Clone Samp Tool 
C) Pen Tool 
D) Lasso Tool
E) Polygonal Lasso Tool 

14. Aşağıdakilerden hangisi fotoğrafın bir alanından alt tuşuna .
	 basılarak doku örneği almaya sağlayan araçtır?

	 A) Lasso Tool
	 B) Clone Stamp Tool
	 C) Pen Tool
	 D) Rectangular Marquee Tool
	 E) Red Eye Tool

Ç) Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.  

15.	Fotoğrafa hangi koşullarda haricî ışık eklenmesi gerektiğini 
	 örneklendirerek açıklayınız. 

	 ………………………………………………………………………………….
	 ………………………………………………………………………………….
	 ………………………………………………………………………………….
	 ………………………………………………………………………………….
	 ………………………………………………………………………………….

16.	Dekupe işleminin kullanım alanlarını örneklendirerek açıklayınız.
	 ………………………………………………………………………………….
	 ………………………………………………………………………………….
	 ………………………………………………………………………………….
	 ………………………………………………………………………………….
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1. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 
hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğraf belirledi. 

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Fotoğraf baskısı için kullanılan ölçütleri ve çözünürlükleri 
inceledi.

5.
Düzenlediği fotoğrafı, baskı ölçülerini ve çözünürlüklerini 
dikkate alarak değiştirdi.

6. Gerekli düzenlemelerle fotoğrafı kırptı.

7. Fotoğrafı baskı boyutlarına uygun hâle getirdi.

8. Çalışmasını taşınabilir belleğe kaydetti.

9. Taşınabilir belleği koşullara uygun çıkardı.

10. Programı zarar görmeyecek şekilde kapattı.

11. Bilgisayarı zarar görmeyecek şekilde kapattı.

12. Süreyi planlı ve verimli kullandı.

13. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 13 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 65’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (65x100)/65=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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2. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini hazır-
ladı.

2. Düzenleme yapılacak konuya uygun fotoğraf belirledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4. Fotoğrafı ufuk çizgisini dikkate alarak düzenledi.

5. Gerekli düzenlemelerle fotoğrafı kırptı.

6. Çalışmasını taşınabilir belleğe kaydetti.

7. Taşınabilir belleği koşullara uygun çıkardı.

8. Programı zarar görmeyecek şekilde kapattı.

9. Bilgisayarı zarar görmeyecek şekilde kapattı.

10. Süreyi planlı ve verimli kullandı.

11. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 11 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 55’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (55x100)/55=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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3. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğraf belirledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Fotoğrafı renk tekniklerini kullanarak estetik ve güzel 
görünecek şekilde değiştirdi.

5. Fotoğrafların öncesini ve sonrasını karşılaştırdı.

6. Çalışmasını taşınabilir belleğe kaydetti.

7. Taşınabilir belleği koşullara uygun çıkardı.

8. Programı zarar görmeyecek şekilde kapattı.

9. Bilgisayarı zarar görmeyecek şekilde kapattı.

10. Süreyi planlı ve verimli kullandı.

11. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 11 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 55’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (55x100)/55=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiri-
niz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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4. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğraf belirledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğrafın ışık ayar-
larını yaptı.

5. Fotoğrafların öncesini ve sonrasını karşılaştırdı.

6. Çalışmasını taşınabilir belleğe kaydetti.

7. Taşınabilir belleği koşullara uygun çıkardı.

8. Programı zarar görmeyecek şekilde kapattı.

9. Bilgisayarı zarar görmeyecek şekilde kapattı.

10. Süreyi planlı ve verimli kullandı.

11. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 11 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 55’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (55x100)/55=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiri-
niz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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5. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 
gerecini hazırladı.

2.
Düzenleme yapılacak konuya uygun fotoğraf belir-
ledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğrafın ışık ayar-
larını yaptı.

5.
Düzenlediği fotoğrafa ışığın geliş yönüne uygun 
haricî ışık eklemesi yaptı.

6.
Fotoğrafların öncesini ve sonrasını karşılaştırarak 
onları değerlendirdi.

7. Çalışmasını taşınabilir belleğe kaydetti.

8. Taşınabilir belleği koşullara uygun çıkardı.

9. Programı zarar görmeyecek şekilde kapattı.

10. Bilgisayarı zarar görmeyecek şekilde kapattı.

11. Süreyi planlı ve verimli kullandı.

12. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 
3” İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 12 ölçüt bulunmaktadır. 
Ölçekten alınabilecek en yüksek puan 60’dır. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (60x100)/60=100
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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6. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 
gerecini hazırladı.

2.
Düzenleme yapılacak konuya uygun fotoğraf belir-
ledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğrafta renk hata-
larını ve lekelerini rötuşladı.

5. Fotoğrafların öncesini ve sonrasını karşılaştırdı.

6. Çalışmasını taşınabilir belleğe kaydetti.

7. Taşınabilir belleği koşullara uygun çıkardı.

8. Programı zarar görmeyecek şekilde kapattı.

9. Bilgisayarı zarar görmeyecek şekilde kapattı.

10. Süreyi planlı ve verimli kullandı.

11. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 
3” İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 11 ölçüt bulunmaktadır. 
Ölçekten alınabilecek en yüksek puan 55’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 
100’lük sisteme uyarlanır. Örnek: (55x100)/55=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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7. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı.

2.
Düzenleme yapılacak konuya uygun fotoğraf belir-
ledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Fotoğraf üzerindeki dekupe yapılacak alanı, seçim 
araçlarını kullanarak zeminden ayırdı. 

5. Fotoğrafı transparan yeni zemine yerleştirdi.

6. Fotoğrafların öncesini ve sonrasını karşılaştırdı.

7. Çalışmasını taşınabilir belleğe kaydetti.

8. Taşınabilir belleği koşullara uygun çıkardı.

9. Programı zarar görmeyecek şekilde kapattı.

10. Bilgisayarı zarar görmeyecek şekilde kapattı.

11. Süreyi planlı ve verimli kullandı.

12. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 12 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 60’tır. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (60x100)/60=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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8. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 
hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğraf belirledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğrafın ufuk çizgisi 
düzeltme işlemini yaptı.  

5.
Estetik kuralları dikkate alarak fotoğrafın ışık 
düzeltme işlemini yaptı.

6.
Estetik kuralları dikkate alarak fotoğrafın renk düzeltme 
işlemini yaptı.  

7.
Estetik kuralları dikkate alarak fotoğrafın rötuş işlemini 
yaptı.  

8. Gerekli düzenlemelerle fotoğrafı kırptı.

9. Fotoğrafların öncesini ve sonrasını karşılaştırdı.

10.
Gerekli düzenlemeleri yaparak fotoğrafı PSD, JPEG, 
PNG ve PDF formatlarında ayrı ayrı kaydetti.

11. Çalışmasını taşınabilir belleğe kaydetti.

12. Taşınabilir belleği koşullara uygun çıkardı.

13. Programı zarar görmeyecek şekilde kapattı.

14. Bilgisayarı zarar görmeyecek şekilde kapattı.

15. Süreyi planlı ve verimli kullandı.

16. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 
4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 16 ölçüt bulunmaktadır. Ölçekten alına-
bilecek en yüksek puan 80’dir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (80x100)/80=100
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz ye-
terli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-1
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BİLGİSAYARDA 
FOTOĞRAF / GÖRÜNTÜ 

İŞLEME 

2. 
ÖĞRENME

BİRİMİ

2.1. KOLAJ VE MONTAJ
2.2. RESTORASYON VE DÜZELTME
2.3. MANÜPİLASYON

KONULAR

•	 Kolaj
•	 Montaj
•	 Düzeltme
•	 Rötuş
•	 Restorasyon
•	 Manipülasyon

TEMEL KAVRAMLAR

NELER ÖĞRENECEKSİNİZ?

•	 Uygun araçları seçerek fotoğraflarla kolaj yapma
•	 Uygun araçları seçerek fotoğraflarla montaj yapma
•	 Fotoğraflar üzerinde gerekli düzeltmeleri yapma
•	 Eski ve yıpranmış fotoğraflara restorasyon uygulama
•	 Fotoğrafın kullanım amacına uygun manipülasyon yapma

HAZIRLIK ÇALIŞMALARI

1.	 Kolaj denildiğinde aklınıza gelen nedir? Örneklendirerek açıklayınız.
2.	 Manipüle kelimesinin size çağrıştırdıklarını sınıfta paylaşınız. Manipüle  .
	 etme ve fotoğraf sanatı arasında nasıl bir ilişki olabilir? Örneklerle 
	 açıklayınız.



BİLGİSAYARDA FOTOĞRAF / GÖRÜNTÜ İŞLEME

86 Bilgisayarda Fotoğraf

Fotoğraflar, kullanıma sunulmadan önce birçok işlemden 
geçirilebilir. Fotoğraf veya görüntünün kullanım alanı, fo-
toğrafa ne tür işlemler uygulanacağını ve uygulama bi-
tince nasıl bir sonuca ulaşılacağını belirler. Bazı görüntü 
düzenleme programları, kısıtlı kullanım alanı için üretilmiş-
tir. İşlevi daha fazla olan programlar ise çok yönlüdür ve 
birçok kullanıcıya hitap etmektedir. Akıllı telefonlarda kul-
lanılan uygulamalar için geliştirilmiş birçok işlem, görüntü 
düzenleme programlarında daha detaylı yapılabilmektedir. 
Görüntü düzenleme programlarında elde edilen sonuç-
lar, görüntünün kullanım alanını etkilemekte ve kullanıcı-
nın deneyimi ile bilgisine göre farklılık gösterebilmektedir 
(Görsel 2.1). 

Görsel 2.1: Fotoğraf stüdyosunda görüntü işleme çalışması

2.1. KOLAJ VE MONTAJ
Birden çok görüntü ile tek bir görüntü oluşturarak kolaj 
veya montaj yapılabilir. Kolaj özellikle birden fazla görün-
tünün bir arada gösterilmek istendiği albüm, afiş, broşür, 
takvim gibi çalışmalarda kullanılmaktadır. Montaj ise en az 
iki fotoğraftan tek bir görüntü oluşturmak için kullanılan bir-
leştirme yöntemidir. 

Kolaj ve montaj, yaratıcı ve sanatsal çalışmalarda ger-
çeküstü görüntüler elde etmek ya da manipülasyon yap-
mak amacıyla kullanılmaktadır. Bu tür çalışmalarda kolaj 
veya montaj ile kırpma, kaynaştırma, doku taşıma gibi 
çeşitli görüntü işleme yöntemleri kullanılır. Bunun yanında 
efekt gibi bazı düzenlemelerden faydalanılır (Görsel 2.2).

Görsel 2.2: Fotoğrafta çeşitli 
görüntü işleme yöntemlerinin bir 

arada kullanımı

Görüntü işleme 
yazılımları, fotoğraf ve 
görüntülerin mutfağıdır.

BİLGİ 
KUTUSU
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2.1.1. Kolaj
Birden fazla fotoğrafın tek bir görüntü hâline getirilmesine kolaj denir. Kes-yapıştır şek-
linde uygulanır. Afiş, broşür gibi çalışmalarda birden fazla fotoğraf düzenlenerek kolaj 
çalışmasıyla bir araya getirilir. Dijital ortamda hazır kolaj teknikleri sunan uygulamalar 
olduğu gibi, yerleşim alanlarına kişinin kendisinin karar verdiği uygulamalar da mevcuttur 
(Görsel 2.3).

Görsel 2.3: Seyahat fotoğraflarından oluşan kolaj çalışması
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Kolaj tekniğinin uygulanabilmesi için öncelikle aynı konuya 
ait birden fazla fotoğrafa ihtiyaç vardır. Bir şehrin farklı alan 
ve mekânlarında çekilmiş fotoğraflar ile farklı ülkelere yapı-
lan turistik gezilerde çekilmiş fotoğraflar, kolaj çalışmasında 
tanıtım amaçlı kullanılmak üzere birleştirilebilir (Görsel 2.4). 
Önemli olan aynı amaca hizmet eden fotoğrafların bir araya 
getirilmesidir. İçerik olarak birbirleriyle ilişkili olmayan fotoğ-
raflar kolaj tekniğinde kullanılamaz.

Görsel 2.4: Turistik amaçlı çekilmiş fotoğraflarla kolaj çalışması

Başarılı bir kolaj çalışması yapabilmek için görüntü düzenle-
me programlarını kullanma becerisi, kompozisyon bilgisi ve 
yaratıcılık gereklidir. Bu nedenle grafik ve fotoğraf sektörün-
de çalışanların bu alanlarda kendilerini geliştirmiş olmaları 
önemlidir (Görsel 2.5).

Görsel 2.5: Seyahat kolajı
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Görsel 2.6: Kedi kolajı

Kolaj çalışmasında kullanılacak görüntüler tek bir dosyada toplanmalıdır. Fotoğraflar 
kendi boyutlarında kullanılacaksa görüntü düzenleme programında yeni bir belge açı-
larak istenilen biçimde belgeye yerleştirilebilir. Bu teknik oldukça dağınık bir görüntü 
oluşturacağından, fotoğrafların başka bir sayfada belirli kısımlarının kırpılarak çalışılan 
belgeye aktarılması daha başarılı bir sonuç verecektir (Görsel 2.6, 2.7 ve 2.8). 

Görsel 2.8: Meyvelerle farklı kompozisyonlarda kolaj çalışması

Görsel 2.7: Meyvelerle ilgili kolaj çalışması
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Kolaj çalışmalarında uygulanan bir diğer yöntem ise programların son sürümlerine ek-
lenmiş hazır kolaj seçeneklerini kullanmaktır. Hazır şablon kullanılacaksa yeni bir belge 
açılmalı, kullanılacak şablon yeni belgeye taşınarak belge üzerinde çalışılmalıdır. Böyle-
likle diğer şablonlarla çalışma alanı birbirine karışmayacaktır. Hazır şablonlar, genellikle 
zamanın kısıtlı olduğu durumlarda pratik bir çözüm yolu olarak düşünülmeli ve çalışma 
esnasında mümkün olduğunca özgün olunmalıdır (Görsel 2.9, 2.10).

Tasarımda özgün çalışmak önemli bir kriterdir. Bu nedenle en doğru tercih kişisel yer-
leşim yapmaktır. Bunun için öncelikle yeni bir çalışma alanı açılmalıdır. Çalışmanın ya-
yımlanacağı ortama ya da basılacağı materyale göre boyut ayarlanmalı ve yeni belge 
oluşturulmalıdır. 

Görsel 2.9: Hazır şablonlar

Görsel 2.10: Hazır şablonlar
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Çalışma alanı eşit parçalara bölünerek düzenli bir alan oluşturulabilir. Bunun için View > 
New Guide Layout (Viuv > Niv Gayd Leyaut) komutu seçilir (Görsel 2.11). 

Çalışma birkaç parçaya bölünmek istendiğinde açılan sekmeden Colums (Kalıms) ko-
mutuyla dikey, Rows (Roovs) komutu ile yatay olarak bölünebilir (Görsel 2.12). Bölünen 
alanlar arasında boşluk bırakılmak istendiğinde Gutter (Gadır) komutuyla boşluğun bo-
yutu ayarlanmalı, boşluk bırakılmak istenmiyorsa bu alana sıfır (0) girilmelidir.

Görsel 2.11: Seçim alanı

Görsel 2.12: Çalışma alanını bölme
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Bir sonraki adımda kullanılacak şekil, sol tarafta bulunan Tool me-
nüsünden Tool ile seçilir. Seçilen Tool ile işaretlenmiş alanlara kare, 
dikdörtgen, daire gibi şekiller uygulanır. Çalışma alanı eşit alanlara 
ayrılmışsa şekil seçilerek Ctrl+J / Command+J kısayol komutuyla 
kopyalanarak çoğaltılabilir. Her kopya için ayrı bir layer oluşur. Ço-
ğaltılmış şekiller, diğer alanlara yerleştirilerek kolaj alanı oluşturula-
bilir. Eşit alanlar oluşturulabileceği gibi farklı boyutlarda alanlar da 
oluşturmak mümkündür. Kare dışında yuvarlak, üçgen, beşgen gibi 
şekiller de kullanılabilir (Görsel 2.13). 

Görsel 2.13: Çalışma alanı yerleşim
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Oluşturulan alanlara File > Place > Embedded (Fayl > Pi-
leys > Embeded) komutu ile fotoğrafların bulunduğu dos-
yadan seçilen fotoğraflar çağrılır. Fotoğrafın yerleştirileceği 
alanın bulunduğu Layer, mouse ile tıklanarak seçilmelidir. 
Layer, sürükle bırak yöntemiyle üste ya da alta alınarak yer 
değiştirebilir. Yerleştirilen fotoğraflar, Layer üzerinde Control 
(Ctrl) ve mouse ile sağ tık yapılarak açılan menüde Create 
Clipping Mask (Kreyt Kıliping Mask)komutuyla alana yerleş-
tirilir. Clipping Mask sayesinde fotoğraf oynatılsa da bu ala-
nın dışına taşmayacaktır (Görsel 2.14, 2.15, 2.16 ve 2.17).  

Görsel 2.14: Fotoğrafı çalışma alanına 
çağırma

Görsel 2.15: Fotoğrafı maskeleyerek 
seçili alana yerleştirme

Görsel 2.16: Fotoğraf yerleşim alanları Görsel 2.17: Fotoğrafların  seçili alanlara 
yerleştirilmesi
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Görsel 2.18: Düzenli kolaj yerleşimi

Görsel 2.19: Geometrik şekillerle kolaj alanı

Görsel 2.20: Geometrik şekillerle kolaj yerleşimi Görsel 2.21: Geometrik şekillerle kolaj çalışması

Görsel 2.18, 2.19, 2.20 ve 2.21 geometrik formlar kullanılarak yapılmış kolaj çalışmalarıdır.
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1. UYGULAMA

UYGULAMA ADI	 :	Fotoğraflarla Kolaj Çalışması 
AMAÇ	 :	Görüntü düzenleme programında kolaj çalışması      .
		  yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak benzer ya da aynı konulu 
fotoğraflardan kolaj çalışması yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek
4.	 Konuya uygun fotoğraflar

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Düzenleme için bilgisayar ve programınızı hazırlayınız. 
3.	 Kolaj çalışması için bir konu belirleyiniz. 
4.	 Belirlediğiniz konuya uygun basılı, dijital yayın organlarından fotoğraflar 

bulunuz veya kendi çektiğiniz fotoğrafları kullanınız. 
5.	 Fotoğrafları bilgisayara aktarınız.  
6.	 Fotoğraflar üzerinde gerekli gördüğünüz ışık, renk, perspektif gibi düzelt-

meleri yapınız.
7.	 Kolaj çalışması için gerekli kompozisyonu oluşturunuz. 
8.	 Görüntü düzenleme programında yapacağınız işlemlere uygun hazır kolaj 

şablon veya araçlarını seçiniz. Çalışmanızı kompozisyonunuza uygun olacak 
şekilde tamamlayınız.

9.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
10.	Çalışmanızı, baskıya uygun ve görüntü düzenleme programının formatın-

da bilgisayara ve taşınabilir belleğe kaydediniz.
11.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
12.	Görüntü düzenleme programınızı kapatınız. 
13.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 2’de verilen “1. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.



BİLGİSAYARDA FOTOĞRAF / GÖRÜNTÜ İŞLEME

96 Bilgisayarda Fotoğraf

2.1.2. Montaj
Fotoğrafta yapılan montaj işlemine fotomontaj denir. Fotomontaj yapımı, ilk fotoğraf bu-
lunduktan sonra karanlık odada başlayan baskı sürecinin ardından başlamıştır. Montaj, fo-
toğrafın bir bölümünün kesilerek başka bir fotoğrafa yerleştirilmesiyle yeni bir fotoğraf oluş-
turma işlemidir. Günümüzde montaj işlemi, fotoğrafların kullanılan gelişmiş dijital fotoğraf 
uygulamalarıyla dekupe edilerek başka fotoğraflara yerleştirilmesi ile yapılmaktadır (Görsel 
2.22, 2.23). Montaj, manipülasyonda uygulanan tekniklerden biridir. Bu nedenle manipü-
lasyonun içinde anılmaktadır. Manipülasyon, birçok farklı teknik kullanılarak da yapılabilir.

Görsel 2.23: Çevre konulu fotomontaj

Görsel 2.22: Seyahat konulu fotomontaj

BİLGİ 
KUTUSU

Tüm fotoğraf ve 
görüntü birleştir-

melerinde katman 
maskesi kullanıl-
malıdır. Bu yön-

tem diğer birleştir-
melere göre geri 
alınabilir ve bu 

yöntemin kontrolü 
kolaydır.
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Fotomontaj işleminde gerçeğe yakın bir görünüm elde edebilmek için dikkat edilmesi 
gereken konular şunlardır: 

•	 Fotoğraflar ışık ve çözünürlük açısından birbirine yakın olmalıdır.
•	 Bakış açısı ve perspektif uyumlu olmalıdır. Aksi takdirde fotomontaj inandırıcılıktan 

uzak olacaktır.
•	 Fotomontaj çalışmasında birleştirilen parçaların boyutları, perspektife göre ayarla-

nabilir olmalıdır. 
•	 Fotoğraflar birleştirildikten sonra mutlaka ışık ayarı yapılmalıdır. Gerçeğe yakın bir 

montaj yapabilmek için ışığın yönü ve şiddetine önem verilmelidir (Görsel 2.24, 2.25). 

Görsel 2.24: Fotomontajda 
gerçeğe yakın görünüm

Görsel 2.25: Fotomontajda boyut ile oluşturulan gerçek dışı görünüm
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Görsel 2.26: Fotomontaj için fotoğrafların programda açılması

Görsel 2.27: Fotoğrafın opaklığının düşürülerek silinmesi

Montaj yapabilmek için öncelikle görüntü düzenleme programında en az iki fotoğraf se-
çilmelidir. Çalışma yapılmak istenen boyutta yeni bir belge oluşturulur. Hangi fotoğrafın 
alanı daha fazla kullanılacaksa belge oluşturulduktan sonra ilk o fotoğraf belgeye çağrılır. 
Program içerisine ilk alınan fotoğraf alt katmanda kalacaktır. Ardından ikinci fotoğraf belge 
içerisine çağrılarak ya da sürüklenip bırakılarak çalışma alanına geçilmelidir. Layers işlem 
penceresinden Add Layers Mask komutu seçilerek yeni bir maskeleme katmanı oluşturul-
malıdır (Görsel 2.26). 

Maskeleme katmanı oluşturulduktan sonra üstteki fotoğrafta kullanılmayacak alanlar si-
linmelidir. Bu işlem için programın sol tarafındaki araçlar panelinden Eraser Tool seçil-
melidir. Eraser Tool seçildiğinde renk kutularından beyaz seçili ise silme işlemi, siyah se-
çili ise silinen alanları tekrar boyama işlemi yapılır. İşlem yapılacak alanın büyüklüğüne 
göre silginin boyutu ayarlanmalıdır. Fotoğraf üzerinde küçük alanlarda işlem yapılırken 
Zoom Tool ile alana yaklaşılarak detaylar görüntülenmeli ve işlem buna göre daha detay-
lı yapılmalıdır. Görüntülerin boyutunu ayarlamak için Ctrl+T veya Command+T kısayol 
komutunun kullanılması işlemi hızlandıracaktır (Görsel 2.27).
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Görsel 2.28: İki fotoğrafın birleştirilmesi

Görsel 2.29: İki fotoğrafın birleştirilmiş hâli

BİLGİ 
KUTUSU

Aydınlatma ve kont-
rast gibi düzenlemeler 
ayrı bir katmanda ya-
pılmalıdır. Böylelikle 

istenmeyen aydınlatma 
hatalarının sonradan 
düzeltilmesi, farklı bir 
aydınlatma veya kont-
rast seçeneğinin gör-
sele uygulanabilmesi 

kolaylaşacaktır.

Üst üste yerleştirilen fotoğraflardan alttaki fotoğrafın görün-
mesi, üstteki fotoğraftan silinecek alanları belirlemek için 
gereklidir. Üstteki fotoğrafın şeffaflığının azaltılması alttaki 
fotoğrafın görünürlüğünü artırır. Bu işlem için Layers iş-
lem penceresinde üstte bulunan fotoğrafın opaklığı (Opa-
city) düşürülmelidir. Fotoğraflar üzerinde silme işlemleri 
tamamlandıktan sonra, opaklık eski hâline döndürülmeli 
ve Layers işlem penceresinden Shift tuşuna basılı tutula-
rak tüm katmanlar seçilmelidir (Görsel 2.28). Layers işlem 
penceresinden Merge Layers komutu seçilerek fotoğraflar 
birleştirilmelidir. Birleştirme işlemi tamamlandığında tek bir 
görüntü oluşturulmuş olacaktır. 

Bu oluşturulan görüntü üzerinde gerekiyorsa ışık ve renk 
ayarları, kırpma işlemi gibi düzenlemeler yapılmalı ve fo-
toğraf kaydedilmelidir. Layer’ların birleştirilme işlemi ya-
pılmadan çalışmanın, görüntü düzenleme programı kayıt 
formatında kaydedilmesi önerilir. Bu kayıt formatı daha 
sonraki zamanlarda değişiklik yapılmak istendiğinde kulla-
nım kolaylığı sağlar (Görsel 2.29).
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2. UYGULAMA

UYGULAMA ADI	:	 Fotoğraflarla Montaj Çalışması 
AMAÇ	 :	 Görüntü düzenleme programında montaj çalışması      .
		  yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak fotoğraf düzenleme ve 
montaj çalışması yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek
4.	 Konuya uygun fotoğraflar

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Belirlediğiniz konuya uygun basılı ya da dijital yayın organlarından en az iki 

fotoğraf bulunuz veya kendi çektiğiniz fotoğrafları kullanınız. 
3.	 Düzenleme için bilgisayar ve programınızı hazırlayınız. 
4.	 Fotoğrafları bilgisayara aktarınız.
5.	 Görüntü düzenleme programıyla ufuk çizgisi düzeltme, ışık, renk, rötuş, kırp-

ma işlemleri yaparak fotoğrafları montaja hazır hâle getiriniz. 
6.	 Montaj için gerekli kompozisyonu oluşturunuz. Çalışmanız için uygun araçları 

kullanarak çalışmanızı tamamlayınız.
7.	 Belirlediğiniz fotoğrafların, çalışmanın amacına uygun düzenlendiğinden 

emin olana kadar düzenlemeyi tekrarlayınız. 
8.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
9.	 Çalışmanızı, baskıya uygun ve görüntü düzenleme programının formatın-

da bilgisayara ve taşınabilir belleğe kaydediniz.
10.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
11.	Görüntü düzenleme programınızı kapatınız. 
12.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 2’de verilen “2. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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2.1.3. Dekupe Fotoğrafla Dijital ve Baskıya Uygun Afiş Tasarımı
Afiş, bir mesajın iletilmesi için görsel ve grafiksel ögeler ile hazırlanan bilgilendirme ta-
sarımıdır (Görsel 2.30). Afiş sosyal, politik ve kültürel gerçekliğin sadık bir yansımasıdır. 
Her dönemin iletişim gereksinimleri, sanat akımları ve baskı sistemleriyle aynı hızda 
gelişmiştir. Pompeii’de bulunanlar kazılarda duvarlara elle yazılmış mesajlar afişin o dö-
nemlerde de kullanıldığın kanıtı olsa da bunlar yalnızca duvarlara yazılan mesajlar, ola-
rak görülmüştür. 

Günümüzde kullanılan afişlerin temeli 1440’ta matbaanın icat edilmesiyle atılmıştır. İlk 
afiş 1477’de İngiltere’deki ilk matbaacı William Caxton (Vilyım Kakstın) tarafından ya-
pılmıştır. İlk resimli afiş 1482’de Jean du Pre (Jon du Pi) tarafından termal suların fay-
dalarıyla ilgili reklam afişidir. Afişin günümüzdeki şeklini alması, 1800’lü yıllarda baskı 
tekniklerinin geliştirilerek kolay seri üretime geçilmesiyle olmuştur. Afişler o dönemde 
reklam yapmak, bilgi vermek, halkı tiyatro, dans gibi kültürel etkinliklerden haberdar et-
mek amaçlarıyla kullanılmıştır. 

Görsel 2.30: Afiş tasarımı
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Afiş tasarımı yapılırken yazı tipi, fotoğraf, çizim, ikon gibi birçok görsel 
öge kullanılabilir. Kısa sürede daha fazla şey anlatabilmek için dikkat 
çekici ve anlaşılır tasarımlar yapılmalıdır. Afiş tasarımları günlük hayat-
ta da birçok alanda kullanılmaktadır. Firmalar, siyasi partiler, toplumsal 
ve sanatsal kuruluşlar gibi birçok kurum ve kuruluş afiş tasarımı yap-
tırmaktadır. Afişler, billboard (bilbord) ve vitrinlerde sergilenebildikleri 
gibi basılı yayınların yanında da verilebilir. İnternet sitelerinde gösterim 
için tasarlanan afişler ise basılı olarak da kullanılabilmektedir. Afişler 
genellikle büyük basıma uygun tasarlanmaktadır. Dijital olarak kullanı-
lacaklar ise daha küçük boyutlarda kaydedilmelidir.

Afiş tasarımında kullanılan ögeler, boş bir zemine yerleştirilmek için 
dekupe olarak üretilmeli veya arka fonları temizlenerek kullanıma ha-
zır hâle getirilmelidir. Tasarım için öncelikle konu belirlenmeli ve ko-
nuya uygun taslak tasarımlar yapılmalıdır. Taslak tasarım üzerinde 
en uygun görünen tasarımlar vektör veya piksel tabanlı programlarda 
çalışılmalıdır. Afiş kullanım alanı, çalışılacak dosyanın ölçülerini belir-
ler. Standart afiş tasarım ölçüleri bulunmaktadır. Bununla birlikte fir-
ma veya afiş tasarımını yaptıran kurum ve kişilerin isteği üzerine özel 
ölçüler de kullanılabilir. En çok tercih edilen afiş ölçüleri 28x41 cm, 
35x50 cm, 41x57 cm, 45x64 cm, 50x70 cm, 57x82 cm, 64x90 cm ve 
70x100 cm’dir. 

Afiş tasarımı için öncelikle ölçü belirlenmeli, ardından taslak çalışma 
yapılmalıdır. Programda kullanılacak ölçüye uygun yeni bir çalışma 
alanı açılmalı ve çalışılacak ögeler belirlenerek bilgisayarda oluştu-
rulan yeni bir dosya içinde toplanmalıdır. Yeni belge açıldıktan sonra 
öncelikle zemin rengi belirlenmelidir. Konuya uygun renk seçimi tasa-
rımın daha iyi anlaşılmasını sağlar. Zemin rengi oluşturulduktan sonra 
diğer tasarım ögelerinin yerleşimi yapılmalıdır. Afiş tasarımında yazı-
lar da görsel öge olarak düşünülmelidir. Bazı afişler sadece yazı ka-
rakterlerinin tipografik düzenlenmesiyle oluşturulabilmektedir. Afiş ta-
sarlamak için kullanılan ücretsiz yazılımlar ve bu yazılımlar içerisinde 
hazır şablonlar bulunmaktadır. Hazır şablon üzerine yazı ve görseller 
eklenerek de tasarım yapılabilmektedir. 

Afiş tasarımında kullanılan dil, güçlü ve etkili olmalı ve toplumun her 
bireyine hitap edebilmelidir. Afiş tasarımı yaparken öncelikle diğer ta-
sarım öğelerine dikkat etmek gerekir. Afiş, yaşanılan toplum ve zama-
na uygun düşünülerek tasarlanmalıdır. 

Alanın Kullanımı
Afişlerin sergilendiği alanların insanların bir anlık geçtikleri yerlerde 
olduğu düşünüldüğünde, afişlerin ilgi çekici olmaları gerektiği sonucu-
na varılacaktır. Bu nedenle mesajın iletilmesi kısa ve öz bir anlatım-
la yapılmalıdır. Ayrıca kısa süreli geçilen alanlarda, insanların durup 
okuması gereken büyük metin parçaları kullanılmamalıdır. Afiş tasa-
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gelsenize
us çok güz el

Görsel 2.31: Afiş tasarımı

rımında çalışılacak alanın bütünü tasarıma dâhil edilmelidir. Daha düzenli ve 
anlaşılır afişler için belirli bir düzen oluşturmak önemlidir. 

Renklerin Kullanımı
Afiş tasarlanırken afişin dikkat çekici nitelikte olması önemlidir. Bu nedenle 
tasarımda canlı renkler tercih edilmelidir. Kontrast ve farklı renk uyumu kom-
binasyonları kullanılabilir. Canlı renk kullanımı afişte dikkat çekici olsa da asıl 
mesaj ön plandadır. Mesajı desteklemeyen renk kullanımından kaçınılmalıdır. 

Tipografinin Kullanımı
Afişi oluşturan görsel ögelerin başında tipografi gelir. Tipografi afişte sadece 
bir yazı karakteri değil, aynı zamanda tasarımın da bir parçasıdır. Bazen 
tek bir görsel ve doğru seçilmiş yazı karakterleri, birçok ögenin bir arada 
kullanımından daha etkili sonuçlar verir. Doğru yazı karakteri seçimi için yazı 
karakterlerinin özellikleri bilinmelidir (Görsel 2.31). 

Hedef Kitle
Afişler belirli konu ve kişilere yönelik tasarlanır. Bu hedef kitle, tasarımın nasıl 
yapılması gerektiğini belirler. Tasarım yapılırken hedef kitleye uygun görsel, 
renk ve ifadeler kullanılmalıdır. Afiş, bir mesajın iletilmesi olarak düşünüldü-
ğünde harekete geçirici mesaj kullanımı önem taşır. Doğru kullanılan slogan 
ve mesaj, afişi diğer afişlerin önüne geçirerek hedef kitlede daha olumlu duy-
gular oluşturacaktır.
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3. UYGULAMA

UYGULAMA ADI	:	Fotoğrafla Afiş Tasarımı Yapma
AMAÇ	 :	Sosyal konuları içeren afiş çalışması yapmak. 

Aşağıdaki işlem basamaklarını dikkate alarak afiş tasarımı yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 İnsan sağlığının korunması, su tasarrufu, hava kirliğinin önlenmesi, top-

rakta erozyonla mücadele, iklim değişikliği, çevre kirliliğinin önlenmesi, 
depreme hazırlıklı olma, doğal ve kültürel mirasa sahip çıkma gibi konular-
dan birini afiş tasarımı yapmak için seçiniz.

3.	 Belirlemiş olduğunuz konuya uygun fotoğraflar bulunuz veya çekiniz.
4.	 Fotoğrafları bilgisayara aktarınız. 
5.	 Çalışmada kullanılacak fotoğrafların boyutlarının büyük olmasına özen 

gösteriniz.
6.	 Tasarlayacağınız afişin boyutunu belirleyiniz. 
7.	 Bulduğunuz fotoğrafları afişte kullanmak üzere hazırlayınız.
8.	 Belirlemiş olduğunuz afişin boyutuna uygun görselleri yerleştiriniz.
9.	 Uygun metin ve slogan ekleyerek tasarımınızı paylaşıma hazır hâle getiriniz.
10.	Afişin içerik ve tasarım yönünden uygun olduğundan emin olana kadar 

değişiklik yapınız.
11.	Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
12.	Çalışmanızı, baskıya uygun ve görüntü düzenleme programının formatında 

bilgisayara ve taşınabilir belleğe kaydediniz.
13.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
14.	Görüntü düzenleme programınızı kapatınız. 
15.	Bilgisayarınızı Başlat menüsünden kapatınız.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 2’de verilen “3. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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2.2. RESTORASYON VE DÜZELTME
Eski ve yıpranmış fotoğraflar üzerinde iyileştirme yapma iş-
lemlerine restorasyon ve düzeltme (rötuş) denir. Geçmiş-
te aranlık odada fırçalarla yapılan bu düzeltmeler, günü-
müzde görüntü düzenleme programlarıyla yapılmaktadır. 

2.2.1. Restorasyon
Restorasyon, eski görüntülerin tekrar hayata geçirilmesi 
başka bir deyişle onarılması olarak adlandırılabilir. Özellik-
le basılı fotoğraflarda yıllar geçtikçe katlanma izleri oluşur. 
Kullanılan kimyasallardaki değişimler ve benzeri nedenler-
le fotoğraflar yıpranır. Siyah beyaz çekilmiş görüntülerin 
kullanılan yeni teknikler sayesinde renklendirilmesi istene-
bilir. Tüm bu düzenlemeleri yapabilmek için fotoğraf önce-
likle dijital ortama aktarılmalıdır. Dijital ortama tarayıcılarla  
aktarılan fotoğrafların büyük boyut ve çözünürlükle akta-
rılması önemlidir. Böylelikle görünümün iyileştirilmesi için 
kaliteli altyapı oluşturulur (Görsel 2.32).

Görsel 2.32: Restorasyon 



BİLGİSAYARDA FOTOĞRAF / GÖRÜNTÜ İŞLEME

106 Bilgisayarda Fotoğraf

Fotoğraf restorasyon işlemlerinde de rötuş için kullanılan 
araçlar kullanılmaktadır. Taranan fotoğrafın, görüntü dü-
zenleme programına aktarılmadan bir yedeği oluşturulma-
lı ve yapılacak işlemlerde bu yedek kullanılmalıdır. Prog-
rama aktarılan fotoğrafın kopyası alınarak ayrı bir Layer 
oluşturulmalıdır. Bu işlem, fotoğrafın bulunduğu katmana 
farenin sağ tuşuyla tıklanıp Duplicate Layer (Dupliket Le-
yır) komutu seçilerek yapılır. Alt katmanda kalan orijinal 
fotoğraf kilitlenerek fotoğrafın üzerinde herhangi bir oyna-
manın olması engellenmelidir. Yedek Layer ile çalışmak 
orijinal fotoğrafa her an geri dönülebilecek bir çalışma ala-
nı sağlamaktadır.

Fotoğrafta katlanma izleri, su veya küf lekesi ya da başka 
tür yıpranmalar varsa öncelikle bunlar düzeltilmelidir. Dü-
zeltmeler, ince düzeltme fırçaları ve klonlama aracıyla ya-
pılır. Düzeltmeler yapılırken Layers panelinden yeni klasör 
oluşturularak dosya adı çalışmaya göre değiştirilmelidir. 
Dosya oluşturmak, özellikle birden fazla işlem uygulana-
cak fotoğraflarda düzenli çalışma alanı sağlamak açısın-
dan önemlidir. Ayrıca çalışma alanı, PSD formatında ara 
ara kaydedilerek olası bir aksiliğin önüne geçilmelidir (Gör-
sel 2.33 2.34). 

Görsel 2.33: Restorasyon çalışması için fotoğraftaki hataların giderilmesi

Görsel 2.34: Yıpranmış yerlerin klonlama ile düzeltilmesi
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2.2.2. Görüntüde Düzeltme ve Rötuş İşlemleri 
Objektiften kaynaklı distorsiyonlar, çekim sırasında gözden kaçan ufuk çizgisi, yatay ve 
dikey çizgilerin yamukluğundan oluşan hatalar fotoğrafta düzeltme uygulanarak giderilir. 
Bu işlem için filtreler sekmesinden Lens Correction (Lens Korrekşın) komutu ile öncelikle 
lens hataları giderilir. Ardından ufuk çizgisi düzeltilerek kırpma işlemi yapılmalıdır (Görsel 
2.35, 2.36 ve 2.37). 

Görsel 2.35: Lens Correction komutu 

Görsel 2.36: Perspektif düzeltme

Görsel 2.37: Perspektif düzeltme
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Fotoğrafta düzeltme sadece ufuk çizgisine ya da optik bo-
zulmalara müdahale edebilmek amacıyla yapılmaz. Fotoğ-
rafı daha güzel hâle getirebilmek amacıyla da rötuş işlemleri 
yapılmaktadır. Örneğin renklere, dokulara, ışığa yapılan kü-
çük dokunuşlar ya da istenmeyen yara izleri, sivilceler, çiller 
için genellikle portre ve vesikalık fotoğraflara yapılan müda-
haleler de sıklıkla uygulanan rötuş işlemlerinden bazılarıdır 
(Görsel 2.38, 2.39).

Görsel 2.39: Vesikalık fotoğrafta rötuşGörsel 2.38: Yüzdeki sivilcelere yapılan rötuş işlemi

Action (Ekşın) işlem penceresi kullanılarak da fotoğrafta 
düzeltme yapılabilmektedir. Görüntü düzenleme çalışma-
larına yeni başlanmışsa ve neler yapılabileceği tam olarak 
bilinmiyorsa hazır Action’lar kullanılarak fotoğraflar üzerinde 
birçok değişiklik tek bir tuşla yapılabilir. Bu uygulama için 
internet ortamından hazır Action’lar indirilmeli ve programa 
yüklenmelidir. İndirilen Action’lar oynatma tuşuna basılarak 
fotoğrafa uygulanabilir (Görsel 2.40). 

Görsel 2.40: Action kullanımı
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Kişiler kendi Action’larını da oluşturabilmektedir. Bu işlem 
için Action sekmesinde bulunan artı işaretine basılmalı ve 
yeni Action’ın adı yazılmalıdır. Bu adımdan sonra fotoğraf 
üzerine yapılan tüm işlemler kaydedilmeye başlar (Görsel 
2.41). Yapılan işlemler bittikten sonra durdurma işaretine 
(kırmızı dairenin sol yanında bulunan kareye) basılmalıdır. 
Böylelikle oluşturulan Action, başka görüntü düzenleme iş-
lemlerinde de kullanılabilecektir.

Görsel 2.41: Action yapımı
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4. UYGULAMA

UYGULAMA ADI	:	Fotoğraf Üzerinde Restorasyon Çalışması
AMAÇ	 :	Uygun araç ve yöntemi seçerek fotoğrafta düzeltme .
			   ve restorasyon işlemlerini yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak bir fotoğrafın restoras-
yon çalışmasını yapınız.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek
4.	 Eski ve yıpranmış bir fotoğraf 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Restorasyon çalışması yapabileceğiniz eski ve yıpranmış bir fotoğraf bulunuz. 
3.	 Bulduğunuz fotoğrafı basılı ise taratarak bilgisayara aktarınız.
4.	 Restorasyon için programınızı hazırlayınız. 
5.	 Fotoğraf üzerindeki yıpranmış alanları uygun araçlarla düzeltiniz.
6.	 Fotoğrafta renk düzenlemelerini orijinaline sadık kalarak yapınız. 
7.	 Fotoğraf düzenlemede amacınıza ulaşana dek düzenlemeleri tekrarlayınız.
8.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
9.	 Çalışmanızı, görüntü düzenleme programının formatında ve JPEG olarak 

bilgisayara ve taşınabilir belleğe kaydediniz.
10.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
11.	Görüntü düzenleme programınızı kapatınız. 
12.	Bilgisayarınızı Başlat menüsünden kapatınız. 
  

 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 2’de verilen “4. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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2.3. MANİPÜLASYON
Manipülasyon sözcüğü “yönlendirme, seçme, ekleme ve çıkarma yoluyla bilgileri değiş-
tirme” anlamına gelen “manipüle etmek” eyleminden gelmektedir. Günümüzde birçok 
görüntü oluşturulduğu anda manipüle edilmektedir. Akıllı telefonlarda kullanılan uygu-
lamalarla yapılan efektler, görüntü düzenleme programlarındaki otomatik renk ve ışık 
ayarları tek bir tuşla yapılabilen manipülasyonlara örnek gösterilebilir. Bununla birlikte 
daha fazla vakit alan ve daha fazla değişikliğin yapıldığı manipülasyonlar da mevcuttur. 
Dergilerde görülen pürüzsüz yüzler ve mükemmel fotoğraflar görüntü düzenleme yazı-
lımlarında manipüle edilmektedir (Görsel 2.42, 2.43). 

Görsel 2.43: Renk manipülasyonu

Görsel 2.42: Yüzde manipülasyon
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Manipülasyon, pürüzsüz ve mükemmel görüntüler elde etmek amacıyla yapılmaktadır. 
Bunun yanı sıra farklı ve gerçeküstü görüntüler oluşturmak amacıyla da manipülasyon 
yapılabilir. Manipülasyonun yapım şekli, fotoğrafın kullanım amacına göre değişmektedir 
(Görsel 2.44). 

1.ETKİNLİK

Basılı veya dijital yayın organlarından manipülasyon yapılmış fotoğraflar 
bulunuz.

•	 Manipülasyon yapılan fotoğraflarda ne gibi değişiklikler meydana geldiğini ince-
leyiniz. 

•	 Birden fazla görsel kullanılmış görüntüleri belirleyiniz.
•	Yapılan değişiklerden farklı olarak neler yapılabilirdi? Sınıfta değerlendiriniz.

Görsel 2.44: Renklerle manipülasyon
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2.3.1. Portre Fotoğraflarında Manipülasyon
Rötuş özellikle insanların olduğu fotoğraflarda uygulanmakta-
dır. Yüzde görülen kusurlar ve objektiften kaynaklanan lekeler 
rötuş araçlarından biri  seçilerek temizlenir. Temizlenen yüzde 
cilt rengine uygun renklendirme de yapılabilir. Pudralama işle-
mi denilen bu yöntem fırça yardımıyla renklendirmeyi sağlar. 
Fırça seçimi yapıldıktan sonra damlalık yardımıyla ciltteki renk-
le aynı renk seçilmeli ve rengin opaklığı düşürülerek renklen-
dirme yapılmalıdır. Rengin opaklığı düşürülmediğinde yüzdeki 
tüm detaylar kaybolacaktır (Görsel 2.45). 

Görsel 2.45: Rötuş işlemi için yüz temizleme

Temizleme işlemi sonrası, varsa modelin yüzündeki oran-
tısızlıklar da giderilmelidir. Bunun için Filters menüsünden 
Liquify (Likufay) komutuyla işlem yapılabilir. Liquify komu-
tunun en üst solda bulunan Forward Warp Tool (Forvıd 
Varp Tuul) seçeneği seçilir. Bu seçimle yüzde orantısız 
görünen yerler düzeltilebilir. Örneğin gözler aşağıda veya 
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yukarıdaysa Tool boyutu göze göre ayarlanarak hareket ettirilir. 
Tool boyutu büyüdükçe düzenlenen alan da büyüyecektir. Göz 
istenilen konuma getirildiğinde Ok tuşuna basılarak ana çalışma 
alanına geri dönülür (Görsel 2.46). 

Görsel 2.46: Liquify ile simetri düzeltme

Burnun sağında ve solunda uyumsuzluk varsa düzgün görünen ta-
raftan kopya alınarak uyumsuz tarafa yapıştırılır. Yapıştırılan kısmın 
çevrilmesi için Edit > Transform > Flip Horizontal komutuyla se-
çilen alan döndürülür ve  burnun diğer tarafına yerleştirilir. Yerleş-
tirilen tarafta oluşan renk farkları ve birleşim yerleri için maskeleme 
işlemi uygulanmalıdır. Maskeleme için kopyalanan Layer seçili iken 
Add Layer Mask seçeneğiyle renk geçişlerinin belirgin olduğu kısım-
lar silinir. Tüm işlemler bittikten sonra Layer’lar birleştirilerek tek bir 
fotoğraf elde edilmelidir. Aynı işlem dudak ve gözlerde oluşan oran-
tısızlıkları gidermek için de uygulanabilir (Görsel 2.47, 2.48 ve 2.49). 
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Görsel 2.48: Oran eşitleme

Görsel 2.49: Burun simetri düzeltme

Görsel 2.47: Oran 
eşitleme
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Fotoğraf üzerinde doğal makyaj uygulaması yapılmak is-
teniyorsa fotoğrafta doku kaybı oluşmasına engel olacak 
şekilde renklendirme yapılabilir. Fotoğrafta belirli alanları 
renklendirmek için Layer’ın kopyası alınarak Hue Saturation 
seçeneğiyle kopyanın renklendirilmesi yapılır (Görsel 2.50).

Görsel 2.50: Fotoğrafta seçili alanları renklendirme

Renklendirilen kopyanın yanında görünen beyaz kutucuğun siyaha çevrilmesi için Hue 
Saturation Layer’ı seçili iken Ctrl+i / Command+i kısayol komutuyla seçim tersine çevrilir 
(Görsel 2.51). Bu işlemden sonra renklendirmenin yapılacağı alan silinmelidir. Silme işle-
mi için öncelikle silgi aracı seçilmeli ve aracın boyutu ayarlanarak renklendirilmek isteni-
len alan silinmelidir. Aynı görüntü üzerinde birkaç farklı renklendirme işlemi yapılacaksa 
ilk Layer’dan kopyalama yapılarak aynı işlem tekrarlanmalıdır. Renklendirme işlemleri 
tamamlandıktan sonra tüm Layer’lar birleştirilerek tek bir görüntü oluşturulmalıdır (Görsel 
2.52, 2.53). 

Görsel 2.51: Fotoğrafta seçili alanları renklendirme
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Görsel 2.52: Renklendirmede maskeleme ile far yapımı

Görsel 2.53: Maskeleme ile dudak renklendirme
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Fotoğraf üzerinde yer değiştirme işlemiyle değişiklikler yapılabilir. Baş-
ka fotoğraflardan parçaların birleştirilmesi, fotoğrafın bir tarafının diğerine 
kopyalanması veya Brushes ile düzeltilerek değiştirilmesi mümkündür. 
Özellikle portre fotoğraflarında makyaj işlemi için fırça kullanımı tercih 
edilmektedir. Modelin yüzü renklendirilebilir ve fırça yardımıyla kusurlar 
düzeltilebilir. Hazır fırçalar eklenti olarak indirilerek kullanılabilir veya kul-
lanıcı kendi fırçalarını oluşturabilir. Hazır fırça kullanılırken fırça indirilip 
program dosyası içine yüklenmelidir. Programın içinden Brush sekmesi 
açılarak seçim yapılmalı, boyut ve yön ayarlanmalıdır (Görsel 2.54). 

Görsel 2.54: Brush ile kirpik ekleme 
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Fotoğraflar üzerinde fırçalar yardımıyla yüzde yapılabilecek renklendirme 
çalışmaları sınırsızdır. Fırça seçimi yapılarak kontürleme de yapılabilir. 
Bu işlem için oluşturulan bir Layer üzerinde boyama işlemi uygulanmalı-
dır. Fotoğraf üzerinde direkt boyama yapıldığında işlemi geri almak daha 
zor olacaktır. Kontür için öncelikle tek rengin daha koyu bir rengi seçilmeli 
ve fırça boyutu ayarlanarak hatların üzerinden geçilmelidir (Görsel 2.55). 
Bu işlem günlük hayatta uygulanan makyaj gibi düşünülmeli, renklendir-
meler yüz hatlarına uygun yapılmalıdır. Böylelikle daha iyi sonuçlar elde 
edilecektir. Renklendirmelerin opaklığı ayarlanarak da daha doğal sonuç-
lara ulaşılabilir. 

Görsel 2.55: Makyaj çalışması
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UYGULAMA ADI	:	 Portre Fotoğrafında Manipülasyon Çalışması 
AMAÇ	 :	 Uygun araç ve yöntemi seçerek fotoğrafta 
		  manipülasyon yapmak.

Aşağıdaki işlem basamaklarını dikkate alarak daha önce çekilmiş bir 
portre fotoğrafında manipülasyon çalışması yapınız.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek
4.	 Portre fotoğrafı

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Düzenleme yapacağınız fotoğrafı belirleyiniz. 
3.	 Düzenleme için bilgisayar ve programınızı hazırlayınız. 
4.	 Fotoğrafları bilgisayara aktarınız.
5.	 Fotoğraf üzerindeki pürüzleri temizleyiniz. 
6.	 Dudak, saç ve gözlerde renk değişiklikleri yapınız. 
7.	 Portre fotoğrafında makyaj çalışması yapınız. 
8.	 Fotoğraf düzenlemede amacınıza ulaşana dek düzenlemeleri tekrarlayınız.
9.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
10.	Çalışmanızı, görüntü düzenleme programının formatında ve JPEG ola-

rak bilgisayara ve taşınabilir belleğe kaydediniz.
11.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
12.	Görüntü düzenleme programınızı kapatınız. 
13.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 2’de verilen “5. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.

5. UYGULAMA
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2.3.2. Gerçeküstü Manipülasyon
Manipülasyon tek bir fotoğraf üzerinde yapılabildiği gibi bir-
den çok fotoğrafın birleştirilmesiyle de yapılabilir. Günümüz-
de reklam ve moda gibi sektörlerde fotoğrafın gerçeküstü 
görüntülerle dikkat çekmek amacıyla kullanılması yaygın 
hâle gelmiştir. Birbiriyle ilişkisi olmayan herhangi iki ya da 
daha fazla görüntünün birleştirilmesiyle yeni anlatım ve ifa-
de biçimleri ortaya çıkmıştır (Görsel 2.56, 2.57).   

Görsel 2.56: Fotoğrafta gerçeküstü görüntü   

Görsel 2.57: Fotoğrafta manipülasyon
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Görüntü işleme programlarında yapılan manipülasyon çalışmalarında kolaj, montaj, 
doku taşıma, maskeleme, çizim, efekt uygulama gibi pek çok yöntem bir arada kullanıla-
bilmektedir (Görsel 2.58, 2.59 ve 2.60).

Görsel 2.58: Manipülasyon
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Görsel 2.59: Üst üste baskı manipülasyon

Görsel 2.60: Fantastik manipülasyon
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Görsel 2.61: Manipülasyonda detay

Manipülasyon, fotoğrafçının hayal gücüyle sınırlıdır. Tasarım öncesi hikâye oluşturularak 
fotoğraflar birleştirilir. Bu birleştirmede renk ve dokuların uyumu önemlidir. Görsel 2.61 
ve 2.62’de farklı konu ve kompozisyonlarda manipülasyon çalışmaları görülmektedir. 
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Görsel 2.62: Manipülasyon örnekleri
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Fotoğrafta manipülasyonla gerçeküstü bir görüntü elde edil-
mek istendiğinde öncelikle birleştirilecek fotoğrafların yerle-
şim alanları eskiz ile belirlenmelidir. Birden fazla eskiz oluş-
turulabilir. Böylelikle çalışma sonunda elde edilmek istenen 
sonuç ve gidiş yolları daha belirgin hâle gelecektir. 

Eskiz çalışması yapıldıktan sonra kullanılacak görüntüler 
seçilmeli ve bu görüntüler bir yerde toplanarak çalışma dos-
yası oluşturulmalıdır. Oluşturulan dosya adıyla görüntülere 
ulaşmak ve düzenli çalışma alanı oluşturmak mümkün ola-
caktır. Görüntünün oluşturulması için hangi görselin kullanıl-
ması gerektiğine karar verilemediğinde iki görsel de dosya 
içerisinde tutulmalıdır. Çalışma başladıktan sonra görselle-
rin yerleşimlerine bakılarak hangisinin kullanılacağına karar 
verilmelidir (Görsel 2.63). 

Görsel 2.63: Manipülasyon için fotoğrafların seçimi
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Birleştirilecek fotoğraflar seçildikten sonra üst üste yerleştirilmelidir. Opacity seçeneği ile 
görünürlükleri azaltılmalı, yerleşim yerleri kontrol edilerek yer ve boyutlarına karar ve-
rilmelidir (Görsel 2.64). Yerleşim yeri ve boyutlarına karar verildikten sonra maskeleme 
işlemine başlanmalıdır. Maskeleme özellikle birden fazla fotoğraf kullanılacağı zaman uy-
gulanması gereken bir tekniktir. Aynı görüntü birden fazla kopyalanarak katman oluşturu-
labilir. Böylelikle önde ve arkada nesnenin devamı olması durumunda uygulama yapmak 
daha kolay olacaktır (Görsel 2.65). 

Görsel 2.64: Fotoğrafların yerleşim yerinin ayarlanması

Görsel 2.65:  İki fotoğrafta alınacak yerlerin seçilmesi ve yerleştirme  
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Maskelemede yumuşak geçişler için yumuşak fırçalar kullanılmalıdır. Maskeleme alanı 
küçük olan görüntüler başka bir çalışma alanına seçim araçlarından biriyle seçilerek taşı-
nabilir. Böylelikle silinecek alan azaltılmış olur. Tek nesneden oluşan çok sayıda katman 
varsa grup oluşturularak çalışılmalıdır (Görsel 2.66, 2.67). 

Görsel 2.66: Birleştirme sonrası hataların düzeltilmesi ve 
iki fotoğrafı kaynaştırma

Görsel 2.67: İki fotoğrafın birleştirilerek tek görüntüye dönüştürülmesi
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6. UYGULAMA

UYGULAMA ADI	:	 Birbirine Uygun Fotoğraflarla Fantastik Karakter     .
		  Oluşturma 
AMAÇ	 :	 Uygun araçları kullanarak bilgisayarda manipülasyon  .
		  yöntemiyle fantastik karakter oluşturmak.

Aşağıdaki işlem basamaklarını dikkate alarak, seçtiğiniz fotoğraflardan 
yeni bir karakter oluşturup kullanım alanına uygun kaydediniz.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek
4.	 Konuya uygun fotoğraflar 

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Oluşturmak istediğiniz karaktere uygun fotoğrafları belirleyiniz. 
3.	 Düzenleme için bilgisayar ve programınızı hazırlayınız. 
4.	 Fotoğrafları bilgisayara aktarınız.
5.	 Fotoğraflar üzerinde gerekli gördüğünüz düzeltmeleri yapınız. 
6.	 Oluşturmak istediğiniz karakter için fotoğraf birleştirmeleri yapınız.
7.	 Manipülasyon için gerekli düzenlemeleri yapınız.
8.	 Çalışmada amacınıza ulaşana kadar fotoğrafı düzenlenmeye devam 

ediniz.
9.	 Fotoğraf düzenleme sırasında planlı ve disiplinli çalışmaya dikkat ediniz.  
10.	Çalışmanızı, görüntü düzenleme programının formatında ve JPEG olarak 

bilgisayara ve taşınabilir belleğe kaydediniz.
11.	Taşınabilir belleğinizi bilgisayardan çıkarınız. 
12.	Görüntü düzenleme programınızı kapatınız. 
13.	Bilgisayarınızı Başlat menüsünden kapatınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 2’de verilen “6. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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A) Aşağıdaki cümlelerde parantez (...) ile boş bırakılan alanlara verilen .
     bilgiler doğru ise “D” yanlış, ise “Y” yazınız. 

1.	 (...) Bir fotoğraf orijinal boyutundan daha büyük boyuta getirildiğinde .
		  bozulmalar oluşur. 
2.	 (...) Eski fotoğrafları görüntü düzenleme programında düzeltme işlemine .
		  manipülasyon denir. 
3.	 (...) Fotoğraflardaki küçük hataların giderilmesi için fırçayla boyama     .
		  yöntemi kullanılır.
4.	 (...) Clone Stamp Tool fotoğraftaki bir alanı kopyalayıp istenilen alana     .
		  yerleştirmek için kullanılır.  
5.	 (...) Modelin yüzünde oluşan simetrik hataların giderilmesi için Liquify    .
		  sekmesi kullanılır.

B) Aşağıdaki cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.

6.	Birden fazla Layer’ın birleştirilmesi için ................... komutu kullanılır. 
7.	Fotoğrafın boyunu küçültmek için ................... komutu kullanılır.

C) Aşağıdaki soruları okuyarak doğru seçeneği işaretleyiniz.

8.	Aşağıdakilerden hangisi fotoğrafta renkleri canlı hâle getirmek için 
uygulanan komuttur? 

	 A) Sharpness
	 B) Saturation
	 C) Noise Redustion
	 D) Image Size
	 E) Liquify

9.	 Aşağıdakilerden hangisi görüntü düzenleme programında kullanılan 
ham dosya biçimidir?

A) DOC         B) GIF         C) JPEG         D) PNG         E) PSD

10.	Aşağıdakilerden hangisi fotoğrafı baskıya göndermeden önce 
      dikkat edilmesi gereken durumlardan biridir?

		  A) Yüksek çözünürlük
		  B) Renk doygunluğu
		  C) Beğeni sayısı
		  D) Telefonla çekim
		  E) GIF dosya uzantısı

ÖLÇME VE DEĞERLENDİRME
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ÖLÇME VE DEĞERLENDİRME

11.	Fotoğraf çekilirken oluşan distorsiyon hatalarının giderilmesi için  .
	 aşağıdakilerden hangisi kullanılır?

		  A) Lens Correction
		  B) Crop
		  C) Add Layer Mask
		  D) Duplicate Layer
		  E) Sharpness

12.	Aşağıdakilerden hangisi kolaj tekniği için söylenemez?

		  A) Tek fotoğraftan oluşur.
		  B) Birden çok fotoğraf bulunur.
		  C) Layerlar ile çalışılır.
		  D) Maskeleme ile yapılır.
		  E) Aynı konudan fotoğraflar birleştirilir.

Ç) Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.  

13.	Kolaj ve montaj arasında ne gibi farklar bulunmaktadır?

…………………………………………………………………………………
…………………………………………………………………………………
…………………………………………………………………………………
…………………………………………………………………………………

14.	Manipülasyon tekniklerini örneklerle açıklayınız. 

…………………………………………………………………………………
…………………………………………………………………………………
…………………………………………………………………………………
…………………………………………………………………………………

15.	Afiş tasarımı yapılırken dikkat edilmesi gerekenleri örneklerle 
      açıklayınız. 

…………………………………………………………………………………
…………………………………………………………………………………
…………………………………………………………………………………
…………………………………………………………………………………
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1. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 

hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğrafları belirledi. 

3. Düzenleme yapacağı fotoğrafları bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğraflarda ufuk çizgisi-
ni düzeltti.  

5.
Estetik kuralları dikkate alarak fotoğraflarda ışığı dü-
zeltti.  

6.
Estetik kuralları dikkate alarak fotoğraflarda renkleri 
düzeltti.  

7. Estetik kuralları dikkate alarak fotoğraflara rötuş yaptı.  

8. Kolaj çalışması için gerekli kompozisyonu oluşturdu.

9.
Hazır kolaj şablonlarını veya kendi oluşturduğu kompo-
zisyonu kullanarak kolajını tamamladı.

10. Çalışmasını taşınabilir belleğe kaydetti.

11. Taşınabilir belleği koşullara uygun çıkardı.

12. Programı zarar görmeyecek şekilde kapattı.

13. Bilgisayarı zarar görmeyecek şekilde kapattı.

14. Süreyi planlı ve verimli kullandı.

15. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 4 
“Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 15 ölçüt bulunmaktadır. Ölçekten alınabi-
lecek en yüksek puan 75’tir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (75x100)/75=100
Değerlendirme:100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz yeterli 
demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-2
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2. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 

hazırladı.

2.
Düzenleme yapılacak konuya uygun fotoğrafları belir-
ledi.

3. Düzenleme yapacağı fotoğrafları bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğraflarda ufuk çizgi-
sini düzeltti.  

5.
Estetik kuralları dikkate alarak fotoğraflarda ışığı 
düzeltti.  

6.
Estetik kuralları dikkate alarak fotoğraflarda renkleri 
düzeltti.  

7. Estetik kuralları dikkate alarak fotoğraflara rötuş yaptı.  

8. Montaj çalışması için gerekli kompozisyonu oluşturdu.

9.
Montaj çalışması için uygun araçları seçerek çalışma-
sını tamamladı.

10. Çalışmasını taşınabilir belleğe kaydetti.

11. Taşınabilir belleği koşullara uygun çıkardı.

12. Programı zarar görmeyecek şekilde kapattı.

13. Bilgisayarı zarar görmeyecek şekilde kapattı.

14. Süreyi planlı ve verimli kullandı.

15. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 
4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 15 ölçüt bulunmaktadır. Ölçekten alına-
bilecek en yüksek puan 75’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (75x100)/75=100
Değerlendirme:  100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-2
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3. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 
gerecini hazırladı.

2. Afiş tasarımına uygun konu belirledi.

3. Afiş tasarımı için uygun görselleri buldu.

4. Tasarlayacağı afişin boyutunu belirledi.

5. Afişe görselleri yerleştirdi.

6. Afişe uygun slogan buldu.

7. Afişe uygun yazı karakteri seçti.

8.
Gerekli tasarımları yaparak afişi paylaşıma hazır 
hâle getirdi.

9. Yapmış olduğu afişi paylaştı. 

10. Süreyi planlı ve verimli kullandı.

11. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 11 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 55’tir.
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (55x100)/55=100
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-2
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4. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı.

2.
Düzenleme yapılacak konuya uygun fotoğrafı  belir-
ledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğraflarda ufuk 
çizgisini düzeltti.  

5.
Estetik kuralları dikkate alarak fotoğraflarda ışığı 
düzeltti.  

6.
Estetik kuralları dikkate alarak fotoğraflarda renkleri 
düzeltti.  

7. Estetik kuralları dikkate alarak fotoğrafa rötuş yaptı.  

8.
Restorasyon düzeltmeleri için gerekli araçları kulla-
narak çalışmasını tamamladı.

9. Çalışmasını taşınabilir belleğe kaydetti.

10. Taşınabilir belleği koşullara uygun çıkardı.

11. Programı zarar görmeyecek şekilde kapattı.

12. Bilgisayarı zarar görmeyecek şekilde kapattı.

13. Süreyi planlı ve verimli kullandı.

14. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 
4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 14 ölçüt bulunmaktadır. Ölçekten alına-
bilecek en yüksek puan 70’tir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (70x100)/70=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz ye-
terli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-2
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5. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 

hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğrafı belirledi.

3. Düzenleme yapacağı fotoğrafı bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğrafın ufuk çizgisini 
düzeltti.

5. Estetik kuralları dikkate alarak fotoğrafın ışığını düzeltti.

6.
Estetik kuralları dikkate alarak fotoğrafın renklerini dü-
zeltti.

7. Estetik kuralları dikkate alarak fotoğrafa rötuş yaptı.  

8. Fotoğraf üzerindeki pürüzleri temizledi.

9. Göz, saç, dudak rengi gibi değişikler yaptı.

10. Portre fotoğrafında makyaj çalışması yaptı.

11. Çalışmasını taşınabilir belleğe kaydetti.

12. Taşınabilir belleği koşullara uygun çıkardı.

13. Programı zarar görmeyecek şekilde kapattı.

14. Bilgisayarı zarar görmeyecek şekilde kapattı.

15. Süreyi planlı ve verimli kullandı.

16. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 16 ölçüt bulunmaktadır. Ölçekten 
alınabilecek en yüksek puan 80’dir.
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (80x100)/80=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-2
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6. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 

hazırladı.

2. Düzenleme yapılacak konuya uygun fotoğrafları belirledi.

3. Düzenleme yapacağı fotoğrafları bilgisayara aktardı.

4.
Estetik kuralları dikkate alarak fotoğrafın ufuk çizgisini 
düzeltti.

5. Estetik kuralları dikkate alarak fotoğrafın ışığını düzeltti.

6.
Estetik kuralları dikkate alarak fotoğrafın renklerini dü-
zeltti.

7. Estetik kuralları dikkate alarak fotoğrafa rötuş yaptı.  

8. Fotoğraflar üzerindeki pürüzleri temizledi.

9.
Oluşturmak istediği karaktere uygun fotoğrafların birleş-
tirmelerini yaptı.

10. Manipülasyona uygun gerekli düzeltmeleri yaptı.

11. Çalışmasını taşınabilir belleğe kaydetti.

12. Taşınabilir belleği koşullara uygun çıkardı.

13. Programı zarar görmeyecek şekilde kapattı.

14. Bilgisayarı zarar görmeyecek şekilde kapattı.

15. Süreyi planlı ve verimli kullandı.

16. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 4 
“Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 16 ölçüt bulunmaktadır. Ölçekten alınabi-
lecek en yüksek puan 80’dir.
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (80x100)/80=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz yeter-
li demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-2



3. 
ÖĞRENME

BİRİMİ

DİJİTAL 
İLLÜSTRASYON



TEMEL KAVRAMLARKONULAR

HAZIRLIK ÇALIŞMALARI

NELER ÖĞRENECEKSİNİZ?

1.	 Bir bireyin kendine özgü yapısını ifade eden ve onu başkalarından ayıran        .
	 ‘‘karakter’’ ne gibi özellikler taşır? Örneklerle açıklayınız. 
2.	 Dijital mekânlarla nerelerde karşılaşılır? Örneklerle açıklayınız.  
3.	 En çok kullandığınız emoji alanı ve emojiler hangileridir?
4.	 Bilgisayar ve web sitelerinde gördüğünüz simgelerden aklınızda kalanlar   
     hangileridir?

3.1. DİJİTAL ORTAMDA     
       KARAKTER TASARIMI 
3.2. DİJİTAL ORTAMDA MEKÂN  
       TASARIMI
3.3. EMOJİ VE İKON TASARIMI 

•	 Karakter
•	 Dijital mekân
•	 Emoji 
•	 İkon 

•	 Dijital ortamda karakter tasarımı yapma 
•	 Model sheet sayfaları hazırlama ve inceleme 
•	 Dijital ortamda mekân tasarımı yapma
•	 Emoji tasarımı yapma 
•	 İkon tasarımı yapma
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DİJİTAL İLLÜSTRASYON

İllüstrasyon, bir sanatçı tarafından yapılmış görselleştirme 
çalışmasıdır. İllüstrasyon bir metnin yanında verilebileceği 
gibi tek başına da verilebilir. Anlatılmak istenen hikâyenin 
görselleştirilmesi veya bir metnin anlatımının güçlendirilmesi 
amacıyla kullanılır. İllüstrasyonla anlatım, belirli bir bağlamı 
görüntü yardımıyla açıklamaktır. İllüstrasyonlar birçok alan-
da kullanılmaktadır. Kullanım alanına ve sanatçının çalışma 
şekline göre illüstrasyonların üretim şekli de değişebilir. 
İllüstrasyonlar, klasik bir yöntem olan elle çizilerek ya da di-
jital programlar kullanılarak yapılabilmektedir. Dijital ortam-
larda kullanım alanları artan ve klasik yöntemlere göre daha 
pratik olan dijital illüstrasyonların kullanımı gün geçtikçe art-
maktadır.

Dijital illüstrasyonlar piksel tabanlı ve vektör tabanlı olmak 
üzere iki farklı şekilde üretilmektedir. Piksel tabanlı prog-
ramlarda her bir pikselin bilgileri ayrı saklanmaktadır. Vektör 
tabanlı yazılımlarla oluşturulan illüstrasyonlar, bilgisayar al-
goritmasına bağlı iki noktanın birleşimiyle oluşturulur. Piksel 
tabanlı programlardaki çalışmaların aksine vektör tabanlı 
programlarda oluşturulan çıktılar ne kadar büyütülse de her-
hangi bir bozulmayla karşılaşılmaz. Çizilen ögeler her za-
man keskin ve net olur. Piksel tabanlı programlardaki çıktılar 
ise piksel sayısıyla sınırlıdır (Görsel 3.1).

Görsel 3.1: Piksel ve vektör karşılaştırması

İllüstrasyonların fikir aşaması ve yapımında birçok farklı kay-
naktan (canlılar, bitkiler, insanlar, karikatürler) faydalanmak 
mümkündür. İllüstrasyon çizimlerinde yararlanılan kaynak-
ların başında fotoğraf gelmektedir. Farklı alanlarda çekilmiş 
birçok fotoğraf, dijital karakter veya dijital mekân tasarımla-
rında, birebir kopyalanamasa da, gerçeğe yakın görüntüler 
oluşturabilmek için kaynak olarak kullanılmaktadır. 
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DİJİTAL İLLÜSTRASYON

3.1. DİJİTAL ORTAMDA KARAKTER   
       TASARIMI 
Bireyin toplumdaki diğer kişilerden farklı tüm özellikleri 
kişinin karakterini oluşturmaktadır. Bu farklar sosyolo-
jik, psikolojik ve fizyolojik özelliklerin bütünüdür. Dijital 
karakter tasarımında “karakter özelliklerini göstermek” 
amaçlanmaktadır. Görsel 3.2’de farklı karakter özellikle-
rini yansıtan karakter tasarımları görülmektedir. Karakter 
tasarımında çizim yeteneğinin güçlü olması kadar iyi bir 
gözlemci olmak da önem taşır. Dijital karakterler, genel-
likle günlük hayatta karşılaşılan kişilerden esinlenerek ta-
sarlanmaktadır. Gerçeğe yakın kişilik özellikleri, karakter 
tasarımında daha dikkat çekici ve inandırıcı olmaktadır. 
Dijital karakter tasarımında tasarımcı öncelikle oluştura-
cağı karakterin kişisel özelliklerini belirlemeli ve karakte-
rini bunun üzerine inşa etmelidir. Toplumda gözlemlenen 
insan, hayvan ve nesnelerin özellikleriyle oluşturulabi-
lecek yeni karakterler gerçeğe uygun oluşturulduğunda 
hem  izleyici karakterde kendinden bir şeyler bulacak 
hem de karakter akla daha yatkın hâle gelecektir.

Dijital çağın gelişmesi, dijital karakter kullanımının da 
yaygınlaşmasına olanak sağlamıştır. Reklam sektörü ile 
maskot yapımı ve oyun tasarımı gibi alanlarda karakter ta-
sarımı kullanılmaktadır. Kullanıcının kendinden bir şeyler 
katarak oluşturduğu, kendine yakın hissettiği karakterler 
daha başarılı bulunmakta ve daha uzun süre kullanılmak-
tadır. Kişilerin, karakteri kendine yakın hissedebilmesi 
için toplumsal özellikler de tasarıma yansıtılmaktadır.

Karakter tasarımları; kitap, gazete, dergi gibi yayınlarda, 
dijital platformlarda ve en çok da animasyon çalışmala-
rında kullanılmaktadır. Çocuk hikâyelerinden yetişkinlere 
hitap eden içeriklere kadar her türlü basılı veya dijital ya-
yında karşımıza çıkmaktadır. Karakter tasarımının nasıl 
yapılacağı aşağıda sıralanan bazı etkenlere göre değiş-
mektedir. 

•	 Kullanılacağı yere (reklam-tanıtım hizmetleri, öykü 
resimleme, vb.) 

•	 Hedef kitlesine (farklı yaş grupları, meslek grupları 
vb.) 

•	 Çalışmanın türüne (bilimsel, tarihî, kurgusal, gerçek-
çi, fantastik, vb.) 

•	 İki ya da üç boyutlu (2D veya 3D) olmasına göre de-
ğişmektedir.

Görsel 3.2: Karakter 
tasarımında farklı 
karakter örnekleri
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DİJİTAL İLLÜSTRASYON

3.1.1. Karakter Tasarımında Model Sayfası 
İllüstrasyon çalışmalarında karakter çizimi ve tasarımı tam arkadan ya da tam 
önden yapılmaz. Genellikle yandan ve 3 / 4 oranında dönük görünümlü çizimler 
tercih edilir. Arkadan görünüm kullanılması gerektiğinde bile (özel durumlar dı-
şında) karakterin 3 / 4 oranında dönük olması sağlanır. Animasyon gibi hareketli 
çalışmalarda ise figürlerin farklı duruşları gösterilmelidir (Görsel 3.3). 

Görsel 3.3: 2D ve 3D karakterler 

3D karakterler

2D karakterler
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DİJİTAL İLLÜSTRASYON

Görsel 3.4: Dijital ortamda yapılmış karakter tasarımları

Görsel 3.5: Karakter tasarımında model sheet

Bu durumda karakterin ön, yan, 3/4 oranlı arka görünümleri çalışılarak aynı 
sayfaya yerleştirilir ve model sheet (madıl şiid) denilen model sayfası hazırlanır 
(Görsel 3.4, 3.5). Karakter tasarımı genellikle tam figür olarak yapılmakta ancak 
yüz ifadelerine odaklanmak istenildiğinde portre biçiminde de hazırlanabilmekte-
dir. Tasarımda gerçekçi görünüm elde edebilmek için fotoğraftan yararlanılabilir.
Görsel 3.6 ve 3.7’de farklı konularda kullanılmak üzere çizimler yapılmıştır. 

arka ön 3/4 yan
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DİJİTAL İLLÜSTRASYON

Görsel 3.6: Farklı hareket ve yüz ifadelerinin yer aldığı model sheet çalışması

Tasarımlarda kullanılmak üzere modelin hareketleri kol, 
bacak, yüz gibi ayrı ayrı çizilerek birden fazla taslak 
oluşturulmuştur.



145Bilgisayarda Fotoğraf

DİJİTAL İLLÜSTRASYON

Görsel 3.7: Farklı hareket ve yüz ifadelerinin yer aldığı model sheet çalışması
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DİJİTAL İLLÜSTRASYON

3.1.2. Karakter Tasarımında Yüz İfadesinin Önemi
Karakter tasarımında Görsel 3.8 ve 3.9’da görüldüğü gibi değişik duygu 
durumlarının aktarımı önemlidir. Duygu durumlarını aktarırken yüz ifadesi 
ön plana çıkmaktadır. Göz, kaş, burun ve ağzın almış olduğu farklı biçim-
ler ifadeyi etkiler. Korku, neşe, endişe, şaşkınlık, heyecan gibi duyguların 
yaşandığı sırada yüzün bölümlerinin aldığı biçimler iyi gözlemlenmeli, ge-
rekirse fotoğraflardan yararlanılmalı ve gözlem sonuçları karaktere yansı-
tılmalıdır. 

Görsel 3.8: Karakterde farklı duygu durumları

Görsel 3.9: Karakterde farklı duygu durumları
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DİJİTAL İLLÜSTRASYON

1. ETKİNLİK

Basılı veya dijital yayın organlarından farklı duygu durumlarını yansıtan 
fotoğraflar bulunuz. 

•	 Fotoğraflarda gördüğünüz göz, kaş, burun, ağız ve çene yapılarının duygu 
durumlarına göre farklarını inceleyiniz.

•	 Fotoğraflardaki yüz ifadelerini basit çizimlerle aşağıdaki boşluğa çiziniz.
•	 Çizdiğiniz çeşitli duygu durumlarındaki yüz ifadelerinde oluşan biçimleri kar-

şılaştırınız. Bulduğunuz farkları sınıfta değerlendiriniz. 
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DİJİTAL İLLÜSTRASYON

3.1.3. Model Sheet
Model sheet, oluşturulan karakterin çok yönlü olarak çizilmesi işlemidir. Özellikle animas-
yon çalışmaları için oluşturulan karakter, modelin hareketlendirilebilmesi için farklı yönler-
de çizilmelidir. Bu çizim, daha sonra animasyon çalışmalarında oluşturulacak sahnelerde 
kullanılmak üzere hazır hâle getirilir. Son dönemlerde internet siteleri için fotoğraflar da 
çok yönlü olarak çekilmektedir. Model sheet, ürünlerin çok yönlü olarak görülebilmesi ve 
alıcının daha fazla bilgi edinebilmesi amacıyla tercih edilmektedir (Görsel 3.10). 

Görsel 3.10: Model sheet çekimleri
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DİJİTAL İLLÜSTRASYON

Görsel 3.11: Model sheet çekimleri

Bunun için fotoğrafı çekilecek nesne veya modelin yeri sa-
bitlenir. Model döndürülerek belirli açılar ile birden fazla 
fotoğrafı çekilir. Çekilen bu fotoğraflar, daha sonra video 
düzenleme programlarında birleştirilerek kullanıma hazır 
hâle getirilir. 

Çok yönlü çekilen fotoğraflar aynı zamanda karakter tasa-
rımları için de kullanılmaktadır. Çekilen fotoğraflar, vektör 
programlarına aktarılarak üzerinde çizimlerin yapılması 
yöntemi ile model sheet oluşturulur (Görsel 3.11). 
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DİJİTAL İLLÜSTRASYON

1. UYGULAMA

UYGULAMA ADI	:	Model Sheet İçin Fotoğraf Çekimi
AMAÇ	 :	Bir modelin belden yukarısının dört yönden (ön, arka .
		  yan, 3/4 oranlı görünüm) fotoğraflarını çekmek.

Aşağıdaki işlem basamaklarını dikkate alarak model sheet için fotoğraf 
çekimi yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Fotoğraf makinesi
3.	 Yardımcı ekipmanlar
4.	 Görüntü düzenleme programı 
5.	 Taşınabilir bellek

İşlem Basamakları
1.	 Atölye kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Model sheet fotoğraflarını inceleyerek nasıl fotoğraflar çekmeniz gerektiği-

ni belirleyiniz.
3.	 Belirlemiş olduğunuz fotoğraf çekimi için uygun ortam hazırlayınız.
4.	 Modelinizin dönüş yerlerini belirleyerek işaretleyiniz. 
5.	 Işıklarınızı modelin konumuna göre ayarlayarak modeli çekime hazır hâle 

getiriniz.
6.	 İlk açıdan başlayarak modelinizin çok yönlü fotoğraflarını çekiniz. 
7.	 Yapmış olduğunuz çekimi kontrol ediniz. Çekimin amacına uygun yapıldı-

ğından emin olana kadar çekimi tekrarlayınız. 
8.	 Çektiğiniz fotoğrafları bilgisayara aktarınız.
9.	 Model sheet sayfası için zemini ve fotoğrafların yerleştirileceği alanları be-

lirleyiniz.
10.	Fotoğrafların yönlerini model sheet kurallarına göre düzenleyiniz.
11.	Hazırladığınız sayfayı paylaşıma uygun formatta kaydederek taşınabilir 

belleğinize aktarınız.
12.	Çalışma sırasında planlı ve disiplinli olmaya dikkat ediniz.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Çalışma-
nız, Ek 3’te verilen “1. Derecelendirme Ölçeği”ndeki ölçütlere göre değerlendi-
rilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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3.1.4. Karakter Tasarımında El Çizimlerinin    
          Kullanılması
Karakter tasarımında tasarımcılar direkt çizim yazılımlarını kul-
lanmaktadır. Bunun dışında önce elde çizmeyi daha sonra ya-
zılımları kullanmayı tercih eden tasarımcılar da bulunmaktadır. 
Bu durum tamamen istenen karaktere ve tasarımcının tercihi-
ne bağlıdır. El çizimini tercih eden tasarımcılar, tasarlanacak 
karakterin konusuna ve amacına uygun el çizimlerinin daha 
yaratıcı ve özgün olabileceğini düşünmektedir. Bunun dışında 
çalışmalarını yalnızca dijital ortamda yapan, özgünlük ve farklı-
lığı yakalayan tasarımcılar da bulunmaktadır. 

Gelişen teknoloji, grafik tablet ve bilgisayarda dijital kalem 
kullanılarak çizim yapılmasına olanak sağlamıştır. Bu sayede 
günümüzde dijital ortamda çizimler daha kolay yapılabilmekte, 
bilgisayar ya da tabletlerde karakter tasarlanabilmektedir. Böy-
lelikle Görsel 3.12’deki gibi hem elle çizimin verdiği özgünlük 
ve sanatsal üslup uygulanabilmekte hem de aynı karakter tasa-
rımında renklendirme, ekleme, çıkarma, kopyalama, değişiklik 
yapma, hataların düzeltilmesi gibi teknolojinin sağladığı birçok 
kolaylıktan yararlanılabilmektedir (Görsel 3.13).

Görsel 3.13: Elde yapılan çizimlerin bilgisayarda renklendirilmesi

Görsel 3.12: Çizim tabletinde karakter tasarımları
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3.1.5. Farklı Yönlerden Çekilmiş Fotoğraflarla    
          Karakter Tasarımı
Dijital ortamda yapılan karakter tasarımlarında fotoğraflar-
dan faydalanmak istendiğinde öncelikle istenen karaktere 
uygun, Görsel 3.14’teki gibi farklı yönlerden farklı duruş ve 
duygu durumlarında fotoğraf çekimleri gerçekleştirilmelidir. 
Çekimlerin, gerekli koşullar sağlanarak stüdyo ortamında 
yapılması avantaj sağlayacaktır. 

Görsel 3.14: Farklı duruş ve duygu durumlarında çekilmiş portre fotoğrafları

Görsel 3.15’teki gibi farklı yönlerden, değişik duygu durum-
larıyla çekilmiş fotoğraflar; bilgisayar ortamında vektörel, 3D 
programlarda veya görüntü düzenleme programlarında açı-
larak karakter tasarımında kullanılabilir.

Fotoğraf çekimlerinden sonra karakter tasarımında kullanıl-
mak üzere uygun fotoğraflar belirlenerek bilgisayar yazılım-
larına aktarılır. Tasarımda görüntü düzenleme programı kul-
lanılıyorsa adımların katmanlar hâlinde yapılması; vektörel 
program kullanılıyorsa çalışmanın aşamalar hâlinde farklı 
isimlerle kaydedilmesi gerekir. Bu işlem, hata yapıldığında 
geri dönebilmeyi ve istenen görüntüye ulaşabilmeyi kolay-
laştıracaktır. İki program eş zamanlı kullanılarak da çalışıla-
bilir. Pen aracının gerektirdiği çizim aşamaları vektörel prog-
ramda yapılırken efekt, doku ya da farklı stiller de görüntü 
düzenleme programında uygulanabilir (Görsel 3.16). 

Bilgisayara bağlanan 
çizim tabletlerinin 

kalemleri mouse yerine 
kullanılır. Çizim kalemle-
ri tasarım programların-
da daha kolay çalışma 

imkânı sunar.

BİLGİ 
KUTUSU
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Görsel 3.15: Karakter tasarımı için 3/4, yan ve ön görünümlerle çekilmiş fotoğraflar

Görsel 3.16: Farklı duruş ve duygu durumlarında karakter tasarımı
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Fotoğraflardan veya elle yapılan çizimlerden yola çıkılarak karakter tasarlamak için 
öncelikle çizim taranır veya fotoğrafı çekilerek bilgisayara aktarılır. Programda arka 
planda açılan fotoğraf veya çizimin opaklığı düşürülerek Layer kilitlenir ve yeni Layer 
açılır. Çeşitli çizim ve düzenleme araçları kullanılarak yeni Layer üzerinde çalışmaya 
başlanır. Karakterin gerçek ya da gerçeküstü olması kullanılan teknikleri etkileyecektir. 
Çizim, kolaj, montaj, çarpıtma, manipülasyon, doku taşıma, efekt kullanımı gibi fark-
lı tekniklerin uygulanması, istenen karakterin başarıyla oluşturulmasında tasarımcıya 
yardımcı olacaktır (Görsel 3.17). 

Görsel 3.17: Portre fotoğrafından yola çıkılarak yapılmış karakter tasarımları
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3.1.6. Çizim Yoluyla Karakter Tasarımı
Karakter tasarımında özgün karakterler oluşturabilmek için gerçek kişilerin fotoğrafların-
dan yararlanılabileceği gibi Görsel 3.18’de görülen hayalî karakterlerin çizimlerinden de 
yararlanılabilir. Karakter tasarımcısı öncelikle elde çizim yöntemiyle taslak çizim oluştur-
malıdır. Daha sonra çizimi bilgisayara aktarmalıdır. 

Tasarımcı, piksel tabanlı bir program kullanacaksa New Layer sekmesini tıklayarak ak-
tarılmış çizimin (görüntünün) üzerinde yeni bir katmanda çizimi tekrarlamalıdır. Yeni bir 
Layer üzerine yapmadığı çizim, transfer ettiği görsele bağlı kalacağı için kullanıma uygun 
olmayacaktır. Tasarımcı, çizimi bitirdikten sonra değiştirilmesi gereken yerleri değiştir-
melidir. Çizim ve düzeltme işlemi bittikten sonra karakter renklendirilmelidir. Tasarımcı, 
çalışmasını programın dosya formatında kaydederek daha sonraki işlemler için kendine 
bir yedek oluşturmalıdır. 

Görsel 3.18: Elde yapılan çizimden hareketle bilgisayarda karakter çizimi
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Çizim yapılırken vektör tabanlı bir program kullanılacaksa yeni bir katman 
açılmasına gerek yoktur. Daha önce yapılmış çizim veya fotoğraftan yararla-
nılacaksa yeni Layer çalışma alanı açılarak, işlem bittikten sonra programa 
aktarılan görüntü seçilip kolaylıkla silinebilir. Ancak rahat çizim yapılabilmesi 
açısından aktarılan görüntünün Selection Tool ile seçildikten sonra görüntü  
gerekli büyüklüğe getirilerek çizimin opaklığının düşürülmesi ve üst menü çu-
buğunda yer alan Object > Lock seçimiyle kilitlenmesi gerekir.

3.1.7. Fotoğraftan Hareketle Karakter Tasarımı
Vektörel program ile piksel görüntü düzenleme programının arayüz ve araçla-
rı birbirine çok benzemektedir. Ancak birinde vektörel çizim ağırlıklı, diğerinde 
ise fotoğraf işleme ağırlıklı çalışılmaktadır. Başka bir deyişle fotoğraf üzerinde 
birtakım değişiklik ve düzenlemeler yapılacaksa görüntü işleme programı ter-
cih edilmelidir. Bunun nedeni vektörel programda fotoğrafa çok fazla müda-
hale etmenin mümkün olmamasıdır. Ancak fotoğraftan yararlanılarak çizim ya 
da işlenmiş fotoğraflarla maskeleme, ölçeklendirme, düzenleme gibi işlemler 
yapılabilmektedir. Bu nedenle fotoğraflarla yapılan uygulamalar, görüntü işle-
me yazılımlarında daha kolay yapılabilmektedir. Vektörel tabanlı tasarım ya-
pılmak istendiğinde vektörel programlar tercih edilir. Görsel 3.19’da vektörel 
programın arayüzü görülmektedir. 

Görsel 3.20’de vektörel programın araç kutusunda bulunan araçlar görülmek-
tedir. Bazı araçların ucunda küçük oklar bulunmaktadır. Bu oklara fare sol 
tuşu basılı tutularak tıklandığında araçların alt seçeneklerine ulaşılmaktadır.

Görsel 3.19: Vektörel program arayüzü
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Görsel 3.20: Vektörel programda araçlar kutusu

Selection Tool 
(Seçim Aracı)

Direct Selection Tool 
(Doğrudan Seçim Aracı)

Lasso Tool 
(Kement Aracı)

Magic Wand Tool
(Sihirli Değnek Aracı)

 Pen Tool 
(Kalem Aracı)

Curvature Tool
(Eğrilik Aracı)

 Type Tool
(Yazı Aracı)

Line Segment Tool
(Çizgi Segmenti Aracı)

Rectangle Tool 
(Dikdörtgen Aracı)

Paintbrush Tool 
(Boya Fırçası Aracı)

Shaper Tool 
(Şekillendirici Aracı)

Eraser Tool 
(Silgi Aracı)

Rotate Tool 
(Döndürme Aracı)

Scale Tool 
(Ölçek Aracı)

Width Tool 
(Genişlik Aracı)

Free Transform Tool 
(Serbest Dönüştürme Aracı)

Shape Builder Tool 
(Şekil Oluşturma  Aracı)

Perspective Grid Tool 
(Perspektif Izgarası Aracı)

Mesh Tool
(Kafes Aracı)

Gradient Tool 
(Degrade Aracı)

 Eyedropper Tool 
(Damlalık Aracı)

Blend Tool 
(Karışım Aracı)

 Symbol Sprayer Tool 
(Sembol Püskürtme Aracı)

Column Graph Tool 
(Sütun Grafik Aracı)

Stroke Color
(Kontür Rengi)

 Fill Color 
(Doldurma Rengi)

Change Screen Mode 
(Ekran Modu Değiştirme)

Artboard Tool 
(Çalışma Yüzeyi Aracı)

Slice Tool 
(Dilim Aracı)

Hand Tool 
(El Aracı)

Zoom Tool 
(Yakınlaştırma Aracı)
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Vektörel programın arayüzünü, araç kutusunu ve menülerini inceleyerek 
geometrik şekil çizimleri yapınız.

•	 Vektörel programı, programın simgesine tıklayarak açınız.
•	 Programın araç kutusunu inceleyiniz. Piksel tabanlı programla benzer ve farklı 

yönlerini söyleyiniz.
•	 Piksel tabanlı programda olduğu gibi Ctrl+N veya Command+N kısayoluyla yeni 

bir belge açınız.
•	 Çizim araçlarını kullanarak geometrik şekiller çiziniz.
•	 Çizdiğiniz nesnelerle büyültme-küçültme, döndürme, çarpıtma, yansıtma, ço-

ğaltma, renklendirme, gruplama, taşıma gibi işlem denemeleri yapınız. 

2. ETKİNLİK

Vektörel programın üst kısmındaki menü çubuğunda bulu-
nan menüler ve bunların işlevleri  aşağıda açıklanmıştır.

File (Fayıl) / Dosya: Var olan bir belgeyi açma, yeni belge 
oluşturma, kaydetme gibi seçeneklerin yer aldığı menüdür.

Edit (Edit) / Düzenleme: Kesme, kopyalama, yapıştırma, 
renk düzenleme gibi işlemlerin yapıldığı menüdür.

Object (Objekt) / Nesne: Nesnelerle ilgili yapılacak işlemle-
re (gruplama, büyütme, küçültme, eğme, yansıtma, maske-
leme gibi) ulaşılan menüdür.

Select (Selekt) / Seçim: Seçimle ilgili ögelerin yer aldığı me-
nüdür.

View (Viv) / Görünüm: Yakınlaştırma, ön izleme gibi belge 
görünümü ile ilgili sekmelerin yer aldığı menüdür.

Window (Vindov) / Pencere: Araçlar, renkler, çalışma ala-
nı gibi program pencerelerine ulaşılan bölümdür. Örneğin 
bu menüde yer alan Tools (Araçlar) sekmesi işaretli değilse 
araç kutusu programın arayüzünde görünmeyecektir.

Help (Help) / Yardım: Programla ilgili sistemsel konuların 
yer aldığı menüdür. 
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Vektörel programda çalışılırken görüntü düzenleme prog-
ramında olduğu gibi öncelikle fotoğraflar programda açılır. 
Fotoğrafı programla aynı anda açabilmek için fotoğrafın 
üzerine farenin sağ tuşuyla tıklanarak “Birlikte Aç” komutu 
kullanılır. Fotoğrafı program açıldıktan sonra  açmak için 
ise fotoğrafın üzerinde farenin sol tuşu basılı  iken fotoğraf 
programa sürüklenir ya da programın üst menüsünden File 
> Open seçeneği kullanılır.

Fotoğraf, vektörel programda açıldıktan sonra Seçenekler 
çubuğunda bulunan Embed (embıd) seçeneğiyle fotoğraf 
programa gömülür. Bu işlem yapılmadan program kapatılıp 
tekrar açıldığında tasarımda kullanılan fotoğraf bilgisayar-
dan silinmişse ya da fotoğrafın konumu değiştirilmişse prog-
ram, bulamayacağı için açamayacaktır. 

Vektörel programda karakter tasarımı için iki farklı fotoğraf-
tan yararlanılarak yapılan örnek bir çalışmanın işlem basa-
makları şunlardır:

•	 Konuya uygun belirlenen fotoğraflar File > Open ya da 
yukarıda açıklanan diğer işlemler seçilerek programda 
açılır (Görsel 3.21, 3.22). 

Görsel 3.21: Fotoğrafın programla açılması Görsel 3.22: Fotoğrafın programla açılması
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Görsel 3.23: Threshold değeri 120 ve 80 seçilen görüntü arasındaki fark

•	 Bu uygulamada kaplan fotoğrafı, Seçenekler çubuğunda bulunan Live Trace > 
Simple Trace seçilerek vektörel hâle dönüştürülmüştür. Live Trace seçeneğinin alt 
menüsünde bulunan seçeneklerle fotoğrafa renk lekeleri, siyah beyaz, logo gibi farklı 
etkiler uygulanabilir. Fotoğraf tıklandığında seçenekler çubuğunda beliren Threshold 
değeri değiştirilerek lekelerin sıklığı ayarlanabilir (Görsel 3.23).

•	 Kaplan yüzünün yarısında kaplanın lekesel görüntüsü diğer yarısında da vektörel 
çizim uygulanmak istenildiği için araç kutusundaki Rectangle Tool kullanılarak çizilen 
dikdörtgenin içine kaplanın yüzünün yarısı maskelenmiştir (Görsel 3.24). Maskele-
me işleminde çizilen şeklin içi boyalı olmalı ve şekli maskelenecek alanın üstünde 

Görsel 3.24: Vektörel programda maskeleme işlemi
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olmalıdır. Şekil fotoğrafın altında ise farenin sağ tuşuyla tıklanarak Arrange > Bring 
to Front seçilmeli ve şekil maskelenecek fotoğrafın üstüne alınmalıdır. Daha sonra 
Selection Tool ile ikisi birden seçilerek Object > Clipping Mask > Make tıklanarak 
fotoğraf maskelenmelidir. Bu işlemin kısayolu Ctrl+7 veya Command+7’dir.

•	 Maskelenen görsel Ctrl+C veya Command+C ile kopyalanır ve diğer pencerede açıl-
mış olan fotoğrafa uygulanır. Çizimin büyüklüğünü ayarlamak için Selection Tool 
ile seçilen görsel, köşelerinde oluşan küçük karelerden tutularak ölçeklendirilebilir. 
Orantının bozulmaması için ölçeklendirme Shift tuşuna basılı tutularak yapılmalıdır. 
Küçük karelerin üzerinde beliren ok, eğri oka döndüğünde hafifçe döndürülerek okun 
yönü ayarlanabilir.  Çizimin alttaki görsele uyarlanması için seçenekler çubuğundan 
Expand (Ekspend) işaretlenir. Expand seçildikten sonra Direct Selection Tool ile 
noktalara müdahale edilerek görsel düzenlenir (Görsel 3.25).

Görsel 3.25: Vektörel programda maskeleme işlemi
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•	 Tasarımda vektörel çizim istenildiği için Görsel 3.26’daki gibi yüzün detaylarının çi-
ziminde Pen Tool kullanılmıştır. Pen Tool ile yapılan çizimler, başlangıç noktasına 
gelinerek tamamlanmalıdır. Her renk tonu için ayrı bir bölge çizilmelidir. Renk tonları 
için damlalık aracı Eyedropper Tool kullanılabilir. Fotoğraftaki renk kullanılmak isteni-
yorsa damlalık aracıyla istenen ton tıklanarak çizilen alana uygulanır. Çizilen alanlar, 
üst üste katman hâlinde olmalıdır. 

Görsel 3.26: Pen Tool ile çizim

•	 Görsel 3.27’de ayrı bölümler hâlinde çizilen gözün katmanlarının birbirinin altına ya 
da üstüne getirilmesi için Arange (Erınç) sekmesinin kullanıldığı görülmektedir. Her 
ton için ayrı alan oluşturulması, çalışmanın renklendirilmesinde ve renklere sonradan 
müdahale edilmesinde kolaylık sağlayacaktır.

•	 Çalışmaya Görsel 3.27 ve 3.28’de verilen aşamalarla devam edilir. Çizilen bölümleri 
tek parça hâlinde hareket ettirebilmek için seçilen nesneler Object > Group ile grup-
lanabilir. Nesne ya da alanlar Shift tuşu basılıyken farenin sol tuşu tıklanarak seçildik-
ten sonra farenin sağ tuşuyla açılan sekmeden Group sekmesi seçilerek gruplanır. 
Kısayolu Ctrl+G veya Command+G’dir. Direct Selection Tool ile gerektiğinde grup 
içindeki parçalara ya da çizimin noktalarına müdahale edilebilir. Grubun bozulması 
istendiğinde Shift+Ctrl+G kısayolu kullanılır.
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Görsel 3.27: Fotoğraf üzende vektörel çizim

Görsel 3.28: Birçok vektörel tekniğin fotoğrafa uygulanması
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•	 Çalışma bittiğinde File > Save As ile istenen formatta kayıt yapılabilir. Çalışma, 
JPEG formatında kaydedilmek isteniyorsa File > Export seçeneği kullanılmalıdır 
(Görsel 3.29, 3.30). 

Görsel 3.29: Çalışmanın kaydedilmesi
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Görsel 3.30: Çalışmanın son hâli



166 Bilgisayarda Fotoğraf

DİJİTAL İLLÜSTRASYON

3.1.8. Dijital Ortamda Karakter Tasarımının  Aşamaları
Karakter tasarımı hem pratik hem de her yerde yapılabilir bir çalışmadır. Bu nedenle sık-
lıkla tercih edilmektedir. Karakter tasarımı birçok farklı yöntemle yapılabilir. Çalışmaların 
programlar yardımıyla sonsuz büyütülebilmesi, kullanım alanlarının eşitlendirilebilmesi 
için çalışmalar vektöre çevrilir. Bunun için elle yapılmış çizimin fotoğrafı çekilebilir veya 
tarama cihazı yardımıyla çizim bilgisayara aktarılabilir. 

Bilgisayarda bulunan çizim programlarıyla çizimi renklendirmek son dönemlerde yaygın kul-
lanılan tekniktir (Görsel 3.31). Üzerinde daha fazla düzenleme yapılabilmesi ve tabletlerde 
çizim kalemlerinden yardım alınabilmesi nedeniyle çizim programları diğer yöntemlere göre 
daha kullanışlıdır. Klasik ve kullanılan yöntemlere benzer olsa da silme, yenileme, aktarma 
özellikleri düşünüldüğünde çizimin çizim programlarında yapılması daha uygundur. Çizim 
için ücretli yazılımlar olduğu gibi ücretsiz yazılımlar da mevcuttur. Bu yazılımların genel özel-
liği kalem ve kâğıtla çizim yapılıyormuş etkisi vermesidir. Birçok tasarımcı, tabletlerin her 
yerde model tasarımı yapabilme imkânı sunması nedeniyle bu yöntemi tercih etmektedir. 

Görsel 3.31: Dijital ortamda tasarlanmış karakterler
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Görsel 3.32: Dijital ortamda tasarlanan karakterler

Karakter tasarımına yeni başlayanlar, öncelikle karakteri oluşturan modelin ön yüz çalış-
malarını yapmalıdır. Daha sonrasında bu modelin çok yönlü kullanılabilmesi için model 
sheet oluşturulmalıdır (Görsel 3.32). Bunun nedeni hareketli karakter kullanımlarının ön, 
arka, yan gibi birçok yönden görünebilmesidir. 
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Görsel 3.33: Dijital ortamda tasarlanan karakterler

Görsel 3.33’te canlı ve cansız modellerden yola çıkılarak yapılan karakter tasarımları 
görülmektedir.
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2. UYGULAMA

UYGULAMA ADI	:	Çizimlerden Model Sheet Oluşturma
AMAÇ	 :	Model sheet fotoğraflarından çizim yaparak 
		  çizimleri model sheet sayfasına dönüştürmek.

Aşağıdaki işlem basamaklarını dikkate alarak model sheet fotoğrafların-
dan yapılan çizimlerle, model sheet sayfası oluşturunuz.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Vektörel tabanlı program
4.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Model sheet için daha önce çektiğiniz fotoğrafları karakter tasarımı yapmak 

üzere bilgisayara aktarınız. 
3.	 Fotoğrafı piksel ya da vektör tabanlı programlardan birini seçerek açınız.
4.	 Fotoğrafınızı programda açtıktan sonra Layer üzerinden kilitleyiniz.
5.	 Fotoğraflarınız üzerinden çizim araçlarını kullanarak bir karakter tasarımı 

yapmak için yeni bir Layer açınız.
6.	 Tasarımı yaparken öncelikle karakterin dış hatlarını oluşturunuz. 
7.	 Oluşturmuş olduğunuz dış hatları Layer üzerinde isimlendiriniz. 
8.	 Modelin iç hatlarının da çizimini yaparak işlemi tamamlayınız. 
9.	 İç hatlarınızı da isimlendirerek renklendirmeye hazır hâle getiriniz.
10.	Fotoğraf üzerinden uygun renk seçimlerini yaparak modelinizi renklendiriniz. 
11.	İşlemler bittikten sonra çiziminizi kaydediniz.
12.	Çiziminizi kaydettikten sonra bir sonraki fotoğrafa geçerek yukarıdaki işlem-

leri tekrarlayınız. 
13.	Çizim işlemleri bittikten sonra çizimlerden model sheet sayfası oluşturunuz.
14.	Çalışmanızı, kullandığınız programın formatında ve PDF olarak bilgisayara 

ve taşınabilir belleğe kaydediniz.
15.	Düzenleme işlemleriniz bittikten sonra taşınabilir belleğinizi çıkarınız. 
16.	Görüntü düzenleme programınızı ve bilgisayarınızı kapatınız.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygula-
ma çalışmanız, Ek 3’te verilen “2. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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3.2. DİJİTAL ORTAMDA MEKÂN TASARIMI
Dijital ortamda mekân tasarımı yapan kişiler, iş tanımında dijital arka plan çevre tasarım-
cısı olarak adlandırılır. Animasyon filmler, video oyunları, televizyon şovları, reklamlar 
gibi birçok alanda dijital karakterler için mekân tasarımı yapılmaktadır. Mekân tasarımı 
hayalî bir yaşam alanı oluşturmaktır. Çevre tasarımı için perspektif, mimari bilgi, topoğ-
rafya, coğrafya, peyzaj bilgisi oldukça önemlidir. Tasarlanan yaşam alanları, karakterin 
ruh hâlini ve kişilik özelliklerini yansıtmalıdır. Karakter üzerinden oluşturulan senaryoya 
uygun, sürdürülebilir çevre tasarımı, arka plan ve manzaralar oluşturulmalıdır. Tasarım-
lar uzay mekân ilişkisi ile perspektif kurallarına dikkat edilerek yapılmalıdır.

Görsel 3.34: Dijital mekân

Mekân tasarımında yeryüzü şekilleri ve mimari yapılar tasarlanırken detaylar göz ardı 
edilmemelidir. İç mekân ve dış mekân tasarımlarında, senaryoya uygun tasarım yapıl-
malıdır. Çalışmaya tasarlanacak mekân için fikir bulma aşamasından başlanmalıdır. 
Hangi model için nasıl bir mekân tasarımı yapılacağı, tasarlanacak karaktere uygun 
mekânın nasıl olması gerektiği fikir aşamasında belirlenmelidir. Fikir aşamasından sonra 
referans oluşturacak görüntüler, örnek olarak çalışma dosyası içerisine kaydedilmelidir. 
Mekândaki doku, renk, şekil hatta boyutlar gibi birçok ayrıntı referans görüntüler yardı-
mıyla  tamamlanabilmektedir (Görsel 3.34, 3.35). 
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Görsel 3.35: Dijital mekân tasarımları
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Görsel 3.36: Dijital mekân tasarımları

Görsel 3.36 ve 3.37’de dijital mekân tasarımları görülmektedir.
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3.2.1. Konuya Uygun Mekân Fotoğrafı Çekimi
Mekânların belli çizgi ve renkleri vardır. Dikkatli bakıldığında her bir yapının geometrik 
şekil, renk, perspektif gibi detayları barındırdığı görülecektir. Mimari yapılar, iç veya dış 
mekânlar oluşturulurken geometrik şekiller, renkler, düzen ve perspektif gibi konular dik-
kate alınır. Dijital ortamlarda var olan karakterler gibi mekânlar da gerçek hayatta var 
olan mekânlara benzemektedir. Mekân ve karakterler ne kadar hayalî ve ütopik olsalar 
da gerçeği andıran detayları barındırmalıdır. 

Mekân tasarımcısı, bu işi yapmaya başlamadan önce mimari konuları ve perspektifi 
araştırmalı, çalışmalarını yaparken bu konuları dikkate almalıdır. Dijital mekân tasarımla-
rında da mimari tasarımların kuralları geçerlidir. Mekân tasarımı yapacak kişi, ilginç iç ve 
dış mekânların fotoğraflarını çekebilir. Bazen çektiği tek bir fotoğraftan bazen de birden 
fazla fotoğraftan tek bir dijital mekân tasarımına kaynak oluşturabilir. Gerçeküstü mekân 
tasarımlarında fotoğraf üzerinde değişiklikler yapılarak nasıl görüneceği belirlenebileceği 
gibi eskizler yardımıyla da fotoğrafın nasıl olabileceği belirlenebilir.

Görsel 3.37: Dijital mekânlar
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3. UYGULAMA

UYGULAMA ADI	:	Dijital Mekân Tasarımına Uygun Fotoğraf Çekimi
AMAÇ	 :	Dijital mekân tasarımına uygun iç veya dış mekânın .
		  farklı yönlerden fotoğrafını çekmek.

Aşağıdaki işlem basamaklarını dikkate alarak dijital mekân tasarımı için 
fotoğraf çekimi yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Fotoğraf makinesi
3.	 Yardımcı ekipmanlar
4.	 Görüntü düzenleme programı 
5.	 Taşınabilir bellek

İşlem Basamakları
1.	 Fotoğraf atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital mekân tasarımlarını inceleyerek nasıl fotoğraflar çekmeniz gerekti-

ğini belirleyiniz.
3.	 Fotoğraf çekimi için uygun ortam bulunuz. 
4.	 Bulduğunuz ortamın ışık koşullarını kontrol ederek ortamı çekime uygun 

hâle getiriniz. 
5.	 İç veya dış mekânın en etkin görüldüğü açıları belirleyerek çekimlerinizi 

gerçekleştiriniz. 
6.	 Yapmış olduğunuz çekimi kontrol ederek fotoğrafların amacınıza uygun 

çekildiğinden emin olana kadar işlemi tekrarlayınız. 
7.	 Çekimleriniz sırasında planlı ve disiplinli olmaya dikkat ediniz.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 3’te verilen “3. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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3.2.2. Mekân Fotoğrafının Vektör Tabanlı Programda İşlenmesi
Dijital ortamda düzen ve uyum önemli unsurlardır. Oluşturulmuş olan karakter, uygun 
olmayan bir mekâna yerleştirildiğinde inandırıcılığını yitirecektir. Modele uygun bir mekâ-
nın oluşturulması bu açıdan önemlidir. Bu nedenle renk seçimleri ve mekân tasarımları 
karakterin kişiliğine uygun yapılmalıdır. Fotoğraftan hareketle yapılan mekân tasarımla-
rında ilk olarak çekilen fotoğraf, vektör tabanlı bir programa aktarılmalıdır (Görsel 3.38).  
Aktarıldıktan sonra öncelikle genel hatların belirlendiği bir çizim yapılır. Daha sonra çizim 
renklendirilir. Aktarılan fotoğrafta, iç mekân çizimi yapılacaksa mekânın çizgileri belirlen-
melidir. Objelerin derinlik algısına dikkat edilmeli, önde ve arkadaki nesnelerin yerlerine 
göre, en arkadaki nesneden çizim yapılmaya başlanmalıdır (Görsel 3.39).

Görsel 3.38: Dijital mekân için çekilmiş fotoğraf

Görsel 3.39: Fotoğraf üzerinden çizim yapılması
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Görsel 3.40: Fotoğraf üzerinden çizim yapılması

Çizim sırasında objeler, aşama aşama gruplandırılarak çalışılır. Böylelikle yer değişimleri 
daha kolay yapılabilir. Çalışma, vektör tabanlı olarak kaydedilir ve çalışma sırasında olu-
şabilecek aksaklıkların önüne geçmek için programın otomatik kayıt özelliği seçilir veya 
sıkça kayıt yenilenir. Çalışma tamamlandığında dosya vektör tabanlı kayıt formatında 
kaydedilir ve daha sonra kullanım alanına uygun dosya türü seçilerek tekrar kayıt yapılır 
(Görsel 3.40).
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4. UYGULAMA

UYGULAMA ADI	:	Çekilen Mekân Fotoğrafından Mekân Tasarımı Yapma
AMAÇ	 :	Dijital mekâna uygun yapılan fotoğraf çekimlerinden .
			   hareketle mekân tasarımı oluşturmak.

Aşağıdaki işlem basamaklarını dikkate alarak dijital mekân tasarımı 
yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Basılı veya dijital yayın organlarından dijital mekân tasarımlarını inceleyiniz. 
3.	 Basılı veya dijital yayın organlarından mekân tasarımınıza uygun bir fotoğ-

raf bulunuz ya da kendi çektiğiniz bir fotoğrafı seçerek bilgisayara aktarınız. 
4.	 Aktarmış olduğunuz fotoğrafın kopyasını başka bir alanda bulundurunuz.
5.	 Çalışma dosyanızda bir Layer daha oluşturarak çalışmanızı bu Layer üze-

rinde yapınız.
6.	 Fotoğraf üzerinden mekânın belirgin çizgilerini oluşturunuz. 
7.	 Çizgilerini oluşturduktan sonra yeni bir Layer’a çiziminizin kopyasını alarak 

renklendirmesini bu Layer üzerinde yapınız. 
8.	 Renklendirme işlemleri bittikten sonra modelinizi mekâna yerleştirerek bo-

yutunu ayarlayınız. 
9.	 Yapmış olduğunuz çalışmanın aşamalarını kaydediniz. 
10.	Planlı ve disiplinli çalışmaya dikkat ediniz. 
11.	Hazırlamış olduğunuz yeni dosyayı, paylaşmaya uygun kaydederek taşı-

nabilir belleğinize aktarınız.
12.	Yapmış olduğunuz çalışmayı sınıfta paylaşınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 3’te verilen “4. Derecelendirme Ölçeği”ndeki ölçütlere göre değer-
lendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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5. UYGULAMA

UYGULAMA ADI	:	Birden Fazla Mekân Fotoğrafından Tek Mekân 
		  Oluşturma 
AMAÇ	 :	Dijital mekâna uygun yapılan fotoğraf çekimlerinden .
		  yeni bir mekân tasarımı oluşturmak.

Aşağıdaki işlem basamaklarını dikkate alarak dijital mekân tasarımını 
yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Dijital mekân tasarımlarını inceleyerek fotoğrafları nasıl kullanmanız gerek-

tiğine karar veriniz.  
3.	 Birbiriyle uyumlu olabilecek birden fazla fotoğrafı birleştirmek üzere seçiniz.
4.	 Seçtiğiniz fotoğrafları görüntü düzenleme programına aktarınız. 
5.	 Aktarmış olduğunuz fotoğrafların kopyasını başka bir alanda bulundurunuz.
6.	 Çalışma dosyanızda bir Layer daha oluşturarak çalışmanızı bu Layer üze-

rinde yapınız.
7.	 Seçtiğiniz fotoğrafa uygun doku taşıma, kroplama, dekupe, efekt kullanımı 

gibi işlemlerle yeni bir mekân oluşturunuz.
8.	 Oluşturduğunuz yeni mekân üzerinde istediğiniz görünüme ulaştığınızda 

Layer’ları birleştirerek tek Layer oluşturunuz.
9.	 Çalışmanın görüntü düzenleme programında kullanılan kayıt formatını ve 

JPEG hâlini taşınabilir belleğinize kaydediniz. 
10.	Çalışmanızı sınıfta paylaşınız. 
11.	Çalışma sırasında planlı ve disiplinli olmaya dikkat ediniz.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygula-
ma çalışmanız, Ek 3’te verilen “5. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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3.3. EMOJİ VE İKON TASARIMI
İnsanoğlu tarih boyunca kendini ifade edebilmek için re-
sim çizmiştir. Kendini ve yaşananları resimlerle ifade etme 
biçimi zamanla şekil değiştirmiştir. İnternet kullanımının 
başlaması ve yaygınlaşmasıyla insanlar, duygularını an-
latabilmek için resim yapmak yerine birbirlerine resimler 
göndermeye başlamıştır. Resim göndermenin yaygınlaş-
ması ve büyük resimlerin gönderilmesinin zorluğu, anlatı-
mın daha küçük boyutlara indirilmesini gerektirmiş; böyle-
ce emoji ve ikon tasarımları ortaya çıkmıştır (Görsel 3.41).

3.3.1. Emoji Tasarımı
Mobil ve web tabanlı iletişim araçlarında mesajı tek bir ka-
rakter üzerinden yansıtmak için tasarlanan yüz, ifade veya 
nesnelere emoji denir. Emoji kelimesi Japonca ‘‘resim ve 
harf’’ kelimeleri birleştirilerek oluşturulmuştur. ‘‘E’’ resim, 
‘‘moji’’ harf anlamına gelmektedir. Emojiler, kişilerin ruh 
hâlini ya da içinde bulundukları durumu anlatmak için kul-
landıkları sembollerdir. Emoji, küresel veya yerel konuların 
yansıtıldığı tasarımlardan oluşabilir. Piktogramlar ve ide-
ogramlar da emoji olarak kullanılabilir. 

Telefon şirketleri, arama motorları ve birçok firma var olan 
tasarımlara kendi çizgilerini yansıtmakta ya da kendi emo-
jilerini kullanıma sunmaktadır. Son dönemlerde hareketli 
emoji tasarımlarının yanı sıra bu emojilerin kullanımı da 
artmıştır.

Görsel 3.41: Emoji örnekleri
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Emoji denildiğinde akla ilk gelen yuvarlak bir yüz, sarı renk ve 
ifadeler olsa da emojiler birçok farklı şekilde ve renkte yapı-
labilmektedir. En sık kullanılanlar sarı renk ifade emojileridir. 

Emoji tasarımı için genellikle vektör tabanlı programlar tercih 
edilmektedir. Vektörel programlar, kullanım alanlarının çeşitli-
liği ve çizim özelliklerinin daha gelişmiş olması nedeniyle daha 
kullanışlıdır. Öncelikle tasarlanmak istenen emoji için elle çizil-
miş bir taslak oluşturulabilir. Ardından taslak çizim, bilgisayar 
ortamında tamamlanarak renklendirilir (Görsel 3.42). Hazır 
şekilleri kullanarak daha düzgün hatlı çizimler yapılabilir. Şe-
killerden bir emoji yapılmak istenmiyorsa şekiller birleştirilerek 
yeni şekil de oluşturulabilir. 

Görsel 3.42: Emoji tasarımları

Emoji tasarımı yapmak için vektör tabanlı programda daire 
oluşturarak göz, burun, dudak çizilir. Renklendirmek için var 
olan renkler kullanılabileceği gibi rengi beğenilen görseller-
den damlalık aracıyla renk seçimi de yapılabilir. Emojilerin 
yüz ifadeleri referans olarak alınabileceği gibi fotoğraflardaki 
kişi ve hayvanların yüz ifadeleri de taklit edilebilir. Emojilerde 
genellikle yuvarlak hatlar kullanılır ancak kişi kendini yuvarlak 
hatlarla kısıtlamadan da tasarım yapabilir. Sosyal medya ve 
web sitelerinde kullanılan emojiler, genellikle emojileri kulla-
nan firmanın özelliklerini taşır. 
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Görsel 3.43: Emoji çalışma alanı

Görsel 3.44: Emoji çalışma alanı

Renk, çizgiler veya daha önceden var olan bir maskot, firma için oluşturulacak emoji 
tasarımında kullanılabilir. Bir emojinin hatları belirlendikten sonra aynı emoji üzerinden 
duygu durumları değiştirilerek emoji kullanıma sunulur. Emoji tasarımı yapmak için uy-
gulanması gereken işlemler şunlardır: 

•	 Kare çalışma alanı açılır (Görsel 3.43).
•	 Sarı iç renk  ve siyah dış renk seçilerek bir daire oluşturulur. Oluşturulan daire içeri-

sine Line Segment Tool ile çizgi şeklinde göz çizilir (Görsel 3.44).
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Görsel 3.45: Emoji çalışma alanı

•	 Line Segment Tool (Layn Segmınt Tuul) açılır alt menüsünden Arc Tool (Ark Tuul) se-
çilerek ağız çizilir. Ağız çizgisi Arc Tool ile iki taraflı çizilerek birleştirilebilir (Görsel 3.45). 
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•	 Burun çizimi, içi dolu veya içi boş daire Rectange Tool (Rektanggel Tuul) 
açılır alt menüsünden Ellipse Tool (Elips Tuul) ile yapılır (Görsel 3.46).

Görsel 3.46: Emoji çalışma alanı

•	 Yüzün daha dolgun görünmesi için göz altına çil görünümünde daire 
nokta çizimi, Rectange Tool açılır alt menüsünden Ellipse Tool ile çizilir. 
Emojide degradeli geçiş için Gradient işlem penceresinden Type seçe-
neğiyle  emojinin orta noktasından başlayarak ışık gölge etkisi verilir 
(Görsel 3.47, 3.48). 
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Görsel 3.47: Emoji çalışma alanı

Görsel 3.48: Emoji tasarımları
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6. UYGULAMA

UYGULAMA ADI	:	Emoji Tasarımı Yapma
AMAÇ	 :	Sosyal medya ve web sitesi kriterlerine uygun emoji .
		  tasarlamak. 

Aşağıdaki işlem basamaklarını dikkate alarak emoji tasarımı yapınız. 

Araç Gereç
1.	 Bilgisayar
2.	 Vektörel tabanlı program
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 Emoji tasarımlarını inceleyerek nasıl emojiler oluşturabileceğinize karar 

veriniz.  
3.	 Seçtiğiniz emojiye ve belirlediğiniz modelin karakterine uygun taslak 

çiziniz.
4.	 Vektör tabanlı programda tasarlayacağınız emojinin boyutuna uygun yeni 

belge oluşturunuz. 
5.	 Belge üzerinde hazır şekillerden faydalanarak ya da kendiniz çizim ya-

parak emojiyi oluşturunuz. 
6.	 Oluşturduğunuz şekil üzerine emojinin karakterini oluşturan detayları çiziniz.
7.	 Oluşturduğunuz emojinin renklendirme işlemlerini yapınız.  
8.	 Çalışmanızın yapım aşamalarını kaydediniz.
9.	 Hazırladığınız emoji tasarımını paylaşıma uygun kaydederek taşınabilir 

belleğinize aktarınız.
10.	Yaptığınız çalışmayı sınıfta paylaşınız. 
11.	Çalışma sırasında planlı ve disiplinli olmaya dikkat ediniz.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 3’te verilen “6. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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3.3.2. İkon Tasarımı
Bir uygulamayı nesneyi, biçimi, tek başına simgeleyen ve 
anlatan resimli grafik sembolüne ikon denir. Bu simgeler 
var olan nesneleri temsil edebileceği gibi, internet ortamın-
da kullanılan alan veya firmaların logoları gibi unsurları da 
temsil edebilir. İkonlar, nesnelerin hatları kullanılarak tasar-
lanabileceği gibi, tasarımcının yeni hatlar belirlemesiyle de 
oluşturulabilir. İyi tasarlanmış ikonlar üç ana kriterle değer-
lendirilir. Bunlar; biçim, estetik birlik ve tanınmadır. Yeni bir 
simge seti tasarlanırken bu özellikler dikkate alınmalı, birden 
fazla tasarım tek bir web sitesi için tasarlanacaksa devam-
lılık gözetilmelidir. Tek bir simge tasarımı için birkaç farklı 
tasarım yapılarak içlerinden en uygun olanı seçilmelidir. 

İkon, dikkat çekici olmasının yanı sıra anlaşılır olmalıdır. 
Genellikle küçük olarak kullanılan ikonlarda karmaşık görü-
nümden kaçınılmalıdır. İyi tasarlanmış bir ikonun en önemli 
özelliği basit ve anlaşılır olmasıdır. Küçük unsurların fazla 
kullanımı ikonun anlaşılmasını güçleştiriyorsa ikon sadeleş-
tirilmelidir. İkonlar, kullanıcının herhangi bir metne ihtiyaç 
duymadan anlatılmak isteneni anlayabilmesini sağlamalıdır. 
İyi tasarlanmış bir ikon, farklı yaş ve kültürden insanlar ta-
rafından da anlaşılabilir olmalıdır. Bununla birlikte kullanım 
alanına ve hedef kitleye uygun renk ve metafor seçimi yapıl-
ması, amaca uygun ikon tasarımı için önemlidir. 

İkon tasarımlarında detaylara ağırlık vermek yerine, basit-
leştirip belirginleştirme tercih edilmelidir. Ancak gereğinden 
fazla basitleştirerek nesneleri tanınmaz hâle getirmek de 
istenilmeyen bir durumdur. Gereğinden fazla renk kullan-
mak dikkatin dağılmasına neden olacaktır. Bu nedenle üç 
renkten fazla renk kullanımı tavsiye edilmemektedir. İkon 
tasarımında birden fazla nesne kullanılacaksa üslup birliği 
sağlanmalıdır. 

Kullanım alanı aynı olacak ikonlarda eşit boyut, çizgi kalın-
lığı, görsel ağırlık, detaylandırma, renk kullanımı gibi temel 
ögeler dikkate alınmalıdır. İkonlar arasındaki uyum, kulla-
nıcının algısını olumlu etkileyecektir. Kullanıcı, gördükleri-
ni anlamak ister. Özellikle ikon tasarımının yaygın olarak 
kullanıldığı internet sitelerinde kullanıcı standart görünüm-
lere alışkındır. Bu standart algıyı kırmak zordur. İkon tasarı-
mında standart görünüm yaratıcılığı sınırlar. Yapılan küçük 
değişiklikler, renk kullanımı ve çizgilerdeki değişimler ikon 
tasarımı için büyük farklar yaratabilmektedir. 
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İkonlar, markalar için tasarlanıyorsa markanın renklerini, 
logosunu ve stilini yansıtmalıdır. Diğer sitelerde kullanılan 
ikonlar, başka sitelerde de aynı amaç için kullanılmalıdır. 
Aksi takdirde kullanıcı tarafından kabul görmeyecektir. 
İkonlar, kullanım amacını yansıtmalıdır. Örneğin fotoğraf 
makinesi ekipmanlarının ikonları görüldüğünde sitenin fo-
toğraf makinesi, ürün satışları veya çekim siteleri akıllara 
gelecektir (Görsel 3.49). 

Görsel 3.49: İkon örnekleri
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7. UYGULAMA

UYGULAMA ADI	:	İkon Tasarımı Yapma
AMAÇ	 :	Belirlenen bir konuda ikon tasarımı oluşturmak. 

Aşağıdaki işlem basamaklarını dikkate alarak ikon tasarımı yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Vektörel tabanlı program
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız. 
2.	 İkon tasarımlarını inceleyerek nasıl ikonlar oluşturabileceğinize karar 

veriniz.  
3.	 Vektör tabanlı programda yeni belge oluşturunuz. 
4.	 Taslağınızdan faydalanıp oluşturmak istediğiniz ikona uygun çizim yapınız.
5.	 Çiziminizi yaparken hazır şekillerden kullanmak istediğiniz varsa yararla-

nabilirsiniz. 
6.	 Oluşturduğunuz şekil üzerine ikon karakterini oluşturan detayları çiziniz.
7.	 Oluşturduğunuz ikonu renklendiriniz. 
8.	 Renklendirdiğiniz ikonun boyutunu ayarlayınız. 
9.	 Çalışmanızın yapım aşamalarını kaydediniz. 
10.	Hazırladığınız ikon tasarımını paylaşmaya uygun kaydederek taşınabilir 

belleğinize aktarınız.
11.	Yaptığınız çalışmayı sınıfta paylaşınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 3’te verilen “6. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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A) Aşağıdaki cümlelerde parantez (...) ile boş bırakılan alanlara verilen     
     bilgiler doğru ise “D” yanlış ise “Y” yazınız. 

1.	 (...) Model sheet sayfası modelin her yönden görünümüdür.
2.	 (...) Karakter tasarımında vektör tabanlı programlar kullanılır. 
3.	 (...) Piksel tabanlı programlarda yapılan çalışmalar istenilen oranda büyü-       .

       tülebilir.
4.	 (...) Dijital karakter sadece çocuk kitapları için tasarlanmaktadır. 
5.	 (...) Dijital karakter tasarımında, var olan kişi ve nesneler referans olarak              .

	 alınır. 
6.	 (...) Karakter tasarımı yalnızca 3D olarak yapılır.

B) Aşağıdaki cümlelerde yer alan boşlukları uygun ifadelerle doldurunuz.

7.	 Tasarımı, sınırsız büyütmeye olanak sağlayan ................... tabanlı prog-
ramlardır.

8.	 Bilgisayar ortamında yapılan ................... tasarımların değiştirilmesi ko-
laydır.

9.	 Dijital mekân tasarımı yapan kişiler ................... tasarımcısı olarak adlan-
dırılır.

C) Aşağıdaki soruları okuyarak doğru seçeneği işaretleyiniz.

10.	Aşağıdakilerden hangisi Layer’ları grup yapmak için kullanılan        
kısayoldur? 

     A) Ctrl + A     B) Ctrl + G     C) Ctrl + J    D) Ctrl + N      E) Ctrl + S          

11.	Aşağıdaki programlardan hangisi karakter tasarımı için kullanılır?

		 A) Office 
		 B) Sunum 
		 C) Mesajlaşma 
		 D) Vektör tabanlı 
		 E) Video edit

12.	Aşağıdakilerden hangisi çalışmada yeni katman oluşturmak için 
kullanılan kısayoldur?

	 A) Ctrl + A     B) Ctrl + C     C) Ctrl + J    D) Ctrl + N      E) Ctrl + R 

ÖLÇME VE DEĞERLENDİRME
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13.		Var olan bir çizimin programa atılarak üzerinden çizilmesi için 
aşağıdaki araçlardan hangisi kullanılır?

	 A) Magic Wand Tool 
	 B) Lasso Tool
	 C) Clone Samp Tool
	 D) Pen Tool 
	 E) Polygonal Lasso Tool 

14.		Yeni belge açma seçeneği aşağıdaki menülerden hangisinde yer 
alır?

	 A) File                             B) Help                        C) Object
	                 D) View                         E) Window

15.		Programla ilgili sistemsel sorunlar için aşağıdakilerden hangisi 
kullanılır?

	 A) Edit                             B) Help                        C) Object
	                 D) Select                       E) Window 

16.		Aşağıdakilerden hangisi seçimle ilgili ögelerin olduğu menüdedir?

	 A) Help                            B) Object                     C) Select
	                 D) View                         E) Window 

Ç) Aşağıda verilen soruların cevaplarını boş bırakılan yerlere yazınız.  

17.	Günümüzde emojinin yaygın olarak kullanılmasının etkilerini  
örneklendirerek açıklayınız. 

…………………………………………………………………………………
……………………..….………………………………………………………
……………………………………………..…….……………………………
……………………………………………..…….……………………………

18.	İkon kullanımının sektörel bazda etkilerini örneklendirerek açıklayınız. 

…………………………………………………………………………………
……………………..….………………………………………………………
……………………………………………..…….……………………………
……………………………………………..…….……………………………

ÖLÇME VE DEĞERLENDİRME
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1. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı. 

2. Model sheet fotoğraflarını nasıl çekeceğini belirledi.

3.
Belirlemiş olduğu fotoğraf çekimi için uygun ortamı 
hazırladı.

4.
Modelin dönüş yerlerini ve açılarını belirleyerek 
işaretledi.

5. Modelin konumuna göre ışıkları ayarladı.

6. Fotoğraf çekimi için gerekli düzenlemeleri yaptı.

7. Modelin farklı açılardan fotoğraflarını sırayla çekti.

8.
Fotoğraf ekipmanlarını düzenli ve zarar görmeyecek 
şekilde kaldırırdı.

9. Stüdyo kurallarına uydu.

10. Fotoğrafları bilgisayara aktardı.

11. Fotoğraflar üzerinde gerekli düzeltmeleri yaptı.

12. Fotoğrafları model sheet sayfasına uygun yerleştirdi.

13.
Çalışmasını uygun formatta taşınabilir belleğe 
kaydetti.

14. Bilgisayar atölyesi kurallarına uydu. 

15. Süreyi planlı ve verimli kullandı.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 15 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 75’tir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (75x100)/75=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz yeter-
li demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-3
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2. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı.

2.
Düzenleme yapılacak konuya uygun fotoğraflar 
belirledi.

3. Düzenleme yapacağı fotoğrafları bilgisayara aktardı.

4. Uygulamayı yeni bir Layer üzerinde yaptı.

5. Fotoğraflar üzerinden çizimle karakter tasarımı yaptı.

6. Karakterin dış hatlarını oluşturdu.

7. Karakterin iç hatlarını oluşturdu.

8. Dış ve iç hatları renklendirdi.

9. Model sheet için tüm fotoğrafların çizimlerini tamamladı.

10.
Model sheet sayfasında çizimleri yönlerine göre ayar-
ladı.

11.
Çalışmayı seçmiş olduğu programın dosya formatında 
kaydetti.

12. Bilgisayarı zarar görmeyecek şekilde kapattı.

13. Süreyi planlı ve verimli kullandı.

14. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 14 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 70’tir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (70x100)/70=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.
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3. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 
hazırladı.

2. Dijital mekân tasarımlarını inceledi.

3.
Dijital mekân tasarımlarını dikkate alarak çekeceği 
fotoğrafları belirledi.

4. Belirlemiş olduğu fotoğraflar için uygun mekânı buldu.

5. Fotoğraf çekimi için mekânı hazırladı.

6.
Fotoğraf çekimi için mekânda gerekli ışık ayarlamalarını 
yaptı.

7.
İç ve dış mekânın en etkili açılarını belirleyerek 
fotoğraflarını çekti.

8.
Fotoğraf ekipmanlarını, düzenli ve zarar görmeyecek 
şekilde kaldırdı.

9. Fotoğraf çekim yerini düzenledi.

10. Fotoğrafları bilgisayara aktardı. 

11. Süreyi planlı ve verimli kullandı.

12. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 12 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 60’tır.
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (60x100)/60=100
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-3
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EK-3

4. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 

gerecini hazırladı.

2.
Farklı kaynaklardan dijital mekân tasarımları ince-
ledi.

3.
Dijital mekân tasarımlarını dikkate alarak hangi 
fotoğrafları kullanacağını belirledi.

4.
Düzenleme yapacağı fotoğrafları bilgisayara ak-
tardı.

5. Fotoğraf üzerinde mekânın belirgin çizgilerini çizdi.

6.
Yeni Layer üzerinde mekânın renklendirmesini 
yaptı.

7. Çalışmasının ham dosya hâlini bilgisayara kaydetti.

8. Gerekli düzenlemeleri yaparak Layer’ları birleştirdi.

9. Çalışmasını taşınabilir belleğe kaydetti.

10. Taşınabilir belleği koşullara uygun çıkardı.

11. Programı zarar görmeyecek şekilde kapattı.

12. Bilgisayarı zarar görmeyecek şekilde kapattı.

13. Süreyi planlı ve verimli kullandı.

14. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 14 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 70’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (70x100)/70=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.
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5. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-

cini hazırladı.

2.
Farklı kaynaklardan dijital mekân tasarımları incele-
di.

3.
Dijital mekân tasarımlarını dikkate alarak hangi 
fotoğrafları kullanacağını belirledi.

4. Düzenleme yapacağı fotoğrafları bilgisayara aktardı.

5. Yeni Layer üzerinde çalışmaya başladı.

6.
Seçtiği fotoğrafa uygun işlemlerle yeni bir mekân 
oluşturdu.

7. Çalışmasının ham dosya hâlini bilgisayara kaydetti.

8. Gerekli düzenlemeleri yaparak Layer’ları birleştirdi.

9. Çalışmasını taşınabilir belleğe kaydetti.

10. Taşınabilir belleği koşullara uygun çıkardı.

11. Programı zarar görmeyecek şekilde kapattı.

12. Bilgisayarı zarar görmeyecek şekilde kapattı.

13. Süreyi planlı ve verimli kullandı.

14. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 14 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 70’tir.
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (70x100)/70=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-3
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6. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gerecini 

hazırladı.

2.
Farklı kaynaklardan emoji tasarımları inceleyerek nasıl bir 
çalışma yapacağını belirledi.

3. Emoji tasarımı için taslak çizdi.

4.
Vektör tabanlı programda emoji boyutuna göre yeni belge 
açtı.

5.
Belge üzerine hazır şekillerden ya da çizim araçlarıyla  
emoji dış hattını çizdi.

6. Emojinin karakterine uygun yüz detaylarını çizdi.

7. Emoji renklendirmesini yaptı.

8.
Çalışmasının yapım aşamaları için çalışmasını program 
formatında kaydetti.

9. Layer’ları birleştirerek tek bir dosya hâline getirdi.

10. Çalışmasını taşınabilir belleğe kaydetti.

11. Taşınabilir belleği koşullara uygun çıkardı.

12. Programı zarar görmeyecek şekilde kapattı.

13. Bilgisayarı zarar görmeyecek şekilde kapattı.

14. Süreyi planlı ve verimli kullandı.

15. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 
4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 15 ölçüt bulunmaktadır. Ölçekten alına-
bilecek en yüksek puan 75’tir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (75x100)/75=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz ye-
terli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-3
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7. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 

gerecini hazırladı.

2.
Farklı kaynaklardan ikon tasarımları inceleyerek 
nasıl bir çalışma yapacağını belirledi.

3. İkon tasarımı için taslak çizdi.

4.
Vektör tabanlı programda ikon boyutuna göre yeni 
belge açtı.

5.
Hazır şekiller ya da çizim araçlarıyla ikon dış hattı-
nı çizdi.

6. İkon tasarımının detaylarını çizdi.

7. İkonun renklendirmesini yaptı.

8. Çalışmasını program formatında kaydetti.

9. Layer’ları birleştirerek tek bir dosya hâline getirdi.

10. Çalışmasını taşınabilir belleğe kaydetti.

11. Taşınabilir belleği koşullara uygun çıkardı.

12. Programı zarar görmeyecek şekilde kapattı.

13. Bilgisayarı zarar görmeyecek şekilde kapattı.

14. Süreyi planlı ve verimli kullandı.

15. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 15 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 75’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (75x100)/75=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-3



4. 
ÖĞRENME

BİRİMİ

SOSYAL MEDYA



HAZIRLIK ÇALIŞMALARI

KONULAR TEMEL KAVRAMLAR

NELER ÖĞRENECEKSİNİZ?

4.1.	SOSYAL MEDYADA İÇERİK .
	 PAYLAŞIMI
4.2.	BANNER TASARIMI
4.3.	SOSYAL MEDYA 
	 KANALLARIN SEÇİLMESİ

•	 Sosyal medya
•	 Hedef kitle
•	 Banner
•	 Sosyal medya kanalları

•	 Hedef kitleye uygun slogan seçimi yapma
•	 Sosyal medya kanallarına uygun Banner tasarımı 
	 yapma
•	 Farklı sosyal medya kanallarını tespit etme
•	 Sosyal medya kanallarına uygun font seçimi yapma

1.	 Sosyal medyanın kullanım alanlarını örneklendirerek açıklayınız. 
2.	 Sosyal ağlar yaşam biçiminizi nasıl değiştirdi? Örneklendirerek açıklayınız. 
3.	 Son yıllarda kullanımı artan sosyal ağ sitelerini örneklendirerek açıklayınız.
4.	 Sosyal ağ sitelerinde ne gibi içerik paylaşımları yapılmaktadır? 
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Sosyal medya; iletişim, etkileşim, içerik paylaşımı ve iş bir-
liğine dayalı web siteleri ile uygulamaların tümü için kullanı-
lan bir terimdir. Bireysel kullanıcılar; arkadaş, aile ve sosyal 
çevreleriyle iletişimi sağlamak için bu uygulamalar ile web 
sitelerini kullanır (Görsel 4.1). Firmalar ise ürünlerini pazar-
lamak, bilinirliğini artırmak, statülerini korumak ve müşteriyle 
iletişim sağlamak için sosyal medyadan yararlanır. Sosyal 
medya kullanımının artması sadece içerikleri değil, insanla-
rı da farklı etkilemeye başlamıştır. Bu etki; yapılanları pay-
laşma, paylaşılanları daha güzel ve alımlı gösterme, güncel 
tarzları kendi paylaşımlarıyla daha geniş kitlelerle paylaşma 
isteğinden kaynaklıdır. Paylaşımlar sonucunda tüm düşün-
celer, gidilen yerler, yenilen yemekler gibi unsurlar, sosyal 
medya yoluyla görünür olmaktadır. Firmalar için de aynı du-
rum geçerlidir. Sosyal medyada yer almayan firmalar daha 
az tercih edilmektedir. Ürün talepleri; kullanıcı önerileri ve 
ürün etiketlemeleri sayesinde şekillenmektedir. Tercih edil-
mek isteyen firmalar, artık kurumsal kimliklerinin yanı sıra 
dijital kimliklerini de oluşturmak zorundadır. 

Görsel 4.1: Sosyal medya

Kurumsal marka; bir şirketi tanımlayan (kimliğini tanıtıcı, 
tanımlayıcı) kişi, grup ve diğer kurumların bu marka hak-
kındaki düşünce yapılarında oluşan imajlarının bütünüdür. 
Kurumsal markalaşmada sosyal medya, markanın değeri-
nin artırılması için önemli bir unsur olup kurumsal iletişimi 
desteklemek amacıyla kullanılmaktadır. Özellikle sosyal ağ 
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siteleri, kurumsal markalar açısından avantajlar sağlar ve 
markaların müşterileriyle etkileşimini önemli derecede artı-
rır. Sosyal medyanın kurumsal markaya sağladığı en önemli 
fayda, marka ve tüketiciler arasındaki etkileşimi destekle-
mesi ve hedef kitleye kolay ulaşabilme imkânı tanımasıdır. 
Kurumsal markalar, sosyal medya yol haritalarını oluşturur-
ken Görsel 4.2’deki ögelerden yararlanır. Sosyal ağ siteleri; 
rekabetçi piyasa koşullarında avantaj sağlayan, düşük mali-
yetli ve yüksek kalitede marka iletişimi ve bu iletişimi geliştir-
me imkânı sağlayan ortamlardır.

Görsel 4.2: Markalaştırmayı oluşturan ögeler

Hedef Yenilik Strateji Pazarlama  Hikâye  Reklam Farkındalık Kalite Bağlılık

MARKALAŞTIRMA

İşletmeler için vazgeçilmez bir unsur olan sosyal medya; 
kullanıcıların görüş ve beklentilerini, tercih ettikleri ürünleri 
ve bu ürünler hakkındaki yorumlarını müşteri memnuniye-
tini artırmak için de kullanır. Bu durum izleme ve ölçme için 
daha doğru verilere daha kısa sürede ulaşmayı sağlar.
 
Günlük yaşamdaki alanlar gibi sosyal medya alanları da 
farklı kullanıcıların farklı siteleri kullandığı sosyal mecralara 
dönüşmüştür. İnsanlar, sosyal hayatı içerisinde kendini ait 
hissettiği alanlarda daha fazla kalarak kendi yerleşik yaşa-
mını ve alanını oluşturmaktadır. Bu alan zamanla değişebi-
lir. Sosyal medya kullanımı da sosyal hayatın yansımasıyla  
şekillenmektedir. Kullanıcılar yaş, cinsiyet, ortak ilgi alanları 
ve günlük hayatta kullanılan fiziki alanlar gibi birçok etken 
nedeniyle aynı sosyal medya alanlarını kullanmaya başla-
yabilir. Bu kullanım zaman içerisinde değişiklik gösterebilir. 
Sosyal medya alanlarını kullanmanın yanı sıra kişiler o alan-
da kendi çevrelerini oluşturur. Bu çevre; toplumsal ve kişisel 
özelikler, kültürel farklılıklar, ilgi alanları, fiziki ve sosyal çev-
re gibi birçok farklı nedenle oluşabilir.  
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4.1. SOSYAL MEDYADA İÇERİK PAYLAŞIMI 
Sosyal medya, dünyanın her yerinden kullanıcılara en kısa sürede ulaşabilmeyi sağ-
layan platformdur. Sosyal medya kullanımı kişilere göre farklılık gösterse de zamanla 
uygulamalar popüler hâle gelir ve böylece kitlesel olarak sosyal medya kullanımı artar. 
Kişi ve firmalar sosyal medyada var olmak için bu platformları kullanma ihtiyacı duyar. 
Firmalar, müşteri kitlesini dikkate alarak hangi platformlarda yer alıp almayacaklarına 
karar vermelidir (Görsel 4.3).

Görsel 4.3: Sosyal medya kullanan bir kitle

Sosyal medyanın özellikle kişiler için fayda ve zararları tartı-
şılan bir konudur. Sosyal medyanın faydaları şunlardır:

•	 Kişilerin görünür olmasını sağlar. 
•	 İş ve ürün pazarlamada kolaylık sunar. 
•	 İzleyici kitlesi oluşturma imkânı tanır.
•	 Hızlı ve kolay iletişim sağlar.
•	Daha geniş kitlelerle etkileşim içinde olabilmeyi sağ-

lar.

Sosyal platformlar, kişiler için yeni iletişim alanları ve sosyal 
çevre oluşturmaktadır. Fikirler veya oluşturulmuş içerikler 
daha fazla kişiye ulaşabilmektedir. Girişimci ve sanatçıların 
oluşturdukları içerikler de geniş hedef kitlesine ulaşabilmek-
tedir. Sosyal medya alanının herkese açık olması, kişiler 
arasında bulunan sosyal statülerin devre dışı kalması ve 
herkesin popülerliğinin artabileceği bir alan olması sebeple-
riyle sosyal medyada daha fazla kişi kendini göstermek için 
çalışmaktadır. Sosyal medya; firma veya kişiler için aracıla-
rın ortadan kaldırıldığı ve direkt hedef kitleye ulaşılabildiği 
bir ortamdır. Hedef kitle ve müşteri yorumlarıyla ürün veya 
paylaşımlar geliştirilebilmektedir. 
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Sosyal medyanın olumlu görülen taraflarının yanı sıra özellik-
le kişileri etkileyen olumsuz tarafları da bulunmaktadır. Sos-
yal medyanın olumsuz özelliklerinden bazıları şunlardır:

•	 Kişilerin sosyal medya bağımlılığı 
•	 Kutuplaşmış ortamlarda kişinin kendini ifade edememesi 

ve kişiler arasında tartışmalara yol açması
•	 Fiziksel yapısından rahatsızlık duyanların uygulamalarda 

filtreler kullanarak farklı görüntüler elde edebilmesi nede-
niyle, kişilerin kendisini farklı gösterme çabasının  psiko-
lojik durumlarında sıkıntılara yol açması 

•	 Güvenlik açıklarının oluşması sebebiyle kişinin hak ve 
hürriyetlerinin zarar görmesi 

•	 İnsanların; sosyal medyada daha aktif olmaları, güncel 
hayatlarında ise yalnızlık çekmeleri sebebiyle tükenmişlik 
sendromu yaşamaları 

•	 Firma çalışanlarının kişisel davranışlarının firmalara mal 
edilerek markaların karalanması 

•	 Çok sayıda rakip firma olması nedeniyle kazançlarda dü-
şüş yaşanması

Sosyal medya platformları fotoğraf, video, görsel, ses dosya-
ları gibi birçok farklı türde paylaşıma olanak sunar. Bazı uy-
gulamalar tek bir dosya türüyle paylaşıma izin verse de artık 
tüm uygulamalar birçok dosya türünü desteklemektedir. Sı-
nırların ortadan kalktığı sosyal medya alanında herkes payla-
şım yapabilmekte ve bu paylaşımların izlenme sayısı sonraki 
içerikleri etkilemektedir. Birçok uygulama veya platformda ta-
kip etmek, paylaşım yapmak ya da iletişimde bulunmak için 
mesaj gönderme gibi seçenekler mevcuttur. Bu seçenekler, 
platformun kullanım amacına göre şekillenmektedir. Sosyal 
medya yönetimi, bireysel ya da kurumsal olarak yapılabilir. 
İzlenirliği artırmak ve sosyal medyayı aktif kullanmak için; ön 
hazırlık ve planlama yapmak, bütünsel düşünmek, renkleri 
doğru kullanmak, kitleyi anlamak, sosyal medya platformla-
rına uygun içerik üretmek, firma kullanıcı profili oluşturmak, 
günlük içerik paylaşmak, hedef kitle belirlemek gerekir.

4.1.1. Ön Hazırlık ve Planlama Yapmak
İçerik üretiminin tekrara düşmemesi ve düzenli olarak pay-
laşım yapılabilmesi için işletme tanıtımlarında kullanılacak 
fotoğrafların önceden çekilerek hazır bulundurulması işi ko-
laylaştıracaktır. 

Aynı tasarımla çekilen fotoğraflar, bir zaman sonra hedef kit-
leye sıkıcı gelebileceği için fotoğraf kurguları çeşitlendirilerek 
yapılmalıdır. Ürün ve firma tanıtımında kullanılabilecek fotoğ-
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İ LETMELER 
İçin Yenlikçi Çözümler

Yaratıcı Çözümler Üretmek

Programlama ve 
Web Tasarım

Yüksek Kalitede Çözümler Üretmek

Arama Motoru 
Optimizasyonu 

Mobil Uygulama
Geli tirme 

rafların da dekupe fotoğrafları çekilip bilgisayarda rötuş ve birleştirme işlemleri yapılarak 
yeni kurgular oluşturulabilir. Ürün, masaüstü fotoğrafçılığında çekilebilecek boyutlarda 
ise fotoğrafçı ile sosyal medya uzmanının yakın çalışması daha kısa sürede istenilen 
fotoğrafa ulaşmayı kolaylaştırabilir. Planlama yapılırken içerik sayısından çok, içeriğin 
etkileri düşünülmelidir (Görsel 4.4).

Görsel 4.4: Tasarım planlaması

4.1.2. Bütünsel Düşünmek
Kullanıcı, bir markanın istikrarlı olmasını ister. Yeniliğin yanı sıra klasikleşen parçaların 
olması, kullanılan logo ya da renklerin aynı standartta kalması müşterinin güvenini artırır 
(Görsel 4.5). Bu nedenle sosyal medya hesaplarında da aynı beklentiye girilmektedir. 
Paylaşıma bakıldığında paylaşım içinde markanın varlığı anlaşılmalı ancak aynı gönderi 
sürekli tekrar etmemelidir. Firma logosu, anlaşılır boyutta kullanılmalı ancak ekranda 
göze batmamalıdır. 

Görsel 4.5: Tasarımın bütünselliği

Logo 

Sıra Dışı 

Modem & Miniınalist 

Lorem ipsum dolar sit amet, consecte­
tuer adipiscing elit, sed diam nonummy 
nibh euismod tincidunt ut laoreet dolore 
magna aliquam erat volutpat. 

www.companyname.com 
• • 
• • 

web sayfası arayüzü 

• • 
• • 

Ana Sayfa Ürünler Koleksiyon Kurumsal İletişim 
--

• • 
• • 

lnstagram kare gönderi postu 1080x1080px 

Logo 

• • 
• • 

Kaliteli 

Modem & Minimalist 
Lorem ipsum dolar sit amet, consecte­

tuer adipiscing elit, sed diam nonummy 
nibh euismod tincidunt ut laoreet dolore 

magna aliquam erat volutpat. 

www.companyname.com 
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4.1.3. Renkleri Doğru Kullanmak
Renk; satın alma, izleme ve beğeni gibi dürtüleri harekete geçiren etkenlerden biridir. 
Doğru renk kullanımı, izlenme oranlarını artırırken renklerin yanlış kullanımı kişilerin ek-
randa kalma süresini kısaltmaktadır. Bu nedenle renk analizleri doğru yapılmalı, parlak 
renk tonlarından kaçınılarak daha yumuşak renk tonlarıyla izleyicinin ekranda kalma sü-
resi uzatılmalıdır. Bir firmanın kurumsal renk seçimi, sosyal medyaya uygun tercih edil-
memişse bu renk tonlarının daha yumuşak tonları kullanılabilir (Görsel 4.6).

Görsel 4.6: Reklamda renk seçimi

4.1.4. Kitleyi Anlamak
Hedef kitle ne kadar iyi anlaşılırsa içerik de o kadar uygun 
hazırlanabilir. Hedef kitlenin anlaşılabilmesi ve uygun payla-
şımların yapılabilmesi için sosyal medya sorumlusunun hedef 
kitlenin özelliklerini bilmesi ve hedef kitleyi anlaması gerekir. 
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Kitlenin anlaşılabilmesi, beklentilerinin öngörülebilmesi için 
sosyal medya sorumlusunun empatisi güçlü, iletişim beceri-
leri de gelişmiş olmalıdır. Böylece kitleyle etkileşim kuvvet-
lenebilir (Görsel 4.7).

Görsel 4.7: Kullanıcı kitlesi

4.1.5. Sosyal Medya Platformlarına Uygun   
          İçerik Üretmek
Firmaların görünürlüğünün artırılması için kullanıcılarının 
bulunduğu birçok platformda yer alması beklenir. Ancak bu 
platformların her biri ayrı bir yer olarak düşünülmelidir (Gör-
sel 4.8). Bir yerde yapılan paylaşımın kopyalanarak diğer 
sayfalara aktarılması, müşteriler üzerinde olumsuz bir etki 
bırakacaktır. Müşteri, platformda izleyici olarak takipte kala-
caksa ciddiye alındığını bilmek ister. Bu ise her bir platforma 
özel içerik üretimiyle mümkündür. Aynı fotoğrafın farklı tasa-
rımlarla hazırlanarak sunulması bile müşterinin göz alışkan-
lığının önüne geçecektir. Her yeni içerik, hedef kitleye değer 
sunmak anlamına gelmektedir. 

Görsel 4.8: Farklı platformlar için içerik tasarımı

Rekabet ortamı ve her 
gün artan paylaşım sa-
yıları markaların görü-

nürlüğü ve sosyal med-
yadan beklenen etkiyi 
azaltabilir. Etkiyi artır-
mak için doğru kişilere 
ve kurumlara tanıtım 

yapmak gerekir.

BİLGİ 
KUTUSU
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4.1.6. Firma Kullanıcı Profili Oluşturmak 
Sosyal medya platformları, kişi ve firmaların kullanıcı pro-
filleri oluşturarak o platformda dijital bir kimlik oluşturmala-
rını ister (Görsel 4.9). Bu dijital kimlik, şifre kullanımıyla kişi 
veya kurumlara özeldir. Bu durumda sadece şifreyi bilen ki-
şiler paylaşım yapabilir, paylaşılanlara yorum yapabilir veya 
diğer kullanıcılarla etkileşime girebilir. Kişisel kullanım için 
oluşturulan kullanıcı profillerinin yönetilmesi sadece kişiye 
ait olduğu için daha kolaydır. Ancak firma profili oluşturul-
duğunda yapılan paylaşımlar, firmanın sosyal kimliğini et-
kileyeceği için bu sayfaların yönetiminin düzgün ve düzenli 
yapılması sağlanmalıdır. 

Firmalar, paylaşım yapabilmek için sosyal medya hesabı 
oluşturmalıdır. Oluşturulan firma hesabı; kişi hesabından, 
şirket kurucusu veya yöneticiden farklı bir hesap olarak dü-
şünülmelidir. Bu hesapta, çalışanların sonraki dönemlerde 
değişebileceği göz önünde bulundurularak kişilerden ba-
ğımsız, firmayla ilgili paylaşımlar yapılmalıdır.

Görsel 4.9: Dijital kimlik

Firmalar artık sosyal kimliğin giderek önem kazanmasıyla 
en az bir kişiyi sosyal medya sorumlusu olarak çalıştırma-
ya başlamıştır. Böylece paylaşımlar tek bir elden ve düzenli 
çıkmaktadır. Şifreler ve yapılan sözleşmeler sadece bu ça-
lışanlarda olduğu için firmanın itibarını sarsacak paylaşım-
lardan onlar sorumlu tutulabilir. Bu nedenle paylaşım ya-
pılırken hassasiyet gösterilmektedir. Görevi sadece sosyal 
medya takibi olan kişiler çalıştırıldığında paylaşımlar, daha 
düzenli yapılabildiği gibi bu işi bilen kişilerce paylaşım yapıl-
ması da firmaya duyulan güveni artırmaktadır. 
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 4.1.7. Sosyal Medyada Günlük İçerik Paylaşmak
Sosyal medya, dijital günlüğün birçok dosya seçeneğiyle günlük hayata girmesi olarak 
düşünülebilir. Sosyal medya platformlarında paylaşımda bulunan firma ve kişiler, güne 
paylaşımla başlayıp günü paylaşımla bitirebilir. Son dönemlerde kişisel olarak kullanım 
yoğunluğu artan sosyal medyada firmaların da paylaşımları artmıştır. Bu artış, izleyicide 
ortaya çıkan yeni beklentilerle oluşmuştur. 

Birçok firma günlük paylaşım yaptırmak için en az bir çalışan görevlendirmeye başla-
mıştır. Sosyal medya uzmanlığı, içerik üreticisi gibi işler  artık firma ve kişiler için yeni bir 
çalışma alanına dönüşmüştür. Sosyal medya uzmanları, genellikle firmaların veya ünlü 
kişilerin paylaşımlarının kontrolünü sağlamaktadır. İçerik üreticileri;  kendi şahsi tanıtım-
ları için içerik üretenler, çalıştıkları firmalar için içerik üretenler olarak iki farklı şekilde 
değerlendirilebilir. İçerik üreticilerinin asıl hedefi, izleyenin ilgisini çekerek onları daha 
fazla ekranda tutmak, izleyenin içeriğe yakın hissedebilmesini sağlamaktır (Görsel 4.10). 
Bunun için de tasarım kurallarının bilinmesi, gündemin takip edilmesi, bölgesel özellikle-
re göre paylaşımlar yapılması gerekmektedir.

Görsel 4.10: Günlük içerik paylaşımı

4.1.8. Hedef Kitle Belirlemek 
Hedef kitle; sunulanı isteyen, buna ihtiyaç duyan insanların 
bütününe denir. Hangi alanlarda üretim yapıldığı ya da izle-
yici istendiği, üretimi yapan kişi veya kurumlarca bilinmekte-
dir. Firmalar için hedef kitle, ürünlerini satın alacak kişilerden 
oluşmaktadır. Ancak üretim yapılmadan önce potansiyel 
alıcı olarak görülen bir kesim de bulunmaktadır. Bu durum 
ürünün hedef pazarını oluşturur. Bazen bu pazarda sapma 
veya genişlemeler görülebilir. Örneğin erkek kullanıcılar için 
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üretilen bir parfüm, kadın kullanıcılar tarafından da ilgi görerek kul-
lanılmaya başlanabilir. Böylelikle hedef kitlenin yanı sıra kullanıcı 
profilindeki değişiklikle hedef kitle de genişlemiş olur. Bu genişleme-
yi gören üretici, bir sonraki ürününü piyasaya sunmadan önce hedef 
kitlesini genişletecek tasarımlar yaptırabilir.

Firmalar, yeni bir ürün piyasaya çıkarmadan önce pazar araştırması 
yaparak ne kadar kullanıcıya ulaşabileceğini öngörmek ister. Hedef 
kitle, ürünleri en çok tercih eden veya edebilecek kişilerin tümüdür. 
Hedef kitle belirlenirken göz önünde bulundurulması gereken bilgiler 
vardır. Yaş, konum, dil, ırk, harcama alışkanlıkları, ilgi alanları, eği-
tim durumu, meslek gibi etkenler hedef kitlenin belirgin özelliklerini 
ortaya çıkarır.

Birçok araştırma firması hedef kitleyi belirlemek için rakip ürünleri 
kimlerin satın aldığını ve ürünlerden duydukları memnuniyeti belir-
ler. Araştırma verileri güvenilir olmakla  birlikte hedef kitle değişebilir 
ve yeniden tanımlanabilir. Hedef kitle dinamiktir. Hedef kitle tanımı 
herkesi kapsamaz fakat geniş bir hedef kitle oluşturulabilir. Bu hedef 
kitle artabilir ya da azalabilir (Görsel 4. 11). Firmalar hedef kitlelerini 
tanımlarken daha büyük sayılardan söz eder. Fakat ürün kullanıcı 
sayısı bu sayının altında kalabilir. 

Görsel 4.11: Hedef kitle

Araştırmalar için genellikle panel şirketleri kullanılır. Firma, araştır-
mayı kabul eden kişiler arasından firmaların kitlesini belirleyen kri-
terler için ilk üç soruyu genellikle eleyici soru olarak kullanır. Bu so-
rular; hedef kitlenin cinsiyeti, kullanıcı yaşı, ürün gruplarından daha 
önce hangi ürünü tercih ettiği ile ilgili olabilmektedir. Anketi yanıtla-
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yan kişi, bu üç soruda hedef kitle içerisinde değilse teşekkür sayfasına yönlendirilir ve 
daha fazla soruyu cevaplaması istenmeden kendisine diskalifiye sistemi uygulanır. Ya-
nıtların kalitesiz olduğu veya yanıtlayanların kriterlere uymadığı düşünülüyorsa bu panel, 
firmalara bildirilmeli ve sorular güncellenmelidir. İyi tasarlanmış bir anket; müşterilerin ne 
istediğini, onları ürünleri satın almaya iten etkenleri ve pazarda rekabet avantajlarını or-
taya çıkarabilir. Yeni ürün ve hizmetleri piyasaya sürmek için rakip firmaların satışlarının 
ölçüldüğü araştırmalar başarı için kullanılabilir. Görsel 4.12’deki gibi kamp malzemeleri 
satışı yapan bir firmanın, outdoor (autdor) ve gezi dergileri gibi okuyucuların ilgisinin ol-
duğu yerlerde reklam vermesi ideal olacaktır.

Görsel 4.12: Reklam tasarımı

Piyasaya yeni ürün sürecek firmalar için birtakım sorularla ürünün satışını artıracak kriter-
ler belirlenebilir. Bu sorular şu şekildedir:

•	 Satın alma kararlarını aile fertlerinden kim veriyor? 
•	 Kullanıcılar, genelde ürünlerini nereden satın alıyor? 
•	 Belirli ürünleri ne sıklıkla alıyorlar? 
•	 Daha önce hangi ürünleri kullanıyorlarmış? Hangi rakip firmaları tanıyorlar?
•	 Ürün seçimi yaparken üründe ne gibi özellikler bulunmasına dikkat ediyorlar?
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Hedef kitlenin bilinmesi, reklamların ne şekilde yapılacağını belirler. Ürü-
nün tanıtımında hedef kitleye uygun renk ve konsept kullanımı ürünün 
daha fazla talep görmesini sağlayacaktır. Aynı zamanda hedef kitlenin 
belirlenmesi, reklamların nerelerde yayımlanacağına ve doğru medyanın 
belirlenmesine de yardımcı olacaktır. 
 
Hedef kitle belirlenirken ve ürün memnuniyeti ölçülürken anketler sıklık-
la kullanılmaktadır. Bu anketler genellikle araştırma firmaları aracılığıyla  
yapılır. Firmalar kendi internet sitelerinde, sosyal medya hesaplarında, 
mağaza veya sokakta anket düzenleyebilir. Sosyal medyada son dönem-
de sıklıkla kullanılan ürün değerlendirmeleri de kısa anketlere örnek ola-
rak gösterilebilir. Bu kısa anketler, kullanıcı istekleri analiz edilerek yeni 
ürünlerin tasarlanmasına veya en çok tercih edilen ürünlerin üretiminin 
artırılmasına etki eder. 

Firmalar için sosyal medya ve uygulamaların tasarımları analiz edilebi-
lir şekilde yapılır. “Kişiler internet sitelerinde hangi ürünlere daha fazla 
ilgi gösteriyor, hangi ürünleri favorilerine daha çok ekliyor?” ve “Hangi 
ürünleri paylaşarak arkadaşlarına tavsiye ediyor?” gibi soruların cevapla-
rı yapılan anketlerle alınabilir. Telefonlarda kullanılan birçok uygulamada, 
daha önce arama motorlarında aranmış konularla veya bir internet site-
sinde bakılan ürünlerle ilgili reklamlar kullanıcılara sunulmaktadır (Görsel 
4.13). Bu kişiler, yaptıkları aramalarla hedef kitle olarak görülmeye baş-
lanır. Potansiyel müşteri olarak görülen kişilere reklam ve satış firmala-
rı aradıkları ürünlere benzer ürünler sunulur. Bu sunum sayesinde kişi 
müşteriye dönüştürülebilir.

Görsel 4.13: Kullanıcı kitle
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1. UYGULAMA

UYGULAMA ADI	:	Sosyal Medyada Hedef Kitlesi Belirleme
AMAÇ	 :	Hedef kitleyi belirlemek.

Aşağıdaki işlem basamaklarını dikkate alarak okul tanıtımı için hazırlaya-
cağınız sosyal medya içeriğinin hedef kitlesini belirleyiniz.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Ofis programları
4.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Sosyal medya içeriğinde okulla ilgili paylaşacağınız bilgileri belirleyiniz.
3.	 Belirlediğiniz içerikle ilgili bilgilere uygun fotoğraflar hazırlayınız.
4.	 Bilgiler ve fotoğraflarla, tasarım programlarından birini kullanarak içeriğinizi 

hazırlayınız.
5.	 Hazırladığınız içeriğin hedef kitle kriterlerini belirleyiniz. 
6.	 Belirlediğiniz kriterlere uygun anket soruları hazırlayınız. 
7.	 Okulunuza yeni gelen öğrencilerden deneme grubu oluşturunuz.
8.	 Hazırladığınız anketi deneme grubunda bulunan öğrencilere uygulayınız.
9.	 Anket sonucunu yeni gelen öğrencilerin beklentileri açısından değerlen-

diriniz.
10.	Değerlendirmeniz sonucunda içeriğin hedef kitlenize hitap edip etmediğine 

karar veriniz. 
11.	Hedef kitlenin istekleri karşılanmıyorsa içeriğinizi tekrar gözden geçirerek 

yenileyiniz. 
12.	Yenilediğiniz içerik sonrası deneme grubunuza tekrar anket düzenleyiniz.
13.	Anket sonucu ve hedef kitle beklentilerini karşılaştırarak içerik değerlendir-

mesi yapınız.  

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 4’te verilen “1. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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4.1.9. Sosyal Medya İçin İçerik Üretimi 
Sosyal medya platformları, her gün yenilenmekte ve teknoloji geliştikçe bilgiye erişim 
hızı önem kazanmaktadır. Hızlı erişime alışan kişiler için ilginin uzun süre bir noktada 
kalması veya beklemek sorun teşkil etmektedir. Bunun nedeni çevrede oluşan ve de-
vamlı değişen görsellerin çoğalması, internet hızının günden güne artması, teknolojik 
gelişmeler sayesinde ulaşımın kısalması, ilgi duyulacak çok fazla ögenin çevrede yer 
almasıdır. Tüm bu değişime firmalar da ayak uydurmak zorundadır. Sosyal medyada 
içerik üretilirken dikkat edilmesi gereken unsurlar şunlardır:

•	 Günceli takip etmek, 
•	 Firmayı doğru yansıtmak, 
•	 Hedef kitleye hitap etmek, 
•	 Görüntü kalitesi ve görsel tasarım kurallarına önem vermek, 
•	 Video, fotoğraf veya ses içeriklerinde anlaşılır içerik oluşturmak, 
•	 Manevi değerleri dikkate almak,
•	 Özel gün ve haftalara uygun içerikler üretmektir. 

İçerik üretiminde internet siteleri, paylaşılan dosya formatlarına göre değişiklik gösterir. 
Blog, e-kitap, görüntü, video, video hikâye, canlı yayın, infografik, görüş ve inceleme 
yazıları ve duyurular bu duruma örnek gösterilebilir.

Görsel 4.14: Blog

Görsel 4.15: Vlog çekimleri

Blog, konuşma diline yakın bir üslupla yazılan metindir. 
Şirketler, güvenilirlik ve itibar oluşturmak için uzmanlık 
alanlarını blog aracılığıyla içten bir dille anlatabilir. Blog 
içeriklerinin sayıca fazla olması olumsuz bir özellik ola-
rak düşünülebilir. Kalıcı, güncel ve görünür kalabilmek 
için yazmak ve içerik oluşturmak önemlidir. İyi bir blog 
içeriği oluşturabilmek için içerik takvimi planlanmalıdır. 
İçerik takvimine göre işletme hakkında anlatılmak iste-
nilen hikâye ve bu hikâyelerin hangi zaman dilimlerinde 
yayımlanacağına karar verilir. İzlenme ve okunma oran-
larına göre içeriğin eylem planında değişiklik yapılabilir. 
Hedef kitle, sosyal medya sayfalarında veya elektronik 
posta yoluyla bilgilendirilerek yeni içeriğe yönlendirile-
bilir (Görsel 4.14).

Vlog, günlük video içeriği üretimidir. Son dönemlerdeki 
hızlı yaşam koşullarına ayak uyduran vlogların izlen-
mesi ve takip edilmesi daha kolaydır. Kişiler, günlük 
kısa videolarla yaptıkları aktiviteleri ya da günceli iz-
leyiciye sunar (Görsel 4.15). Vloglar ile belirli zaman 
aralıklarında, belirli konulara bağlı kalınarak içerik üre-
tilir. Böylelikle hedef kitlenin vloglara hızlı ulaşması ve 
vlogları takip etmesi kolaylaşır.

Podcast (Potkest), sayısal ses ve dijital medya 
ürünlerin internet üzerinden yayımlanmasıdır. Gele-
neksel radyo formatının dijitalleşmesi olarak tanım-
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lanabilir. Belirli konular üzerindeki sohbet veya anlatım-
lar ses kaydı yapılarak dinleyiciye sunulur (Görsel 4.16). 
Özellikle taşınabilir ses cihazlarıyla her yerde dinlenebil-
mesi kullanım kolaylığı sağlar. 

E-kitap, uzun ve ayrıntılı yazıların kitap tasarımı kullanı-
larak düzenlenmesi ve dijital olarak yayımlanabilmesidir 
(Görsel 4.17). E-kitap, blog yazılarına kıyasla daha fazla 
emek ve zaman istemektedir. E-kitap oluşturulurken ya-
zım yanlışı yapmamaya özen gösterilmeli ve kitap for-
matında çalışılmalıdır. E-kitaplar, tasarımcı ve yazarın 
iş birliği içinde çalışmasını gerektiren içeriktir. Firmalar 
daha fazla zaman ve emek gerektirdiği için genellikle bu 
içerikleri tercih etmez. Potansiyel müşteri oluşturmaya 
katkı sağlasalar da kişiler, gereğinden fazla zaman har-
cayacakları içerikleri okumaz. 

Görseller, çizim, fotoğraf, grafik gibi içeriklerdir. Gör-
sel içerik, makale ve bloglardan daha dikkat çekici ve 
algılanabilirdir (Görsel 4.18). Görsel sayısının fazla ol-
ması rekabeti artırmaktadır. Görseller, akıllı telefonlarla 
üretildiğinde maliyeti oldukça düşük olur. Sosyal medya 
platformlarında kaliteli görüntüler kullanılması müşterinin 
dikkatini çeker. Bu durum, akıllı telefonlarla elde edilen 
görüntülerden daha kaliteli görüntüler gerektirir. Ancak 
kaliteli görüntüler için profesyonel fotoğraf makineleri 
kullanılması maliyeti artırdığı gibi içeriğin yayımlanması 
için de daha fazla zaman harcanması gerekir. Akıllı te-
lefonlarla içerik üretilecekse telefon içerisine indirilen uy-
gulamalar sayesinde daha kaliteli efektler kullanılabilir. 
Bu uygulamaların bazıları ücretsizken bazılarına belirli 
bir ücret ödemek gerekir. 

Video, çekimleri ve canlı yayınlar, ürünleri sergilemek 
için sıklıkla tercih edilen yöntemlerden olmuştur (Görsel 
4.19). Akıllı telefonlarda kameraların kullanılmaya baş-
lanması video kullanımının da artmasına yol açmıştır. 
Tüketiciler, ilk zamanlarda kaliteli ürün beklentisi içindey-
ken ileri zamanlarda kullanıcılar tarafından oluşturulan 
gerçek kullanıcı görüntülerine ilgi duymaya başlamıştır. 
Özellikle kişiler tarafından çekilmiş daha amatör görün-
tüler ilgi uyandırmaya başlamış ve bu nedenle birçok 
firma, bireysel kullanıcılarla anlaşarak içerik üreticisi ça-
lıştırmaya başlamıştır. Sosyal paylaşım sitelerinde kulla-
nıcı videoları, daha çok ilgi görürken internet sitelerinde 
kullanılacak videoların daha kaliteli olması beklenir. Yük-
sek kaliteli videolar daha maliyetlidir. Video düzenleme 

Görsel 4.16: Podcast

 Görsel 4.17: E-kitap

Görsel 4.18: Fotomontaj

Görsel 4.19: Video               
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çalışmaları da profesyonel kişilerce yapılmalıdır. Video-
ların kısa süreli yayımlama, süresiz yayımlama ve canlı 
yayın gibi seçenekleri mevcuttur. Aynı zamanda videolar, 
sürelerine ve dosya formatlarına göre değişiklik gösterir.

Motion Graphics (Moşın Gırafiks), metin içeren ta-
nıtım animasyonlarıdır. Hareketli grafikler olarak da ta-
nımlanabilir. Tanıtılan ürüne derinlik katmak ve kişinin 
estetik duygusuna hitap ederek beğenisini kazanmak 
için kullanılan oldukça popüler bir yoldur. Hareketli grafik 
animasyonlarının normal videolardan farkı, görsel tasa-
rım unsurlarının daha yoğun kullanılmasıdır. Hareketli 
grafikler; grafik, illüstrasyon ve üç boyutlu modeller kulla-
nılarak oluşturulur. Reklamlar, video paylaşım siteleri, si-
nema ve dizi jeneriklerinde kullanılmaktadır (Görsel 4.20). 

İnfografikler, bilginin görsel olarak sunulmasıdır. Sa-
dece yazıyla verilen sayfalarca bilginin sadeleştirilip 
grafikler yardımıyla görselleştirilmesi, bilginin daha kısa 
sürede algılanmasını sağlar (Görsel 4.21). Günümüz 
dünyasında öğrenilecek çok fazla bilginin olması ve bu 
bilgilerin daha kısa sürede öğrenilmeye çalışılması gör-
sel hafızanın daha hızlı algılanmasıyla birleşmiştir. İn-
fografikler bir hikâye oluşturularak ve belirli sırayla ve-
rilmelidir. Tasarım, bu hikâye üzerine inşa edilir. Önemli 
görülen yerler, tasarımda dikkat çekici olmalıdır. Veril-
mek istenilen bilgi doğru kaynaklardan alınmalıdır. Tasa-
rım, hangi firma için hangi amaçla yapılıyorsa aktarılan 
bilgi de o yönde olmalıdır. Tasarım yapılırken tasarımcı 
tarafından bilgi özümsenmeli ve en kolay, en anlaşılır hâ-
liyle tasarlanmalıdır. Yaratıcı ve konuya uygun görseller 
ile etki artırılmalıdır. İnfografik çeşitleri şunlardır:

•	 Bilgi infografikleri, daha fazla yazının yer aldığı ve 
yazılar üzerinde vurgulamaların yapıldığı infografik 
türüdür. 

•	 Tarihsel infografik ise bir olayın kronolojik sırala-
mayla verilmesidir.

Görüş ve inceleme yazıları, kişilerin ürünler hakkında-
ki yorumlarıdır. Kişiler beğendikleri ürünleri başkalarına 
tavsiye ederken beğenmedikleri ürünlerle ilgili olumsuz 
eleştirilerde bulunabilmektedir (Görsel 4.22). Sosyal 
medya kullanımının artması ile bu görüşler daha fazla 
önem kazanmıştır. Kullanıcılar, sosyal medya hesapla-
rından ürün hakkındaki görüşlerini belirterek takipçilerine 
bu ürünlerle ilgili detaylı bilgi vermektedir. Beğeni kazan-
dıkça veya görüşlere talep arttıkça paylaşımlar çoğala-
rak devam etmektedir. 

Görsel 4.20: Hareketli grafik

Görsel 4.21: İnfografik

Görsel 4.22: Görüş ve inceleme
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İnceleme yazıları ise kullanıcıların ürünler hakkında de-
taylı görüşlerini içerir. Kişiler çoğu zaman bu yazıları 
kendi istekleriyle yazar; bazen de firma, yeni çıkan bir 
ürünün değerlendirilmesi için seçtiği kullanıcıları, ürün 
lansmanına göndererek inceleme ve yorum yazısı ta-
lep eder. İnceleme yazıları, son dönemlerde inceleme 
videolarına dönüşmüştür. Bu inceleme videoları, ürünü 
almayı düşünen kişilerin ön bilgisini artırmakta ve güve-
nilir kullanıcıların yorumlarıyla kişilerin tercihlerine yön 
vermektedir. 
 
Duyurular, firmayla ilgili indirim, kampanya, açılış gibi 
bilgilerden müşterilerin haberdar olması için yazılan bil-
gilendirme yazılarıdır. Duyurular genellikle dikkat işare-
tiyle yazı tasarımı görselleştirilerek verilir.  Duyuru tasa-
rımları, genellikle kırmızı gibi algıda dikkat çekebilecek 
renklerin kullanılmasıyla oluşturulur. Duyurular, büyük 
habere götüren başlıklar olarak düşünülmeli ve olayın 
gerçekleşmesinden önce yapılmalıdır (Görsel 4.23). An-
cak çok önceden başlatılan duyuru ilginin kaybolmasına 
sebep olur. Örneğin indirim duyurusu yapılacaksa duyu-
runun indirimin uygulanacağı günden birkaç gün önce 
yapılması, ilginin taze kalmasını ve daha fazla dikkat 
çekmesini sağlayacaktır. 
 
Yarışma, belirli bir konu hakkında düzenlenen ve birden 
fazla kişinin aynı şey için çabaladığı ve en az bir kaza-
nanın olduğu bir etkinliktir. Kazanma duygusu insanla-
rı her zaman mutlu eder. Bu kazanabilme dürtüsü ise 
ilginin artmasını sağlar. Promosyon olarak verilen ürün 
fikri de aynı mantıkla geliştirilmiştir. İnsanlara sebepsiz 
olarak verilen ürünler, o firma hakkında olumlu düşün-
meyi sağlamaktadır. Bu nedenle firmalar belirli aralıklar-
la ve özel günlerde yarışmalar düzenleyerek müşterinin 
ilgisini çekmektedir. Aynı zamanda satın alınan ürünlerin 
yanında küçük hediyeler gönderilerek olumlu pekiştirme 
yöntemiyle akılda kalıcılık sağlanmaktadır.

Markalar, marka değerlerini ve ürünlerinin satışını artır-
mak için reklam çeşitlerini kullanılır. Reklamın doğru kit-
leye, doğru zamanda sunulması insanların aklındaki kalı-
cılığı sağlamlaştırmaktadır. Rekabetin fazla olduğu ve her 
şeye ulaşabilmenin kolay olduğu bu zamanda algıların da 
sürekli değişmesi, firmaların işini zorlaştırmaktadır (Gör-
sel 4.24). Firmaların bu değişimi göz ardı etmemesi ve 
reklamları, kişilerin kullanım alışkanlıklarına göre şekillen-
dirmeleri gerekir.                                                             

Görsel 4.23: Duyurular

Görsel 4.24: Rekabet
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2. UYGULAMA

UYGULAMA ADI	:	 Dijital Platform İçin Firma İçeriği Üretme 
AMAÇ	 :	 Dijital platforma uygun içerik üretmek. 

Aşağıdaki işlem basamaklarını dikkate alarak firma ile ilgili sosyal medya 
için içerik üretiniz.

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı 
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Uygulamayı gerçekleştirebilmek için hayalinizde bir firma kurgulayarak 

firmaya isim veriniz.
3.	 Kurguladığınız firmanın yaptığı işi (hizmet alanını) ve hedef kitlesini belir-

leyiniz.
4.	 Firmayla ilgili ne tür paylaşımlar yapabileceğinizi kararlaştırınız.
5.	 Kurguladığınız firmayla benzer hizmet alanında yer alan gerçek firmaların 

paylaşımlarını analiz ediniz.
6.	 Gerçek firmaların daha önce yapmış olduğu paylaşımları inceleyiniz. 
7.	 Paylaşımların izlenme oranlarını ve hangi paylaşımların daha fazla beğeni 

aldığını kontrol ediniz.
8.	 En fazla beğeni alan içeriklere benzer, kurguladığınız firmaya uygun taslak 

içerik hazırlayınız.
9.	 Hazırladığınız taslağa uygun program, çekim veya düzenlemelerle içeriği-

nizi hazırlayınız. 
10.	Hazırladığınız içeriği paylaşıma uygun formata getiriniz.
11.	Hazırladığınız tasarımı yeni oluşturduğunuz bir sosyal medya hesabından 

paylaşınız.
12.	Yaptığınız paylaşımın beğeni oranını tespit ediniz.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 4’te verilen “2. Derecelendirme Ölçeği”ndeki ölçütlere göre 
değerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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4.2. BANNER TASARIMI
Banner (Benır); şirket ve diğer kuruluşların web sayfalarında göste-
rilen reklamlarıdır. Afişlerin, web sayfaları için uyarlanmış hâlidir. Bu 
reklamlar, hareketli veya hareketsiz olarak tasarlanabilmektedir. Bir-
çok web sitesinde banner için ayrılmış alanlar bulunmaktadır. Bu alan-
lar üstte, altta veya yanda olabilir. İnternet sitesi sahipleri, bu ayrılan 
alanları reklam panosu gibi kullanmaktadır. Bu alanlara firmalardan 
reklam alarak gelir sağlanabilmektedir. Reklam verenlerin amacı, tü-
keticiyi kendi internet sitelerine yönlendirmek, tüketicilere ürün ve şir-
keti hatırlatmaktır. Banner tasarımı, çevrim içi dünyada kullanılan en 
iyi reklam araçlarındandır (Görsel 4.25). Çevrim içi reklamcılıkta tasar-
lanan Banner’ın bir web sayfasına yerleştirilmesi gerekir. Banner, sa-
dece görsel olarak veya tıklanabilir formatta tasarlanabilir. Tıklanabilir 
yapıda olanlar, mevcut sayfadan reklam sayfasına gitmektedir.

Görsel 4.25: Banner tasarımları
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4.2.1. Sosyal Medya Kanallarına Uygun Yazı Karakteri Seçimi
Sosyal medya kanallarında paylaşım yapılırken dikkat edilmesi gereken birçok unsur var-
dır. Renk seçimi ve uyumu, paylaşılan görselin çözünürlüğü, kullanılan sloganların etkili 
olması bu unsurlara örnek gösterilebilir. Gözden kaçırılmaması gereken bir diğer husus 
ise yazı tipidir. Yazı tipi, tasarımda sadece bir özellik gibi düşünülmemelidir. Tüm tasarımı 
bir arada tutan ögedir. Yazı tipi seçimi, çok fazla alternatifin olması sebebiyle karmaşık ve 
kafa karıştırıcı olabilir.

Metinler, okunurken veya kelimelerinin gücü üzerine düşünülürken genellikle metnin yazı tipi 
düşünülmez. Metnin çok olduğu belgelerde okunabilirlik ön planda olurken yazının az oldu-
ğu tasarımlarda tipografi daha çok önem kazanır. Az metinli tasarımlarda tipografi sanatçısı, 
yazı karakterini tasarlarken kelimenin anlamı ve cümlenin vurgusunu dikkate alarak tasarım 
yapar.

Tipografi
Harfleri ve metni okunaklı ve net hâle getirmek, metni okuyucuya görsel olarak çekici 
kılmak için tasarlanan harf düzenleme sanatıdır. Tipografi tasarımı, belirli duyguları orta-
ya çıkarmayı ve belirli mesajları iletmeyi amaçlayan bir yapı ve yazı stili içerir. Kısacası 
tipografi, metne hayat veren tasarımdır.

Dijital çağdan önce tipografi; kitaplar, dergiler ve kamu işleriyle ilişkili özel bir zanaattı. Ti-
pografinin ilk örneği Batı’da Gutenberg İncil’inde görülmüştür. Gutenberg’in tasarımından 
sonra tipografide devrim yaşanmıştır. Bu devrim, internetin doğuşuyla birlikte tipografi 
sanatında yaratıcı bir patlamaya dönüşmüştür. Web tasarımcılarının ellerinde bol mik-
tarda yazı tipi ve yazı seçeneği vardır. Böylece kullanımı artan tipografi, görsel olarak da 
her zamankinden daha çeşitli hâle gelmiştir. 

Tasarımda iyi bir tipografi; güçlü ve görsel bir hiyerarşi oluşturur. Grafik dengesini sağlar ve 
ürünün genel hattını belirler. Tipografi; kullanıcıları yönlendirmeli, bilgilendirmeli, okunabilir-
liği ve erişilebilirliği en uygun hâle getirmelidir. Tipografide üç farklı yazı tipi vardır. Bunlar 
serif, sans serif ve dekoratiftir.

Serif yazı tipleri, harflerin sonundaki ekstra işaretlerle tanımlanır. Bu 
küçük vuruş ve ögelerin eklenmesi, serif yazı tiplerine bir gelenek, 
tarih, otorite ve bütünlük havası verir. Gazete başlıklarında veya ki-
taplarda kullanılan yazı tipinde bu “klasik” stil kullanılır.

Sans serif yazı biçimleri, uç kısımlarında çengel, çentik, çıkıntı bu-
lunmayan yazı tipidir. Serif yazı tipinin geleneksel vuruşları ve tireleri 
olmadan oluşturulur. Sans serif yazı tipi ailesi, daha modern ve cesur-
dur. Serif’in daha geleneksel vuruşları ve tireleri olmadan, sans-se-
rif yazı tipi ailesi çok daha modern ve cesurdur. Okunması kolaydır. 
Manşetlerde kullanıldığında seriflerden daha fazla dikkat çeker.

Dekoratif yazı tipi, okunabilir olmaktan çok estetiktir. Marka adların-
da, logo ve kısa başlıklarda kullanımı daha yüksektir. 

Aa
Aa
Aa
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Tipografinin Tasarımda Önemi 
Tasarımcı, tipografinin ne olduğunu ve tasarımda nasıl etkili bir 
şekilde kullanacağını bilmelidir. İyi bir tipografi seçimi yalnızca 
tasarımı güzelleştirmekle kalmaz. Göz alıcı yazı tipi, mesajı güç-
lendirir ve daha ikna edicidir. Bunun yanında ayrıca:

•	 Marka bilinirliği sağlar. 
•	 Karar vermeyi etkiler. 
•	 Okuyucuların dikkatini çeker.

Sosyal medya için içerik üretimi yapılırken tipografi kullanımında 
dikkat edilmesi gereken tasarım ögeleri vardır. Tasarımın dü-
zenli ve akıcı tutulması için, asla üçten fazla yazı tipi kullanıl-
mamalı ve dekoratif yazı tipleri minimumda tutulmalıdır. Sosyal 
medyanın getirdiği kısa dikkat süreleri sebebiyle, öz ve kullanı-
cıya gerekli bilgiyi kısa sürede iletecek tasarımlar yapılmalıdır. 
Tüm tasarımlarda olduğu gibi sosyal medya için üretilen tasa-
rımlar da belirli kurallar çerçevesinde hazırlanmalıdır. 

Hiyerarşi, tasarımın en hayati ilkelerinden biridir. Tipografik hi-
yerarşi, önce fark edilmesi ve okunması gereken önemli metin 
parçaları ile standart metin kopyası arasında net bir ayrım oluş-
turmayı amaçlar. Hiyerarşi; boyutlandırma, renk, kontrast ve hi-
zalama kullanılarak oluşturulabilir.

Zıtlık, hiyerarşi gibi iletilmek istenen fikrin veya mesajın okuyu-
cuya iletilmesine yardımcı olur. Çoğu tasarımcı, etki yaratmak 
ve sayfayı bölmek için çeşitli yazı tipleri, renkler, stiller ve boyut-
larla oynayarak kontrast oluşturur.

Tutarlılık, kafa karıştırıcı ve dağınık bir tasarımın önüne geç-
mek için yazı düzenleme işlemidir. Bilgi aktarırken aynı yazı tipi 
stiline bağlı kalmak önemlidir. Okuyucu okuduğunu anlar ve ile-
tilmek istenen mesajı alır.

Beyaz boşluk, negatif boşluk olarak adlandırılır. Metin ve gra-
fiklerin etrafındaki boşluklardır. Beyaz boşluğun doğru kullanımı, 
tasarımın düzenli olmasını ve metnin okunabilir olmasını sağlar.

Hizalama, her öge arasında eşit boşluk, boyut ve mesafe olma-
sını sağlamak için metin, grafik ve görüntüleri birleştirme işlemi-
dir.

Renk, tasarımda kullanılan en heyecan verici unsurlarından biri-
dir. Sosyal medya için üretilen tasarımlarda kullanılan tipografide 
sadece tek renk kullanılmamalı, tasarımın bütünü ve renklerin 
etkileri göz önünde bulundurularak farklı renkler de kullanılmalı-
dır. Yazı rengini doğru belirlemek, metnin öne çıkmasını ve me-
sajın daha kolay iletilmesini sağlar.
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4.2.2. Sosyal Medya Tasarımı İçin Doğru    
         Yazı Tipi Seçimi
Sosyal medya tasarımı için kullanılabilecek çok sayıda 
farklı yazı tipi vardır. Doğru seçimi yapmak, neyin gü-
zel göründüğünü görmekten çok daha fazlasına bağlıdır. 
Doğru yazı tipi seçebilmek için dikkat edilmesi gereken 
unsurlar şu şekilde sıralanabilir:

Marka ve Kullanıcıları Yansıtmak 
Kullanıcılar, tasarıma bakarken tasarımı kendilerine ya-
kın ve tanıdık hissetmelidir. Tipografi, markanın veya ürü-
nün kişiliğini yansıtmalıdır. Markanın temel özelliklerini 
tanımlamak ve bu özellikleri yansıtan yazı karakterlerini 
tasarımda denemek, tipografi seçimini kolaylaştırır. 

Mesaj İletmek
Ciddi ve önemli bilgiler iletilmek isteniyorsa hem açıkça 
okunabilen hem de dikkatin dağılmasını önleyecek daha 
az stilize veya dekoratif bir yazı tipi seçilmelidir.

Test Etmek
Tasarım için hangi yazı tipinin kullanılacağını en iyi an-
lamanın yolu test etmektir. Müşteri veya iş arkadaşların-
dan fikir alınabilir. Bunun yanı sıra daha önce yapılan 
tasarımlara verilen tepkiler de fikir verebilir.

4.2.3. Banner Tasarımı Hazırlama
Banner tasarımında, tasarımcılar belirli boyutlarda kalıp-
lar kullanmaktadır. Müşterinin isteği ve web sayfasının 
kullanım alanına göre boyutlar kişiselleştirilebilir (Görsel 
4.26). Sıklıkla kullanılan Banner boyutları 728x90 px, 
300x600 px, 300x250 px, 336x280 px’dir.

Banner reklam tasarımı yapılırken seçilen web sitesinin 
kullanılmak istenen alanının kullanılacak kısmı kadar ki-
ralama yapılmalı ve tasarımcıdan da bu boyutlara uygun 
tasarım yapması istenmelidir. Tasarımcı, Banner’ı ta-
sarlarken en çok tercih edilen boyutlara uygun tasarım 
yapabilir. Müşteri, asıl düşündüğü alandan farklı şekil ve 
boyutta, istediği zaman kullanabileceği tasarımları daha 
fazla beğenebilir. Bununla birlikte müşteri farklı boyutlar-
daki tasarımlara da ilgi gösterebilir. Böyle bir durumda 
internet sitesinden o boyuttaki kadar alan kiralamayı da 
düşünebilir. Diğer tasarım kuralları, Banner tasarımı yapı-
lırken de geçerlidir. Stok fotoğraf ve vektörlerin temin edil-
diği sitelerden de hazır Banner tasarımlarına ulaşılabilir.

Görsel 4.26: Banner tasarımları
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Görsel 4.27: Banner şablonları

Tasarım, doğru denge ve renk kullanımıyla oluşturulmalıdır. Marka bilinirliğinin artırıl-
ması için reklam verecek firmanın şirket logosu Banner’a eklenmelidir. Banner tasarımı 
sadece görsel olarak algılanmamalıdır. Reklam, müşterinin dikkatini çekecek bilgi içer-
meli veya müşteriyi tıklamaya itecek yapıda olmalıdır (Görsel 4.27, 4.28). Tıklamaların 
her zaman bir yere gitmesi beklenmese de yönlendirmeyle firmanın sitesine ya da ilgili 
ürüne gidilebilmesi firma için daha iyi bir seçenektir. Banner tasarımında dikkat çekicilik 
yakalanırken tasarım sadeleştirilmeli ve anlaşılırlığını korumalıdır. 

İnternet siteleri direkt yönlendirme yaptığında site tıklanmadan açılır. Reklam tüm sayfa 
olarak geldiğinde bu durum firmalar için antipati oluşturmaktadır. Firmanın güvenirliğinin 
korunması için reklamın verileceği sayfada, Banner yönlendirmeleri reklam vermeden 
önce kontrol edilmelidir. Reklamın verildiği alanın dışına tıklama yapıldığında yönlendir-
me olmamalı, Banner’ın çerçevesi daha önceden belirlenen oranlarda kalmalıdır. Rekla-
mın verileceği sitelere uygun tasarım yapılması müşterilere güven vermektedir. Banner 
tasarımında kelime kullanımı önemlidir. Kullanılan kelime sayısının azlığı, tasarımı ön 
plana çıkartarak ilgiyi artırır. Çizgisel yapısı farklı, okunabilir yazı tipi seçilmelidir. Tasarı-
ma uygun yazı tipi seçimi, Banner’ın bütünlüğünü korur ve ilgi çekiciliğini artırır. 

Görsel 4.28: Banner tasarımları
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3. UYGULAMA

UYGULAMA ADI	:	Banner Tasarımı Yapma
AMAÇ	 :	Belirlenen konuya uygun Banner tasarımı yapmak. 

Aşağıdaki işlem basamaklarını dikkate alarak Banner tasarımı yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Banner tasarımına uygun konu belirleyiniz. 
3.	 Belirlemiş olduğunuz konuya uygun Banner tasarımı yapabilmek için uy-

gun fotoğraflar çekiniz veya görseller bulunuz. 
4.	 Çalışmada kullanılacak fotoğrafların boyutlarının yüksek çözünürlüklü ol-

masına önem veriniz. 
5.	 Tasarlayacağınız Banner’ın boyutunu belirleyiniz.
6.	 Belirlemiş olduğunuz Banner’ın boyutuna uygun görselleri yerleştiriniz.
7.	 Gerekli yazı ve tasarımları yaparak Banner’ı paylaşıma hazır hâle getiriniz.
8.	 Banner’ın içerik ve tasarım yönünden uygun olduğundan emin olana kadar 

değişiklik yapmaya devam ediniz. 
9.	 Banner tasarımınızı tamamladıktan sonra web sayfası paylaşımına uygun 

formatta kaydediniz.

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 4’te verilen “3. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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4.3. SOSYAL MEDYA KANALLARININ 
       SEÇİLMESİ 
Sosyal medya kanalları kullanım amaçlarına göre ayrılmış-
tır. Sosyal medya platformları kurulurken hangi dosya for-
matlarının paylaşılabileceğine karar verilerek o formatları 
desteklemesi için gerekli yazılımlar oluşturulur (Görsel 4.28). 
Belirlenen formatlardan farklı formatlarda paylaşım yapma-
ya izin verilmez. Kullanıcı profili oluşturulurken site kuralları 
okunmalı ve sitenin getirdiği yükümlülüklere dikkat edilmeli-
dir. Bu tür sosyal platformlarda kullanıcı profilleri oluşturul-
duğunda o platformun kurallarının kabul edilmiş sayılacağı 
da unutulmamalıdır. Medya kanallarının hangilerinin kulla-
nılacağına karar verilirken amaçlar göz önünde bulundurul-
malıdır. Paylaşım yapılacak dosya formatları, platformların 
yükümlülükleri, kullanıcı profili gibi etkenler, hangi sosyal 
medya kanalının kullanılacağının belirlenmesinde etkilidir. 
Tek bir platform kullanılması gerekmez. Birden fazla plat-
form da seçilebilir. Ancak herhangi bir platformda firmanın 
adının görülmesi de firmanın olumsuz etkilenmesine neden 
olabileceği için firma tanıtımlarında uygun bir platform seçi-
mi önemlidir. 

Görsel 4.29: Sosyal medya kanalları
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4.3.1. Sosyal Medya Çeşitleri
Kullanıcıların paylaşımlarda bulunarak çevrim içi topluluklar oluşturdu-
ğu elektronik iletişim biçimleri olarak adlandırılan sosyal medya, kendi 
içerisinde kullanım ve içerik yönünden çeşitlenmektedir. Sosyal medya 
türlerinden bazıları şu şekilde sıralanabilir:

Sosyal Ağlar
İnsanlar bu platformları birbirleriyle iletişim kurmak için kullanmaktadır. 
Sosyal ağlar; bağlantı, bilgi, fikir paylaşımlarının yapıldığı alanlardır. 
Kullanıcıların oluşturduğu profiller, başka kullanıcılarla ortak noktaların 
keşfedilmesine olanak sağlar. 

Medya Paylaşım Ağları
Bu platformlarda kişiler, video ve fotoğraf gibi medya paylaşımı yap-
maktadır. Görüntüler bazen yazılarla desteklenebilir. 

Topluluk Tabanlı Ağlar
Topluluk ağları genellikle görüş ve düşüncelerin paylaşıldığı ağlardır. 
Topluluklar belli konular etrafında toplanır. Tartışma blogları oluştu-
rulur. 

İnceleme Platformları
Bu ağlarda; gidilen yerler, kullanılan ürünler, alınan hizmetler hakkında 
değerlendirmeler yapılır. Kullanıcıların diğer kullanıcılara fikir verdiği 
platformlardır. İnceleme platformları sayesinde insanlar, gidecekleri 
yerleri, daha önceden giden kişilerin fikir ve paylaşımlarını inceleyerek 
seçer. 

Sanal Oyunlar
Çevrim içi birçok kullanıcının aynı anda oyun oynamasına izin vererek 
birbirleriyle etkileşime girmelerine olanak sağlayan sitelerdir. Birçok 
farklı çeşidi bulunmaktadır. Kullanıcı profilleri, oyunun şekline ve ilgi 
alanlarına göre değişmektedir. Çocuklar ve yetişkinler için tasarlanmış 
oyunlar mevcuttur. Bu sitelerde karakter ve kişisel özelliklere göre gra-
fiksel olarak temsil edilen avatar (sanal kimlik) tasarımı yapılmaktadır.   
Bazı durumlarda oyunda sadece kullanıcı adı yer almaktadır. Diğer kul-
lanıcılarla oyun içerisinde sohbet edilebilecek yöntemler bulunmaktadır. 

Sanal Gerçeklik Dünyası
Dijital kullanıcı profilleri oluşturulduktan sonra sanal dünyada üç bo-
yutlu avatar oluşturularak bu avatarın karakter ve kişisel özelliklerinin 
istenildiği gibi tasarlanmasına olanak sunar. Sanal oyun olarak adlan-
dırılabileceği gibi sadece sanal dünya olarak da adlandırılabilmektedir. 
Bu etkileşim, kişinin kendi istediği özelliklerde profilini oluşturması ve 
gerçek dünyada sahip olamadığı birçok şeye bu dünyada sahip olması 
üzerine kuruludur. Gerçek dünyadaki gibi yaşam alanları, araç gereç, 
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kıyafet, yemek gibi birçok ayrıntının yer aldığı platformlardır. Bu-
rada oluşturulan karaktere göre kişi, sosyal çevresini de oluştur-
maktadır. Anında mesajlaşma olduğu gibi vücut diliyle de iletişim 
kurulabilmektedir. Bu platformlarda var olan tasarımlar kullanıla-
bilir. Bunun yanında kullanıcıların tasarım yapmalarına izin veren 
bir yapı da bulunmaktadır. Kullanıcı aynı zamanda üretici pozis-
yonundadır. Firmaların bu tarz yapılarda var olmaları ise gerçek 
dünyadaki gibi reklam vermeleriyle mümkündür.
 
4.3.2. Sosyal Medya Siteleri
Günümüzde sosyal medya siteleri denildiğinde Facebook (Feys-
buk), Twitter (Tivedır) ve Instagram (İnstegram) akla gelmektedir. 
Bunun yanı sıra daha az bilinen firmalar ve belirli kullanıcıların yo-
ğun olarak kullandığı siteler de bulunmaktadır (Görsel 4.30). Kulla-
nıcıların dönemsel olarak yoğun ilgi gösterdiği veya bir anda popü-
ler olup daha sonra unutulan birçok site de bulunmaktadır.
 
Facebook
Harvard Üniversite öğrencisi Mark Zuckerberg (Mark Zakırberg) 
tarafından 2004 yılında Harvard öğrencilerinin birbirleriyle iletişim 
sağlamaları amacıyla kurulmuştur. Facebook ilerleyen yıllarda tüm 
dünyada kullanılmaya başlanmıştır. Eski okul arkadaşları, çocuk-
luk arkadaşları gibi geçmişte paylaşım içinde bulunulan kişileri bul-
mayı ve bu kişilerle iletişim kurup bilgi alışverişi yapmayı amaçla-
yan bir sosyal paylaşım sitesidir.

Twitter
Yüz kırk karaktere kadar metin gönderilerine izin veren mikrob-
log sitesi olarak 2006 yılında kullanıma açılmıştır. Twitter kullanım 
alanı, önceleri sadece yüz kırk karakterle sınırlı yazı olsa da daha 
sonra kullanım alanı genişletilerek karakter sayısı artırılmış ve fo-
toğraf, ses, video gibi birçok dosya türünün gönderimine izin ve-
ren bir siteye dönüşmüştür. Günümüzde haberleşmenin en güçlü 
temsilcilerindendir. Tarafsız habere ulaşabilme imkânı sunması ve 
tüm kullanıcıların içerik üretebiliyor olması kullanıcı sayısını gittikçe 
artırmıştır. Aynı zamanda firmalar için güçlü bir iletişim ağı oluştur-
ması sebebiyle müşteriler arası iletişimde de kullanılmaktadır.

Instagram
Görsel içerik paylaşımının öne çıktığı 2010 yılında açılan bir sosyal 
paylaşım sitesidir. Fotoğraf, video, slayt gösterileri, hikâye, canlı 
yayınlar gibi gönderi seçenekleri sunmaktadır. Ürün paylaşımları 
için firmalar da Instagram hesaplarını aktif olarak kullanmaktadır. 
Markaların kampanya, tanıtım ve iletişim için kullandıkları sosyal 
paylaşım alanlarından biridir.

Görsel 4.30: Sosyal 
medya ikonları
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1. ETKİNLİK

YouTube
Dünyanın en popüler video paylaşım sitesi olmakla birlikte Goog-
le’dan (Gogıl) sonra en popüler ikinci arama motorudur. YouTube 
(YuTuup) 2005 yılında kurulmuştur. YouTube’un ayda iki milyardan 
fazla oturum açmış ziyaretçisi vardır. Siteyi ziyaret eden ve kendi 
hesabına giriş yapmadan video izleyen kişiler de bulunmaktadır. 
Temel olarak video yoluyla pazarlamayı kullanmak isteyen herhangi 
bir işletme veya kişi, geniş bir kitleye ulaşmak için Youtube’u kulla-
nır. Site ayrıca videoların diğer web sitelerine yerleştirilmesine de 
olanak sunar. 

Linkedin
2003 yılında başlatılan Linkedin (Linkdin) iş dünyasında farklı uz-
manlık alanlarındaki kişileri bir araya getiren sosyal platformdur. 
Kişilerin birbirleriyle profesyonel bağlantı kurmasına ve firmaların 
sektördeki diğer kişi ve kurumlarla iletişim kurmalarına olanak tanır. 
Kişilerin öz geçmişlerini güncel tutar, iş ilanlarına başvurmalarını 
veya iş ilanlarına cevap vermelerini de kolaylaştırır. 

Pinterest
2010 yılında kullanıma açılan Pinterest (Pintirest) sosyal medya si-
tesi ve arama motorudur. Bir kullanıcının ürünlerini, proje fikirlerini 
ve ilham verici görüntüleri kaydedebileceği dijital bülten panoların-
dan oluşur. Kullanıcılar takip edilebilir.  Aynı zamanda bir kullanıcı-
nın içeriğini başka bir kullanıcının kendi panosunda paylaşmasına 
olanak tanır.

Flickr
Flickr (Filıkır), kullanıcıların kendilerine ait fotoğraflarını paylaşma 
ve etkileşimde bulunma sitesidir. Her gün siteye dört milyona ya-
kın görsel yüklenmekte ve ücretsiz üyeliklerde 1 terabayt depolama 
alanından faydalanma imkânı sunmaktadır. Paylaşılan fotoğraflar-
da konum bilgisi paylaşımına izin verilir. Çekilen yerin tanıtımına 
ve kullanıcının diğer kullanıcılarla etkileşime girmesine olanak tanır. 

Sosyal medya platformlarından en çok kullanılanları inceleyiniz. 
•	 En yaygın kullanılan sosyal medya platformları ve bu platformlarda paylaşılan 

dosya türlerini karşılaştırınız.  
•	 Sosyal medya platformlarının hedef kitlelerini belirleyiniz. 
•	 Hangi sosyal medya platformları firmalar için daha uygundur? Sınıfta tartışınız.



SOSYAL MEDYA

228 Bilgisayarda Fotoğraf

4. UYGULAMA

UYGULAMA ADI	:	İşletmelere Uygun Sosyal Medya Kullanıcı Profili 
		  Belirleme
AMAÇ	 :	Kitleye uygun sosyal medya kanallarını belirlemek.

Aşağıdaki işlem basamaklarını dikkate alarak seçeceğiniz bir işletmenin 
sosyal medya paylaşım formatlarını ve kullanıcı profilini belirleyiniz. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 Sık kullanılan sosyal medya platformlarının isimlerini yazınız.
3.	 Az bilinen ancak işletmelerin sıklıkla kullandığı platformları araştırınız. 
4.	 Belirlenen platformların kullanıcı profillerini özetleyerek yazınız. 
5.	 İşletmenin hangi kitleye hitap ettiğini belirleyiniz.
6.	 Belirlediğiniz kitlenin kullandığı platformları bulunuz.
7.	 Bulduğunuz platformlardaki içeriklerin dosya formatlarını tanımlayınız.
8.	 İşletmenin hangi platformlarda yer alması gerektiği bilgisini ve kullanıcı 

profillerinin tanımlandığı bir veri dosyasını hazırlayınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 4’te verilen “4. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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4.3.3. Sosyal Medya Platformlarında Kullanılan İçerikler 
Sosyal medyada birçok farklı tarz ve şekilde içerikle karşılaşmak mümkündür. Bu içe-
riklerin ortak noktası, izleyici kitlesi oluşturmak ve daha fazla kişinin dikkatini çekmek-
tir (Görsel 4.31). Platformların kuralları kabul edilerek firma profilleri oluşturulduğunda 
içerik, paylaşıma hazır hâle getirilmiş olur. Bu profillerin popülerliğini koruyabilmesi için 
müşterilerin siteyi güvenli bulması, kendine yakın hissetmesi, yeni ürünleri ilk burada 
görmesi, sitenin takipçilerine özel kampanyalar sunması gibi kriterler önemlidir. 

Firma, samimiyeti korumak için kamera arkası görüntüleri paylaşabilir. Firmanın kurulum 
hikâyeleri ve gelişimi anlatılabilir. Komik hikâye veya paylaşımlar, firmanın profesyonel 
yapısına ters düşmeden paylaşılabilir. Özel gün ve haftalar için oluşturulan içerikler ve 
bu günlere verilen değerler yansıtılabilir. Yapılan yarışma ve çekiliş sonuçları bu sayfa-
larda paylaşılarak şeffaflık korunabilir. Müşterilerden gelen ürün kullanım video ve fo-
toğrafları “sizden gelenler” şeklinde paylaşılarak kişilerin firmayı kendilerine daha yakın 
görmeleri sağlanabilir. Firma çalışanları, bu sayfalarda paylaşılırsa sadece müşterilerin 
değil, çalışanların da değerli olduğu gösterilebilir. 

Görsel 4.31: Instagram postları 1080x1080 px



SOSYAL MEDYA

230 Bilgisayarda Fotoğraf

4.3.4. Sosyal Medya Platformlarında Görsel Boyutları
Her sosyal medya platformu, kendi tarzını yaratmak için kullanıcılara belirli ölçülerde ve 
dosya türlerinde paylaşıma izin vermektedir. Yapılacak paylaşımların boyutları değişiklik 
gösterebildiği için kurum ve markalar, bu boyutlara sadık kalarak tasarımlarını şekillen-
dirmelidir. Yapılan tasarımlarda görsel boyutlarının kullanımının önemi şu şekildedir:

•	 Sosyal medya platformlarında bulunan görsel boyutlarına uygun içerikler paylaşıla-
rak profesyonel bir görünüm elde edilir.

•	 Bu boyutlara uyulduğunda hesap daha profesyonel görünür ve kişilerin firmaya gü-
veni artar.

•	 Takipçilerin firmaya güveninin artmasıyla sosyal medya platformlarından e-ticaret 
sitelerine gelecek ziyaretçi sayılarında da artış olur.

•	 Profesyonel yönetilen hesaplarda takipçi kazanımı daha hızlı olur.
•	 Sosyal medya platformlarındaki etkileşim oranı artar.
•	 Firmanın sosyal medyada daha profesyonel şekilde gösterilmesi marka değerini ar-

tırır.

Facebook Boyutları
Facebook’ta profil fotoğrafı oluşturmak istenirse kişinin fotoğrafının kare formatta çekil-
mesi gerekir. Profil fotoğrafı boyutları bilgisayardan girildiğinde 170x170 px olacaktır. 
Telefondan girildiğinde ise 128x128 px olarak görünmektedir.

Facebook, gönderi fotoğrafında dikdörtgen ve kare olarak iki boyutta gönderiye izin verir.  
Dikdörtgen boyutları 1200x630 px, kare boyutları 1200x1200 px’dir.

Son birkaç yıl içerisinde hayatımıza giren hikâyeler yoluyla markalar, hedef kitleyle etki-
leşimlerini artırmakta ve takipçileriyle daha kolay etkileşime geçmektedir. Tek bir fotoğraf 
yerine videolarla daha kolay anlatımlar yapılabilmektedir. Facebook hikâye boyutları 
9/16 oranıyla uyumlu olmalıdır. Facebook hikâyelerinde fotoğraf ya da video paylaşımı 
yapılacaksa fotoğrafların uyumları 1080x1920 px ölçülerinde olmalıdır.

Instagram Boyutları
Instagram profil fotoğrafı 1/ 1 kuralına uygun ve kare formatta olmalıdır. Instagram profil 
fotoğrafı boyu 110x110 px’dir. 

Instagram’da yapılacak paylaşımlarda gönderi dikey, yatay veya kare formatta olabilir. 
Ancak birçok kullanıcı gönderilenin daha düzenli görünmesi için kare formatı tercih 
etmektedir. Instagram gönderileri kare paylaşılmak istendiğinde 1080x1080 px ölçüleri 
kullanılabilir. İstenildiği takdirde bu ölçü 1200x1200 px olarak da ayarlanabilir. Instag-
ram’da yatay fotoğraf paylaşılmak istenirse 1080x566 px ölçüleri kullanılabilir. Instag-
ram’da paylaşılacak dikey fotoğraflar için de gönderi boyutları 1080x1250 px ölçülerin-
de seçilebilir. 

Instagram’ın en aktif kullanılan ve en çok izlenen özelliklerinden biri olan hikâyelerin pay-
laşımı için hikâye boyutlarına dikkat edilmelidir. Instagram hikâye boyutları 1080x1920 
px ölçülerindedir. Instagram hikâye oranları 9/16 olmalıdır. Hikâyeye eklenecek video ve 
fotoğrafların maksimum dosya boyutu ise 4 GB’tır. 
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Instagram’ın kendi belirlemiş olduğu format dışında da paylaşım yapabilmek mümkün-
dür. Örneğin 3x2 - 2x2 oranlarındaki bir eser, görüntü düzenleme programlarıyla isteni-
len tonda renk ayarlanarak Instagram boyutlarında bir paspartu bırakılır ve paylaşıma 
olanak sağlanır. Son gelen güncellemelerle hikâye paylaşımlarında da görüntü boyutu 
ayarlanabilmektedir.

Twitter Boyutları
Twitter’da profile kapak fotoğrafı eklenecekse boyutu 1500x500 px olmalıdır. Kapak fotoğ-
rafı olarak JPEG, GIF ve PNG formatlarında fotoğraflar bu alana eklenebilir.

Twitter’da kullanılacak profil fotoğrafı boyutları 1/1 oranına uygun, kare 400x400 px ol-
malıdır. Ancak bu fotoğraf platformda 200x200 px boyutlarında görünmektedir. JPEG, 
GIF ve PNG formatlarında fotoğraflar bu alana eklenebilir. Twitter paylaşım görseli bo-
yutları 1024x512 px olmalıdır.

Pinterest Boyutları
Pinterest hesabında kullanılacak profil fotoğrafı 1/1 ölçülerinde ve kare olmalıdır. Kulla-
nılacak fotoğrafın ölçüleri 165x165 px olmalıdır.

Pinterest’te paylaşılacak görsellere pin denir. Pinlerin boyutları genellikle pin türüne göre 
değişmektedir. Standart, uzun ve kare pinler olarak üç gruba ayrılan Pinterest pinlerinde 
kullanılması gereken görsel boyutları şu şekildedir:
 
Pinterest standart pin boyutları 600x900 px
Pinterest uzun pin boyutları 600x1260 px
Pinterest kare pin boyutları 600x600 px

Linkedin Boyutları
Linkedin’de hem kişisel hesaplar hem de şirket hesapları bulunduğu için görsel boyutları 
farklılık göstermektedir.
 
Kişisel hesaplarda kullanılan görsel boyutları 400x400 px
Şirket hesaplarında kullanılan görsel boyutları 300x300 px  
Linkedin kapak fotoğrafı boyutları kişisel hesaplar ve şirket hesapları için farklıdır.
 
Kişisel hesaplarda kullanılan kapak fotoğrafı boyutları 1584x396 px
Şirket hesaplarında kullanılan kapak fotoğrafı boyutları 1536x768 px
Linkedin’de yapılacak paylaşımlar, 1104x736 piksel ölçülerinde görsel olarak hazırlanmalıdır.

Youtube Boyutları
Youtube kanallarındaki kullanılacak profil fotoğrafının boyutları 800x800 px olmalıdır. 
Youtube kanalının profil fotoğrafı kare formatındadır.

Youtube kanallarında standart kullanılan kapak fotoğrafı boyutu 2560x1440 px’dir. İlgili 
kapak fotoğrafları, masaüstü cihazlarda 2560x453 px olarak görünmektedir. Telefonlar-
da ise 1546x423 px olarak görünecektir.

Youtube videolarında kullanılacak küçük resim boyutları 1280x720 px olmalıdır.
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5. UYGULAMA

UYGULAMA ADI	:	 İşletme Tanıtım İçeriği Tasarlayarak Paylaşma
AMAÇ	 :	Seçilen sosyal medya kanalına uygun içerik üretimini .
		  yayımlamaya uygun hâle getirmek.

Aşağıdaki işlem basamaklarını dikkate alarak fotoğraf işletmesine uygun 
içerik üretimi yapınız. 

Araç Gereç
1.	 Bilgisayar 
2.	 Görüntü düzenleme programı
3.	 Taşınabilir bellek

İşlem Basamakları
1.	 Bilgisayar atölyesi kullanım kurallarına uyarak araç gerecinizi hazırlayınız.
2.	 İçeriğin paylaşılacağı sosyal medya platformuna karar veriniz.
3.	 Sosyal medya platformunda hangi dosya formatlarının paylaşılabildiğini 

kontrol ediniz. 
4.	 En çok izlenen sosyal medya formatlarından birini belirleyiniz. 
5.	 Bu formata uygun içerik için firmayı veya ürününü tanıtan tasarım taslağı 

oluşturunuz. 
6.	 Taslak tasarımdan uygun olanı seçiniz
7.	 Tasarıma uygun içerikleri bir araya getirerek çalışmanızı yapınız. 
8.	 Paylaşım için uygun dosya formatı seçtiğinizden emin olunuz.
9.	 Paylaşım için uygun hesap oluşturunuz.
10.	Oluşturduğunuz hesaptan paylaşımınızı yapınız.  
11.	Paylaşımınızın beğeni oranına göre içeriği geliştirerek yeniden paylaşınız. 

Değerlendirme 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. Uygulama 
çalışmanız, Ek 4’te verilen “5. Derecelendirme Ölçeği”ndeki ölçütlere göre de-
ğerlendirilecektir. Çalışmanızı yaparken bu ölçütleri dikkate alınız.
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A) Aşağıdaki cümlelerde parantez (...) ile boş bırakılan alanlara verilen    
     bilgiler doğru, ise “D” yanlış ise “Y” yazınız. 

1.	 (...) Sosyal medya siteleri kullanıcı ve işletmelere analiz sağlar. 
2.	 (...) Flickr kullanıcısı, fotoğrafın çekildiği yeri haritada gösterebilir.
3.	 (...) Facebook kullanıcı profili oluşturmak için kimlik ibraz etmek gerekir.
4.	 (...) Sosyal ağlarda pazarlama yapılırken hedef ve strateji belirlenmelidir. 
5.	 (...) Linkedin, kullanıcılar tarafından tercih edilen en popüler bir sosyal ağdır. 
6.	 (...) Sosyal medya pazarlaması en etkili reklam kaynaklarından biridir. 
7.	 (...) 2018 itibariyle, bir tweette maksimum 140 karakter sayısı kullanılır. 
8.	 (...) Sosyal ticaret, işletmenin sosyal ağları kullanımıyla ilgilidir. 
9.	 (...) Facebook sitesi, çevrim içi fotoğraf yönetimi ve paylaşımı uygulamasıdır.

B) Aşağıdaki cümlelerde yer alan boşlukları uygun olan ifadelerle doldurunuz.

10.	Hızlı bilgi paylaşımı için ................... ağlar kullanılır.
11.	Facebook, işletmelerin ................... yapmasına izin verir.

C) Aşağıdaki soruları dikkatlice okuyarak doğru cevabı işaretleyiniz. 

12.	Pazarlama planlamasıyla ilgili aşağıdaki bilgilerden hangisi doğrudur?
	
		  A) Bir kez yazıldığında tamamlanmış olur. 
		  B) Eylemleri planlamak için her gün gözden geçirilmelidir. 
		  C) Şirket yönetim kurulu toplantılarında planlanmalıdır.
		  D) Şirketin her yıl yapılan mali incelemeleri sırasında planlanmalıdır.
		  E) Satış rakamları istenilenin altında olduğunda yapılmalıdır.
	
13.	Sohbet uygulamalarını kullanmanın temel faydası aşağıdakilerden 

hangisidir?
	
		  A) İnsanların çeşitli konulardaki görüşlerini okumayı sağlar.
		  B) Video, fotoğraf, belge ve kısa mesajlar için bir forum sağlar.
		  C) Gerçek zamanlı arkadaşlarla anında konuşmaya olanak tanır.
		  D) Çeşitli medya kuruluşlarından gelen haberleri sunar.
		  E) Fotoğraf göndermeyi ve başkalarının fotoğrafları görebilmesini sağlar.
	
14.	Mark Zuckerberg’in kurucusu olduğu sosyal medya aşağıdakilerden 

hangisidir?
	
		  A) Apple    B) Facebook     C) Google    D) Myspace    E) Twitter

ÖLÇME VE DEĞERLENDİRME
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15.	Facebook’ta genel mesaj bırakılabilen yere verilen ad aşağıdakilerden 
hangisidir?

	
		  A) Ağ   B) Alan adı    C) Duvar    D) Fotoğraf yorum   E) Mesaj kutusu

16.	Aşağıdakilerden hangisi sosyal medyanın işletmeler için sağladığı 
avantajlardan biri değildir?

		  A) Kullanımı kolaydır.
		  B) Bağlantı kurmaya yardımcı olur.
		  C) Maliyetleri düşürür.
		  D) Takipçi sayısını artırır.
		  E) Satış maliyetini düşürür.

17.	İşletmelerin birbirleri ve potansiyel çalışanlarla iletişim kurması-
nı sağlayan sosyal ağ aşağıdakilerden hangisidir?

	
		  A) Facebook   B) Instagram   C) Linkedin    D) Twitter   E) Youtube

18.	Bir müzisyen kliplerini yayımlamak için aşağıda verilen sosyal 
ağlardan hangisini öncelikli kullanmalıdır?

		  A) Blog sitesi   B) Youtube   C) Facebook   D) Instagram   E) Flickr

19.	Marka yönetiminin amacı aşağıdakilerden hangisidir?
	  
		  A) Pazarlama personelini yönetmek
		  B) Pazarlama bütçesini yönetmek
		  C) Şirket için tutarlı bir imaj yaratmak
		  D) Satış rakamlarını yükseltmek
		  E) Şirket reklamlarını yapmak
	
20.	Vlog tanımı aşağıdakilerden hangisidir?
	
		  A) Video günlüğü
		  B) Blog içerisinde kullanılan bir alan
		  C) Günlük fotoğraf paylaşımı
		  D) Kullanıcı profil popülerliği
		  E) Şirket bloğu

ÖLÇME VE DEĞERLENDİRME
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21.	Bir şirket uygun kitleyi kendi sitesine aşağıdakilerden hangisiyle yön-
lendirebilir?

		  A) Kendi sitesinde yaptığı reklam çalışmaları
		  B) Şirket çalışanlarının günlük olarak siteye girme zorunluluğu
		  C) Gazete ve dergilere verilen firma tarihi hakkında yazı
		  D) Başka sitelere verilen Banner reklamları
		  E) Çalışanlara gönderilen maillerde şirket sayfa yönlendirmesi

Ç) Aşağıda verilen soruların cevaplarını boş bırakılan yerlere yazınız.  

22.	Sosyal medyanın işletmeler için dezavantajlarını örneklendirerek 
açıklayınız.

…………………………………………………………………………………
………………………..….……………………………………………………
……………………………………………..……………………………………
……………………………………………..…….………………………………

23.	Markanın sosyal medyada bilinirliğin artırılması için yapılacak 
çalışmaları örneklendirerek açıklayınız.

…………………………………………………………………………………
………………………..….……………………………………………………
……………………………………………..……………………………………
……………………………………………..…….………………………………

24.	Sosyal ağların hangi amaçlar için kullanıldığını örneklendirerek 
açıklayınız. 

…………………………………………………………………………………
………………………..….……………………………………………………
……………………………………………..……………………………………
……………………………………………..…….………………………………

25.	İşletmelerin sosyal medyada var olmak için yapması gerekenleri
		 örneklendirerek açıklayınız. 

…………………………………………………………………………………
………………………..….……………………………………………………
……………………………………………..……………………………………
……………………………………………..…….………………………………

ÖLÇME VE DEĞERLENDİRME
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1. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 
gerecini hazırladı.

2.
Okul için oluşturulacak sosyal medya içeriğinin 
konusunu belirledi.

3. Belirlemiş olduğu içerikle ilgili araştırma yaptı.

4. İçeriği tasarım programlarında hazırladı.

5. Hedef kitlesi için kriterler belirledi.

6.
Belirlemiş olduğu kriterlere uygun anket soruları 
hazırladı.

7. Oluşturduğu deneme grubuna anketi uyguladı.

8.
Uyguladığı anketin verilerini değerlendirerek so-
nucu analiz etti.

9.
Analiz sonucunda tasarımın hedef kitleye hitap edip 
etmediğini verilerle değerlendirdi.

10. Değerlendirmesini raporladı.

11. Çalışmasını taşınabilir belleğe kaydetti.

12. Taşınabilir belleği koşullara uygun çıkardı.

13. Programı zarar görmeyecek şekilde kapattı.

14. Bilgisayarı zarar görmeyecek şekilde kapattı.

15. Süreyi planlı ve verimli kullandı.

16. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 4 
“Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 16 ölçüt bulunmaktadır. Ölçekten alınabi-
lecek en yüksek puan 80’dir.
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (80x100)/80=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz yeterli 
demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-4
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2. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gereci-
ni hazırladı.

2. Çalışmayı yapmak üzere hayalî bir firma kurguladı.

3. Kurguladığı firmanın sektörüne uygun isim belirledi.

4. Kurguladığı firmanın hedef kitlesini belirledi.

5.
Firmanın hedef kitlesine uygun ne tür paylaşımlar 
yapabileceğini belirledi.

6.
Benzer hizmet alanında yer alan gerçek firmaların 
paylaşımlarını inceledi.

7.
Gerçek firmanın yaptığı paylaşımların izlenme oran-
larını tespit etti.

8.
Tespit ettiği izlenme oranlarına göre kurguladığı 
firmaya uygun taslak içerik hazırladı.

9. Tasarım programlarında taslağa uygun içerik hazırladı.

10. İçeriği paylaşıma uygun formatta kaydetti.

11. Çalışmasını taşınabilir belleğe kaydetti.

12. Taşınabilir belleği koşullara uygun çıkardı.

13. Programı zarar görmeyecek şekilde kapattı.

14. Bilgisayarı zarar görmeyecek şekilde kapattı.

15. Süreyi planlı ve verimli kullandı.

16. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 16 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 80’dir.
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (80x100)/80=100
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz yeterli 
demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-4
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3. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER

DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç gere-
cini hazırladı.

2. Banner tasarımına uygun konu belirledi.

3.
Belirlediği Banner tasarımı için uygun görselleri 
buldu.

4. Tasarlayacağı Banner’ın boyutunu belirledi.

5. Banner’a görselleri yerleştirdi.

6. Gerekli tasarımlarla Banner’ı yaptı.

7. Banner’ı paylaşıma hazır hâle getirdi.

8. Yaptığı Banner’ı paylaşarak değerlendirdi.

9 Süreyi planlı ve verimli kullandı.

10. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” İyi”, 4 
“Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 10 ölçüt bulunmaktadır. Ölçekten alınabi-
lecek en yüksek puan 50’dir.
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (50x100)/50=100
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz yeterli 
demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-4
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4. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 
gerecini hazırladı.

2. Bildiği sosyal medya platformlarını yazdı.

3.
İşletmelerin yoğunlukla kullandığı platformları 
araştırdı.

4. Belirlenen platformların kullanıcı profillerini özetledi.

5. İşletmenin hangi kitleye hitap ettiğini belirledi.

6.
Belirlediği kitlenin kullandığı platformları örneklen-
dirdi.

7.
Belirlediği platformların dosya paylaşım formatları-
nı belirledi.

8.
Firmanın hangi platformlarda, hangi dosya türle-
riyle paylaşım yapabileceğiyle ilgili veri dosyası 
hazırladı.

9. Çalışmasını taşınabilir belleğe kaydetti.

10. Taşınabilir belleği koşullara uygun çıkardı.

11. Programı zarar görmeyecek şekilde kapattı.

12. Bilgisayarı zarar görmeyecek şekilde kapattı.

13. Süreyi planlı ve verimli kullandı.

14. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 14 ölçüt bulunmaktadır. Ölçekten 
alınabilecek en yüksek puan 70’tir. 
Öğrenci Puanı: (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (70x100)/70=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi geliştiriniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-4
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5. DERECELENDİRME ÖLÇEĞİ

ÖLÇÜTLER
DERECELER

1 2 3 4 5

1.
İş sağlığı ve güvenliği tedbirlerine uyarak araç 
gerecini hazırladı.

2.
İçeriğin paylaşılacağı sosyal medya platformunu 
belirledi.

3.
Seçtiği platformda hangi dosya türlerinin paylaşıla-
cağını kontrol etti.

4.
Paylaşılabilecek dosya formatına uygun tanıtıcı 
tasarım taslağı oluşturdu.

5. İçeriğin tasarımını yaptı.

6.
Tasarımı paylaşıma uygun dosya formatında ve 
büyüklüğünde kaydetti.

7. Paylaşım için uygun bir hesap oluşturdu.

8. Oluşturduğu hesaptan paylaşım yaptı.

9. Bilgisayarı zarar görmeyecek şekilde kapattı.

10. Süreyi planlı ve verimli kullandı.

11. Bilgisayar atölyesi kurallarına uydu.

SÜTUN TOPLAMLARI

TOPLAM ÖLÇEK PUANI 

ÖĞRENCİ PUANI  

Ölçek Puanını 100’lük Sisteme Dönüştürme İşlemi: Ölçekteki 1 “Yetersiz”, 2 “Kabul edilebilir”, 3” 
İyi”, 4 “Çok iyi”, 5 “Mükemmel” performans düzeyini gösterir. Tabloda 11 ölçüt bulunmaktadır. Ölçek-
ten alınabilecek en yüksek puan 55’tir. 
Öğrenci Puanı:  (Toplam Ölçek Puanı x100)/Alınabilecek En Yüksek Ölçek Puanı formülü ile 100’lük 
sisteme uyarlanır. Örnek: (55x100)/55=100 
Değerlendirme: 100 üzerinden 50 veya üzerinde bir puan aldıysanız uygulamada başarı düzeyiniz 
yeterli demektir. 49 veya altında bir puan aldıysanız eksik puan aldığınız ölçütlerde kendinizi gelişti-
riniz.

NOT: Öneri olarak hazırlanmıştır. Öğrenme ortamlarına göre düzenlenebilir.

EK-4
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Görsel Kaynakçası

http://kitap.eba.gov.tr/karekod/Kaynak.php?KOD=2117

Not: Bu ders materyalindeki kısaltmalar uluslararası ölçü birimleri dikkate alınarak kullanılmıştır.             
      Kaynakça, APA 6 kriterlerine göre hazırlanmıştır.
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1.	 D
2.	 D
3.	 Y
4.	 D
5.	 Y

6.	 History
7.	 Action
8.	 Layer
9.	 Crop Tool
10.	B

11.	B
12.	B
13.	A
14.	B

1. ÖĞRENME BİRİMİ BİLGİSAYARDA FOTOĞRAF DÜZENLEME

2. ÖĞRENME BİRİMİ BİLGİSAYARDA FOTOĞRAF/GÖRÜNTÜ İŞLEME

1.	 D
2.	 Y
3.	 Y
4.	 D

5.	 D
6.	 Marge Layer
7.	 Crop
8.	 B

9.	 E
10.	A
11.	A
12.	A

1.	 D
2.	 D
3.	 Y
4.	 Y
5.	 D
6.	 Y

7.	 vektör
8.	 dijital
9.	 çevre
10.	B
11.	D
12.	C

13.	D
14.	A
15.	B
16.	C

3. ÖĞRENME BİRİMİ DİJİTAL İLLÜSTRASYON

1.	 D
2.	 D
3.	 Y
4.	 D
5.	 Y
6.	 D
7.	 Y

8.	 D
9.	 Y
10.	sosyal
11.	reklam
12.	B
13.	C
14.	B

15.	C
16.	E
17.	C
18.	B
19.	C
20.	A
21.	D

4. ÖĞRENME BİRİMİ SOSYAL MEDYA

CEVAP ANAHTARI


